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Image: Annabella Serra
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Build Method: Extrude

Bevel: preset from menu

Effects: Wall

Text Look: customized instance of Floofy

Wall Look: Pictures as Anything; texture
and relief using an image of corrugated
cardboard

Lights: #7100%, spotlight; #2 70%, spotlight
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Ever wish you didn't have to go through all the work
of figuring out perspective and shading for your let-
tering? Well, Typestry takes care of it automatically.
Ever wish you could try out a different look on your
lettering without having to repaint it all? With

Typestry it's a simple point-and-click operation. How
about changing the lighting? Easy — select a light and
adjust its color and intensity. Typestry is simply the
easiest way to get great-looking dimensional text!

We made Typestry with the goal of making 3D text
incredibly easy: there are very few controls to mas-
ter; the tools are practically self-explanatory and the
interface is straightforward; and you can get an
incredible range of lighting, perspective, and shading
effects with the click of a mouse.

There are only five basic steps to making a picture
with Typestry:

*« Type in some text or import an lllustrator file.

» Position the text the way you want it — move,
rotate, resize, or skew it.

*  Apply a surface to the text — Typestry comes

with an extensive library of surface appearances, or
Looks.

* Add lights — spotlights, slide projectors, or dis-
tant lights.

* ‘“Take a picture” of the text — render with
Academy award-winning RenderMan technology.

You can use any Type | or TrueType font for typing
in your text, or you can import lllustrator files to add
interesting shapes and text effects. You can use font
programs like Fontographer and FontMonger to cre-
ate your own fonts for text, or to make special char-
acters to add visual interest.

If you'd like, you can add effects like wind, particles,
and motion blur. And to top it off, you can even
make simple animations of your text, and turn them
into QuickTime movies or use them as a series of
frames.

After creating an image, you can import it into other
programs, like Photoshop, QuarkXPress, PageMaker,
Persuasion, or just about any paint or page-layout
program.

introduction

what’s typestry?
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Image: Joy Folla

Font: Slipstream
Build Method: Rubber Sheets

Sheet Textiling: text only, no
background

Sheet Style: waving flag
Wind Speed: 75%
Wind Gustiness: 75%

Effects: Wall

Text Look: ECGems Dented Jewel:

Color gold, Scale 5%

Wall Look: Wall Plaster, black

Lishts: #5 40%; #7 100%
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Note: You must have completely installed all the
elements of Pixar Typestry before trying this! Also, if
you're using PostScript fonts you must have ATM
version 2.0 or greater installed.

I. Double-click on the program to open it.

2. Resize the window by dragging the lower right
corner and make it a few inches on a side.

EME

= Untitled 1 __——:““—:lia

Selection: none Front View frame 1 lﬁl

g

3. Click once in the window to the left of the win-
dow's center. This will bring up the text dialog. Type

the name Elmo in the box, choose a font, and click

on Build Object.

Note: Make sure the Build Object box is highlighted.
If not, the font you selected is not properly installed

in your system, or isn't the right kind of font. Select

another font.

(?g add text

Font [ KeedySansBold

Eimo

i

g

Build Methods [_Extrude ~| [Ccancel] [Build Object

The Extrude dialog will appear. Just click on OK.

typestry quick-start




4. Now you should see the word "EImo” in the
Typestry window.

EE=—=— untitled | =—=03]

e

Selection string 1 Front View frame 1 El

5. From the Render menu select Render to Screen,
then Reasonable. You can get a sharper image by
choosing Excellent ‘n’ Slow instead of Reasonable,
but it will take longer.

LELL LTS Motion  Windows
Render to Screen )
Render to File...

Quick 'n Dirty HE
Reasonable *®
Excellent 'n' Slow" T
Custom ®Y

Image Format... 31
Custom Quality... T

Et voilal Your first Typestry picture!

Eﬁ% elmoPICT.1

ek

sle
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I. Do steps |-3 from the Typestry quick-start.

2. Click on the Move tool in the slim toolbox.

i

3. Click and drag your text in the window to move
it. If you accidentally deselect it, just click on it again.

Try rotating or resizing it using the Rotate and
Resize (third and fourth) buttons in the toolbox.
Remember: click and drag on the object itself, not
near it. If you click and hold the button you'll get a
pull-aside menu with various ways to constrain these
two operations. (Don't worry, we'll talk more about
these tools later in the Getting Text In chapter.)

=4

H

If you'd like to get the word reoriented so it is face-
on again, select Reset Orientation from the Edit
menu.

4. Select Show Looks in the Windows menu. In the
Looks window click on the New Look button. This
brings up the Browser (the “select a look™ dialog).

(g select a look

= DocMacll
D Constant <)
D Glass :
D Matte Desk1iop
0 Metal Polished )
D Metal Rough | J
O Plastic Polished
Cancel
=
:
[

5. In the Browser, use the menus to find and select
the Plastic Rough Look for your text. The Browser
should automatically go to Pixar Applications:Look
Instances. From there, look in Starter:Materials:Basic.
Click on the Select button.

6. Click on the Object Info button in the Looks
toolbox. This brings up the Object Info dialog.

typestry less quick start




@ looks

@ string. ...
() Sides
O wall
O Floor

Detach Look

7. In the Object Info dialog, click on the Color
Override box. This brings up the Color Picker.

(g object info

Projection
Object string. 1 i futoPlanar V]
Look Rough Plastic
Color Override [7]

Horizontal Flip
Opacity Override

Look scale | [XIONEN] % " (verticar fiip
[ Scale Look with Object Lm]

8. In the Color Picker, select a color for the plastic
and click on OK. Then click on OK in the Object
Info dialog to put it away.

9. Now from the Effects menu select Backgrounds,
and then Wall. You won't see a wall appear, but it
will show up in the rendered image.

13-4 Render Motion Windows
Backgrounds
Camera »
Motion Blur »
Particle System )
Atmosphere...

Floor
Floor and Wall
{all Setup...
Floor Setup...

10. Select Show Llghts from the Windows menu.

I'l.In the Lights toolbox, click on the middle box
next to light 7. This will bring up the Browser. If you
click and hold on the box you'll get a popup menu.
Selecting New Look is equivalent to just clicking on
the box, and will likewise bring up the Browser.

=

[2.In the Browser, use the menus to find and select
the Windowspot light Look in Pixar Applications:Look
Instances:Lights. Click on the Select button.

| 3. From the Render menu select Render to Screen,
then Reasonable. You can get a sharper image by
choosing Excellent 'n” Slow instead of Reasonable,
but it will take longer.

Et voila! Your second Typestry picture!
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Image: Annabella Serra

Build Methods: 2 Rubber Sheet rings
Effects: WWall
Lights: #5 50%, and moved to the left of the image

Text Looks: customized Floofy instances; white text layer added later as
a screen using Adobe Photoshop

Wall Look: Pictures as Anything using Pixar One Twenty Eight texture
as color and bump
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Using the Text dialog you'll just have to cancel it.) Type in some text.
There are two ways to get shapes into Typestry: @ add text

typing in text, and importing lllustrator files.

Font [ Chicago |
ity

abc i

Regular text

I. To get text in the project window, first make
sure the Text tool is selected.

)

Build Methods | Extrude | [Cﬂnce! [Builduhjecl]

3. Choose a font by clicking and dragging the font
menu. Remember, the font must either be a Type |
PostScript outline font, or a TrueType font.

4. Select a Build Method and click on Build Object.
See below for descriptions of the three Build
Methods: Extrude, Rubber Sheet, and Tubes. This
brings up a dialog associated with the Build Method

g N HEJ o

you chose.
2. Click once in the project window; this brings up
the text dialog. (If you click twice, after you're done 5. Click on OK to convert the text to 3D objects
with the text dialog it will appear a second time and and put it into the Typestry window.

using the text dialog

getting text in




Importing lllustrator files

I. Select the Text import tool by clicking and hold-
ing on the Text tool.

®|A.®

2. Click once in the project window where you'd
like your graphic to appear; this brings up the Import
dialog. (If you click twice, after you're done with the
text dialog it will appear a second time and you'll
just have to cancel it.)

3. Select the file you want to import. This must be
an lllustrator file created with version 3.0 or later.

4. Select a Build Method and click on Open. See

below for descriptions of the three Build Methods:
Extrude, Rubber Sheet, and Tubes. This brings up a
dialog associated with the Build Method you chose.

5. Click on OK to convert the object to 3D and
put it into the Typestry window.

Build Methods

There are three Build Methods: Extrude, Rubber
Sheet, and Tubes. These are described below.

Extrude

This extrudes letters, beveling the edges according
to the bevel style you choose, or create, in the dia-
log. See “Using the Bevel Editor” later in this section
if you'd like to create your own bevel.

@ extrude

Bevel Styles

Depth § . +
OE =
o
custom Bevel [_v]

Bevel Editor

]
|

D)

In the left column of Bevel Styles, when you apply a
Look to the Sides (one of the choices in the Looks
window), the Look controls the appearance of the
whole bevel. In the right column, the middle of the
bevel takes on the Look applied to the faces; the
bevel edges are the Sides, and can have their own
Look. Ordinarily, the whole bevel takes on the Look
of the faces unless you specify a different Look for
the Sides.




Custom Bevel. This allows you to select bevels
you have previously saved.

Depth. This sets the thickness of the object. Of
course, you can change this with the Scale tool once
the object is in the project window. If you change
just the object’s depth with the Scale tool the bevel
will get stretched or squeezed. If you'd like to redo
the Depth setting in the Extrude dialog you'll have
to repace the object (see the note below).

- Note: If you need to change the bevel style or
depth after the object is in the project window just
use Replace Selection (from the Edit menu). You'll
get the Text dialog back with the text already typed
in and the Build Method selected.

The following images show examples of the different
bevel options, including some custom bevels. To the
right of each image is its Bevel Style.

using the text dialog

getting text in
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Rubber Sheet the controls on the right side of the dialog.

This dialog allows you to put letters on six different Here are some examples, along with their Sheet
objects. Textiling and Sheet Style settings:

‘g rubber sheet

Sheet Textiling

Y [ ® No Wind
wdily

Sheet Style Wind Speed

aJ@e
| Wind Gustiness

Padding + Cancel | 0K I

Use the Sheet Textiling to determine what part of
the surface appears: just the parts where there's
text, just the parts without text (creating holes
where the text is), or everything.

« If you choose everything, be sure to give differ-
ent Looks to the “flag” (the text) and to the “sides”
(the rest of the surface). Otherwise you won't see
the text at all.

Use the Sheet Style to put the text on a long, tall, or
wavy rectangle, a sphere, a cylinder, or a ring. These

shapes are flimsy and flexible — rubber-like, even —
and can be blown by wind, which is controlled by

using the text dialog

getting text in







Padding. This adds space around the text vertically
and horizontally. This is so you can avoid filling up all
the available space on whatever Sheet Style you
selected. On a sphere, for example, two letters
would appear on opposite sides. Increasing the
padding squeezes them together so you can have
them both appear on the front. Of course, they'll be
smaller, but you can always resize the sphere.

Use the wind controls on the right side of the dialog
to allow the surface to act as if it's being blown by
the wind.

No Wind. This is the default, creating rubber
sheets that aren’t blown by the wind.

Wind. Turning this on makes the wind blow,
deforming the sheet appropriately in an animation.

Wind Speed. Blowing wind causes sheets to wave.

The higher the Wind Speed, the faster the waves.
The speed's variability is controlled by Wind
Gustiness.

Wind Gustiness. Gusty wind produces variability
in the waves. This control varies the wind's direction
(it blows along the length of the sheet by default),
and varies the Wind Speed somewhat as well. The
Wind Speed then becomes an “‘average” speed.

Remember, you'll only see the effects of the wind if
you create an animation. However, you can create a
still image using the effect by creating a 2-frame ani-
mation. To do this, see the section on “Creating a 2-
frame animation” near the end of the Animation
section.

Changing the wind controls

If you're not happy with the wind control settings
and you want to change them, you must regenerate
the whole object:

I. With the object selected, select Replace
Selection from the Edit menu. This brings up the
Text dialog.

using the text dialog

getting text in




2. The text will already be typed in, with the cor-
rect font and Build Method selected. If you'd like to
preserve these, just click on Build Object. This brings
up the Rubber Sheet dialog.

3. Adjust the controls and click on OK. The object
will be recreated in the project window.

*  Warning: For this to work the object must still
be grouped as it was when you typed it in.

Tubes

You know how the lettering in neon signs looks?
That's what this does — it's just the outline of the
letters where the outline is a tube. There are three
Tube Styles: tubes whose cross sections are circular,
square, or scalloped. Use the Tube Radius slider to
control the size of the tubes.

g tubes

Tube Styles

N (A Tube Radius
< B




*  Warning: Some fonts may appear slightly mis-
shapen when you use a very large bevel size or
Tube Radius. Although Pixar Typestry uses only the
PostScript curves that already exist in the font, when
these curves get greatly exaggerated they may cre-
ate unexpected results.

Using the Bevel Editor

When a letter gets extruded into 3D, it has a front
and a back face. The bevel is what connects the two
faces. The Bevel Editor allows you to change the
shape of the curves that make up a bevel. Selecting
any bevel loads it into the Bevel Editor area. Here,
the bevel’s left side connects with the front face, the
right side with the back face. The editor works simi-

larly to drawing programs that edit curves. To wit:

There are two things you can adjust: points and han-
dles. Your cursor must be in the Bevel Editor win-
dow for these to appear.

handles

[\

points

Every point has two handles. But you'll only see the
handles of the point that's currently selected. If the
handles move independently the point is represent-
ed by a square dot. If adjusting one handle affects
the other the point is represented by a round dot.
You can toggle between these two handle-moving
modes simply by clicking on a point once it's select-
ed.

A point and its associated handles become active
when the cursor approaches it. You'll be able to edit
whatever point the cursor is closest to.

Points control where the parts of the line are; han-
dles control the shape of the line. The direction of a
handle determines which way the curve goes, while
its length controls the “amount” of curving: the
shorter the handle, the straighter the line. Try select-

using the bevel editor

getting text in




ing the bottom left bevel and playing with the mid-
dle point to get the feel of what handles and points
do.

Here's the bottom left bevel choice, unedited :

& Ty

In the illustrations below, the bevel on the left has
had its handles moved, adjusting the direction and
amount of curving. On the right, the point itself was
moved, taking that part of the curve with it.

You can't add or delete points, so you might pick a
bevel based on the number of points it has to offer.
They have from | to 4 points in addition to the end
points.

If you want to reset a bevel shape to its original
state, just click on the bevel you originally loaded in.

Adjusting points

To move a point, just click and drag the point —
don't click, then drag. You can select or deselect

additional points by holding down the Shift key and
clicking on the point(s). Holding down the Shift key
while moving a point constrains its movement to
vertical, horizontal, or diagonal. You can also drag a
selection box around a group of points to adjust all
of them together.

Be careful selecting points. Remember, you'll toggle
between the two types of points simply by clicking
on a point once it's selected.

Holding down the Command key restricts opera-
tions to points only — you won't have access to the
handles. This is handy where handles and points are
very close together and one may interfere with
selecting the other.

Adjusting handles

Ordinarily, you can adjust both the length and the
direction of a handle. Holding down the Shift key
while dragging a handle constrains the length if you
change its direction, or its direction if you change its
length.

Holding down the Option key restricts operations
to handles — you won't be able to grab any points.

Using the Delete key on a handle doesn't actually
get rid of it. It just makes its length O, so you can pull
the handle out again to lengthen it if necessary.




If you need to undo an operation, use Command-Z.

Warning: You can end up making some pretty crazy
bevel shapes starting from the ones provided. If the
line actually intersects itself somewhere, you'll get
some unexpected results. But who knows, they may
be just what you were looking for

Tips: We've found that some of the most interesting
bevel shapes result from treating the end of the
bevel in two contrasting ways. One is to create a
marked discontinuity where the bevel meets the
face: an inward or outward bulge or V"' shape, for
example. The other is to make a very smooth transi-
tion from the face, and then curving to catch high-
lights. Also, you can get more complex shapes if you
don't make the bevel symmetrical front and back,
but ignore the back of the bevel (if you won't be
seeing it in the image). This allows you to drag some
points to the front that would otherwise be used in
the back.

* Note: You should design the bevel with the
character's Depth setting in mind. If you later change
a letter's thickness very much it will tend to exagger-
ate or diminish the effect of the bevel shape. For
example, thickening a letter with a small bevel size
will stretch out rounded bevels, tending to flatten
them.

Let's take a look at a short bevel editing session, by
way of example.

Here's a simple bevel before anything's been done
to it:

Next, the middle point has been dragged up and
over slightly.

The point has been changed so the handles can
move independently, so we can create a corner. The
right handle has been made to point straight up:

using the bevel editor

getting text in




The lower left point’s handle has been pulled way
out to the right:

h 3

Now the middle point’s other handle has been
swung around more than |80

The finished bevel curve:

Saving finished bevels

Once you've got a bevel the way you want it, you
can save it:

|. Click on the Save button. This brings up a dialog
that allow you to type in a name for the bevel.

2. Type in a name and click on OK.

The saved bevel will be available in the Custom
Bevel popup menu.

Replacing text

If you've gotten text in, but notice a typo or need to
replace it for some reason, use Replace Selection
from the Edit menu. All settings are preserved,
allowing you to simply type in new text. Use this to
change the text of a selected object.

= Warning: For this to work the object must still
be grouped as it was when you typed it in. This fea-
ture is disabled for subobjects (individual letters of a
grouped word).




Image: Joy Folla

Font: Remedy Single
Build Method: Extrude
Bevel: custom (flat)

Effects: Particle System; Mass 2,
Elasticity 12, Colors green and
purple, Randomness O, Particle
Density 2, Ejection Speed 6

Text Look: ECGems Swirl Flat
Lights: #5 100%; #7 75%

Frame # |7 rendered

getting text in



B walls

B floors
S feaces
! metals
B sidings
8 fine fabrics
B animal skins
Bl cxotic woods
B cerrific roofs
=3 ground covers
- miscellancous
@ clegant stones
o peautiful bricks
ACD for Macintash and Windows
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The Pixar One Twenty Eight CD
contains Pixar's stunning collection
of seamlessly tiling digital pho-
tographs. These exquisite high-
quality textures are ideal convert-
ed into Looks for use in Pixar
Typestry. You'll be delighted with
the variety and the rich photoreal-
istic detail these textures will add
to your images. They ship as 512x
512x24 bit TIFF image with easy
Photoshop and PhotoStyler com-
patible plug-ins. So in addition to
using them as Looks you can add
these dazzling textures to all of
your 2D and 3D graphic projects.
Macintosh, Windows, and Unix

versions all on one CD.

This image was created with Pixar Typestry

PixXAR ONE TWENTY EIGHT

A COLLECTION OF PHOTOGRAPHIC TEXTURES
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Rendering an image

You can create an image in two ways:

* Render to a screen window, which you can save
to a file.

* Render to a file, which you can then display.

To render an image to a window just select Render
to Screen from the Render menu, and select a quali-
ty setting:

Motion Windows
Render to Screen )
Render to File...

Quick 'n Dirty *®E
Reasonable %R
Excellent 'n' Slow #T
Custom ®Y

Image Format... I
Custom Quality... T

Quick ‘n Dirty produces a quick, low-quality

image, good for checking position, general lighting,

color, etc.

I'e”(’(:‘!/ﬂg an image

making a picture



Reasonable produces a reasonable-quality image,
in a “reasonable’” amount of time. Use this to see
more detail in an image: shading, beveling, effects,
highlights, etc.

Excellent ‘n‘ Slow produces the highest-quality
images (apart from customizing the quality), but
takes a little more time to do so. For this reason, this
is the one to use for final images.

Custom renders with the settings in the Custom
Setup dialog. See the section on "“"Customizing image
quality” later in this chapter.

If you're using shadows that might need to be
recomputed, you'll be prompted to choose from
four options (you can read about how to have lights
cast shadows in "“Using the Lights window" in the
Adding Lights chapter):




@ shadows

Some shadows may
need to be computed.

|| compute shadows |

(Render with old Shadows |
[ Render without Shadows |
)

[ cancel Rendering

Compute Shadows proceeds with shadow calcu-
lations and when done, renders the image.

Render with old Shadows skips the shadow cal-
culations and uses shadow information from previ-
ous renderings (if any) while rendering the image.

Render without Shadows skips shadow calcula-
tions altogether and just renders the image.

Cancel Rendering does just that.

To force shadows to be recomputed, just move an
object and Undo the move. When you render, you'll
be prompted to Compute Shadows.

*  You can use the Render Status window (select
Show Render Status from the Windows menu) to
monitor the rendering’'s progress. Any messages
from the renderer will appear there as well.

@ render status

Cancel Rendering

% done BT

[Starting to render.
[Computing image : Untitled 1PICT.1

<l

To render an image to a file:

I. Select Image Format from the Render menu.
This brings up the Image Format dialog:

@ image format

Window Size Output File []Constrain Aspect Ratio
pisels  Width 400.00 | IFTTENRG
pisels  Height  [300.00

72 pinels/in Resolution | 72 [ pixels/in__+]
File Type PICT V|
(Set Bofouit] File Size  468.8K Cancel n 0K l

2. Check the Constrain box if you want to force
the ratio of the width and height to remain the
same. You can set either one and the other will be
computed automatically to maintain the image's
aspect ratio. When this is not checked, you can cre-
ate an image of any rectangular shape.

3. To force the image to have the same dimensions
and resolution as your on-screen project window,
click on the "“>>"" button. This loads the Window

rendering an image
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Size values into the Output File settings. Otherwise,
type in a width and height for the image, and set the
units with the pop-up menu.

Warning: It's easy to have different dimensions when
you render to a file than the dimensions of your
project window! If this happens either the sides or
the top of your file's image may seem to have been
cut off. Be sure the file's aspect ratio (shape) is the
same as your window’s. You can ensure this by first
loading the window's dimensions into the file's by
using the “>>" button, then checking the Constrain
Aspect Ratio box. Now you can change either
dimension for the file, and the other one will do the
right thing.

4. Type in a resolution, and set the units with the
pop-up menu.

5. Select a file format:

Tiff rgb

Tiff rgb (packed)

Tiff rgba

Tiff rgba (packed)
vPICT

EPS

RIB

TIFF rgb. This is probably the most generally use-
ful form of TIFF. No compression is used, and no
alpha information is present (see TIFF rgba).

TIFF rgb (packed). This is the same as TIFF rgb,
but is compressed using PackBits compression, sav-
ing disk space. Some software cannot handle com-
pressed TIFF.

TIFF rgba. This is the same as TIFF rgb, but
includes alpha information. Alpha information stores
the coverage of the rendered picture, so that it may
be used later as a foreground and composited
seamlessly over a background.

TIFF rgba (packed). This is the same as TIFF
rgba above, but packing is used to save disk space.

PICT. This creates a 32-bit RGBA PICT file. This
format contains alpha information (commonly used

to control transparency or masking in an image) in 8
of the 32 bits.

EPS. This creates a color Encapsulated PostScript
(EPS) file. This format may not be readable by some
non-color printers. If it is, it will simply appear in
gray-scale.

RIB. Use this format to create a file you can import
into Showplace or MacRenderMan.

6. If you want the current settings to be the default
settings, click on the Default button.

7. Click on OK.

8. Select Render to file... from the Render menu.




This brings up a save dialog allowing you to specify a
name and location for the rendered file.

9. Type in a name and click on Save. This brings up
the Render to file dialog.

@ render to file

Image Quality: O Low O Medium @ High O Custom

Image Format: TIFF, 280 & 210 pixels.
Shadows: @ Compute Shadows
(O Render with old Shad
O Render without Shad

| 0. Select a rendering quality and shadow option
(described earlier) and click on OK. If you're not
using shadows, these options will be grayed out.

*  You can use the Render Status box (select Show
Render Status from the Windows menu) to monitor
the rendering’s progress. Any messages from the
renderer will appear there as well.

Restricting the area to be rendered

Untitled 1

Front View frame 1 El

You don't always have to render the contents of the
whole window. You can ‘‘crop out” areas you don't
need to see by using a crop window; just the con-
tents of the crop window will be rendered. That's
what the Crop tool is for. See the section on ““The
Tools” in the Manipulating Text chapter for more on
the Crop tool.

Selection group!

Customizing image quality

You can customize certain quality settings when you
render. These settings appear in the Custom Quality
dialog, which appears when you select Custom
Quality from the Render menu. These settings con-
trol somewhat esoteric rendering “*knobs;" you may
get by quite well without ever using them at all.

rendering an image
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@ custom quality

Pixel Samples (M4 Hider Quality O Low

shading Rate @ High
Gamma [ Binary Dicing

Shading O Flat Load Values From:

@ Smooth Excellent 'n' Slow

Memory Usage O Lo (temsonae ]
@vetum ok iy

O High

O €1 Gordo (Cancel )

Pixel Samples controls the accuracy of a pixel's
color. Higher numbers produce higher quality, but
increases rendering time. You should never need to
set this above 4.

Shading Rate controls the amount of detail you
see. Numbers much below | can significantly
increase rendering time; you'll probably never need
to set this below .5.

Gamma controls essentially the contrast of an
image. You can adjust this according to the final for-
mat in which the image will be displayed, whether
that's a printed page or your monitor. On many
monitors a gamma value of 1.0 (no gamma) will look
dark; 1.8 might look more normal.

Shading controls how well small areas of the image
are shaded. Smooth yields nicer results, and should

be used for high quality images, but slightly increases
rendering time and requires more memory.

Memory Usage controls what proportion of the
program'’s memory to give the renderer. Complex
images (e.g., ones with lots of letters, shadows, per-
forations, etc.) will probably render faster if you
increase two memory settings. The first is this one.
The second is the program’s memory. If you can
afford to do so, give the program as much memory
as possible. To increase the program’s memory, in
the Finder select the Typestry icon and select Get
Info from the Finder's File menu. Type a higher num-
ber in the “Current size” box, and close the win-
dow.

Hider Quality controls how well hidden surfaces
are removed. High quality improves images at the
expense of rendering time.

Binary Dicing controls how well joints between
the pieces that make up the parts of the letters are
handled. If you see what seem to be cracks in let-
ters, try turning this on to eliminate them.

Load Values From sets the custom controls to
the values used by the three normal quality settings.
This is mainly for you to refer to when customizing
your setting.
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Using the Grid

Use the grid to help you with aligning things in the
project window. Select Toggle Grid from the Edit
menu to turn the grid on and off. The dimensions of
the grid are set in the Preferences dialog, available
under the File menu. This is most profitably used in
conjunction with the Telephoto setting, available in
the Camera menu under Effects.

EN Untitled 19 HE| [EOE Untitle EEIE

Selection : none Front View frame 1

[

Selection : none

[&

Note: The grid divides up the window itself, not the
space in the window. This means that if you resize

the window, the number of grid lines doesn't change
— the grid resizes along with the window.

Use the toolbox to manipulate text in the project
window. Click and drag on the text itself to manipu-
late it.

Selecting text

With any tool but the Text tool, double-clicking
allows you to select objects at different levels (a
grouped word, a letter, faces, etc.). Each double-click
goes one level farther down. At the lowest level,
double-clicking pops you back up to the top level.

selecting text
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At any level, a single click selects only other objects
at that level: if you've selected a letter, single clicks
will only select other letters, not the whole word.
Click in an empty space to deselect everything.
When you click again on text, you'll be at the high-
est level again.

In general, for extruded objects in Typestry there
are three levels, or groupings, from which you can
select. (Rubber Sheets have two, and Tubes have
only one.) From highest level to lowest these are:

*  The whole text object. When nothing is select-
ed, clicking on a text object selects that object.

*  One letter of the object (sides and faces togeth-
er). When an object is selected, double-clicking on a
letter selects just that letter.

* The faces of a letter (no sides). When a letter is
selected, double-clicking on that letter selects just
the letter's faces.

For more information on grouping and levels, see
the chapter on Group Therapy.

Selecting hard-to-get text

You can select text in the project window that's
obscured by other text, or otherwise hard to select:

I. If the Score window isn't showing, select Show

Score from the Windows menu.

2. Find the object in the Score window on the left
side and select it.

3. Hold down the Control key as you manipulate
the object in the project window.

The Tools

Use the tools to manipulate text. Tools that have a
square dot in the lower right have pull-aside menus
with variants of that tool. Click and hold to display
the menu.

The Text tool

A Use the Text tool to get text into the project
window and to import Adobe lllustrator files (see

the chapter on Getting Text In for more on this). The
tool on the right of the menu is for importing these.

ALK,

The Move tool

Use the Move tool to move text around in
the project window. You may see its perspective
change as you move it.




Note: Holding the Shift key down while starting to
move an object constrains its motion to the hori-
zontal or vertical.

The Rotate tool

"g!. Use the Rotate tool to rotate text. This tool
rotates the object as if it were enclosed in a sphere
(the way a trackball works): side-to-side mouse
motion spins the object around its vertical axis, for-
ward-back motion spins it around the horizontal
axis, etc.. If you'd like to use a rotation tool that con-
strains the rotation to one axis at a time, click and
hold on the tool and a pull-aside menu will appear.
You can pick the appropriate tool from there.

v.9 e 0,

Note: If you get the text in a weird orientation that
you can't get out of using Undo, use Reset

Orientation from the Edit menu. This will get the
selection straightened out and face-on.

Using the unconstrained rotation tool (and not the
others in the pull-aside menu):

* Move the mouse to the right for east-to-west
rotation (the right side of the text moves toward
the back).

« Move the mouse away from you for south-to-

north rotation (the top of the text tips backwards).

»  Holding down the Shift key after you've started
to rotate text temporarily stops the rotation, allow-
ing you to reposition the cursor. Let go of the Shift
key to resume rotation.

With the Rotate tool selected, holding the Option
key down while clicking on the text brings up this
dialog:

@ rotate

Angle: degrees

Axis: @ O O

With this you can rotate a specified amount (from
—360° to 360°) around any of the selection’s three
axes. The arrows in the dialog box show the direc-
tion of positive rotation.

The Scale tool

Use the Scale tool to resize text along one or more
of its axes. This tool affects the text's width, height,
and depth together. Use the pull-aside menu to get
a tool that allows you to constrain the scale along
one axis.

the tools
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* Rightward mouse motion enlarges text, leftward
shrinks it.

Holding down the Shift key while dragging constrains
the resize to horizontal or vertical, depending on
which direction you first move the mouse.

Holding down the Option key while clicking on the
text brings up this dialog:

‘g scale
e

) Uniform width height depth

@ Nonuniform % % %

With this you can resize a selection in two ways:
*  Uniform, which resizes an object as a whole.

* Nonuniform, which resizes width, height, and
depth differently).

To use this, just select Uniform or Nonuniform, and
enter a percentage by which to resize the selection.

Holding down the Option and Shift keys while drag-
ging forces one dimension to grow while the other
one shrinks by the same amount (‘‘volume-preserv-

ing" resize). This is useful in creating an object that
looks “'squashed and stretched,” as a rubber ball
does when it hits the floor.

Note: Changing some text’s thickness will change
the shape of a rounded bevel: thickening will tend to
smooth it out, thinning will exaggerate it (see the
images in section Getting Text In). You can restore
an object’s size to the size it was when you first cre-
ated it using Reset Scale under the Edit menu.

Here are some examples of non-proportional scale:




The Skew tool

Use the Skew tools to give text a slant along one of
its axes. The pull-aside menu provides tools to skew
along individual axes.

g W&

Holding down the Option key while clicking on an
object brings up this dialog:

@ skew

Angle: degrees

Asts: @ o o

With this, you can skew a selection along any of its

axes by any amount. To use this, just select an axis,

and enter an angle by which to skew the selection.

The following images show the Skew tool being

applied:

the tools
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The Crop tool

had Use the Crop tool to restrict the area to be
rendered: you don't always have to render the con-
tents of the whole window. You can *“‘crop out”
areas you don't need to see by using this tool; just
the contents of the crop window will be rendered.
In the illustration at right, you only see the area with-
in the crop box when you render.

=

6), """

Selection :group1 Front View frame 1 [&|

To get rid of the crop window, just click somewhere
else in the window.

With this tool selected, holding down the Option
key and clicking in the project window brings up the
Crop Window dialog.




.g render cropping

X Active
left % Crop Mark Behavior
right m % @ Crop
top “ % O 2oom
bottom m % : '
[ox )

Here you can do three things:
«  Make the crop window active or inactive.

« Determine numerically what area the window
covers. Use percentages to specify where the edges
of the window are. For example, values of 50, 100,
50, 100 specify an area that covers the bottom right
quarter of the project window.

« Determine how the crop window should work.
The crop window works in two ways:

Crop. This the normal mode, where the partial
image is rendered at the size of the crop window as
you see it on your screen.

Zoom. The partial image is rendered ‘“zoomed up:”
the crop window is expanded proportionally so one
of its dimensions matches the project window's. This
is especially handy when you want to create an ani-
mation that has an object disappear from view. You

can have the object in your project window, and
control the animation normally, but when it's outside
the crop window it won't appear in the rendered
frames with this option turned on.

. Click and drag the handles (in the upper left and
lower right comers) to adjust the crop window.

«  Click and drag anywhere inside the crop window
to move it.

Only what's in the crop window will be rendered.

. To force the crop window to take the shape of
the project window, hold the Shift key down while

resizing the crop window. This is useful when used

in conjunction with the Zoom setting: it allows you

to create animations where objects enter the frame
from one side.

Grouping

The Group Therapy chapter goes into some depth
explaining grouping concepts. This section deals with
the practical issues: how to group, what it's good for,
etc.

Extruded text objects have a default grouping when
you create them. Whatever characters you type in
are automatically grouped into one object. Within
this group, each letter is itself a group consisting of

group/ng
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two elements: |) the front and back faces (which
are a single object), and 2) the sides (also one
object). Type in another text string and you have a
new group. However, you can rearrange and
regroup things quite simply.

If the Score window isn't already showing, select
Show Score from the Windows menu. The left side
of this window displays the groups' elements as if
they were files and folders in the Finder. All “‘fold-
ers” are groups. And you can move things around
just as you do in the Finder, by clicking and dragging.
Use the grey bar at the left end of the “folder as a
handle for dragging. Drag an item into a different
“folder’” and the item and anything in it automatically
becomes a member of that group. Additionally, you
can change the order of things by dragging the ele-
ments or groups up or down. You'll see why this is
useful in a moment.

When you click and drag an element (slowly) you'll
see a purple cursor appear at the drag bar. This tells
you where the element would end up if you were
to release the mouse button. If you don't see the
cursor, the element won't change places.

Group 1!
Object 1]
Object2:

Why would you want to group things? Well, for four
reasons.

*  You can apply Looks to many objects at once.

* You can manipulate the position, orientation,
scale, and skew of many things at once.

* You can perforate objects.

* You can gain incredible control over animations.
You can read about this in the Animation chapter.

Groups and Looks

You can organize words and letters around Looks, if
this serves your purpose. Applying a Look to a
group makes it unnecessary to apply the Look to
each of the group's elements. Additionally, once you
have things positioned the way you want them you
can regroup things into Look-based groups, putting
pairs of letters together, for example, to apply Looks
in groups of two.

Groups and the tools

If you've worked with any of the popular drawing
programs, you're no stranger to grouping things to
have one operation apply to many things at once.
It's a simple idea. The Move, Rotate, Resize, and
Skew tools operate on whatever's selected. If the




selection is a group that contains many objects, you
can get a lot of work done at once. Use grouping to
have an operation apply equally to multiple objects:
when you resize a group, all its elements will have all
three dimensions scaled exactly proportionally.
When you rotate a group, some elements may end
up behind others, which you can use as a tool to
gain depth in a scene.

Creating a group
To create a new group:

I. Select Group from the Edit menu. This creates a
new group. If an element was selected when you
used the Group command, that element will be
included in the new group.

2. If you wish, type in a name for the group by
highlighting the name and typing in a new one.

To ungroup grouped elements:
|. Select the group you want to delete.
2. Select Ungroup from the Edit menu.

Warning: Don't use the Delete key to try to
ungroup! This will delete the group and everything in
it.

Perforating objects

You can get some quite interesting effects by com-
bining objects in unusual ways. You can do various
sorts of perforation, embossing, debossing, and over-
lapping. The all-too-familiar IBM logo is an easy
effect to create. You're not limited to using a few
shapes for these operations — you can use any
object you can get into Typestry.

There are three basic steps. We'll lay them out here,
and then explore them in detail in a tutorial:

|. Create one object that overlaps another. (An
object can itself be a group.)

2. Group the objects.
3. Set the group’s perforation (perf) mode.

The perf modes are available in a popup menu in
the Score window. To display the menu, just click
and hold on a group’s perf icon, just to the right of
the gray drag bar:

= Simple Group

E Perf Intersection

Perf Difference

Once you've created a group in which two objects
overlap, here's what you can do:

perforating objects

manipulating text




* Create a composite object from the two ele-
ments. This is the default behavior. The group’s
name will be preceded by the “Simple Group’ icon,
indicating that it's a simple group.

< | Group 1
> Object !
b DObject2!

* Render only the overlapping areas. This is called
an “intersection.” For this effect, set the perf mode
to Perfs Intersection. The group's name will be pre-
ceded by the Perfs Intersection icon (El)

< [{[m] |Groupit

> Object !

> [IE] |object2:




« Remove any overlapping areas. This is called a
“difference.” For this effect, set the perf mode to
Perfs Difference. The group’'s name will be preceded
by the Perfs Difference icon (@). In the group you
create to hold the objects, the second (lower) ele-
ment in the group gets subtracted from the first
(higher) element.

Group 1
b [IS_|object
b FIS] Jobject2

Warning: Using perforations increases rendering
time. Using multiple characters for perforations can
make a dramatic difference, slowing things down and
increasing memory requirements significantly.

Perfs tutorial

Ok, let's try one. Let's make the N in the word
“ONE" have the word "two'" carved out of it. If
your Score window isn't showing, bring it up now by
selecting Show Score from the Windows menu.

I. In Typestry, type in the word “ONE" (all caps) in
some fat font, as bold as possible. Use the Extrude
Build Method, and any bevel you wish.

2. Type in the word “two” (in lower case) in a thin-
ner font, also using Extrude, with any bevel.

3. Now you should have two words on your
screen, something like this:

ONE
twW@

Front View frame 1

—

Selection :string. 1
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4. In the Score window, change “string. |" to
“ONE" by clicking on it (so it's highlighted), then
typing. Change “'string. 2" to "“two.”

5. In the project window, make the “"ONE" big, and
the “two’’ small: adjust the sizes of the words so the
“two'" is small enough to fit into the N in “ONE."

6. Place the "two’’ somewhere in the N:

==——— Untitled | EE
Selection string. 5 Front View frame 1

For the “two" to create a hole all the way through
the N, it must stick out both the front and the back
of the letter. If the front of the “two’" is behind the
front of the letter, all we'll see is the front of the let-
ter, and not the hole inside where the “two’ is. If it
sticks out the front but not the back, it'll seem like
the “two’’ doesn't poke all the way through.

7. So make the “two" thicker than the N. Be sure
to use the Top and Left views, available under

Camera in the Effects menu, to check that the "“two”’

sticks out in front and back of the letter. (If you
want, you can also use the Telephoto lens, available
under Camera in the Effects menu to get rid of the
perspective distortions. But don't forget to set this
back to Normal when you're done.)

» If you're having trouble selecting the right object
to scale, select it in the Score window, hold down
the Control key, then click and drag in the project
window.

Now for the subtraction.

* Remember, within a group the first element is
the one subtracted from. All the other elements get
subtracted from the first.

So we're going to have to group things carefully to
get the effect we want: ""two” subtracted from the
N. To be safe, let's make a group that includes only
the letter and the "two.” It doesn’t matter if this
group is inside another group, or at some other
level. The subtraction will apply only within the
group we create. Just for practice, let's make the
group at the level of the letters in “ONE."”

8. We'll need to see the contents of the ONE
string, so in the Score window click on the triangle
to the left of the ONE string. Now you should see
ONE's elements (the individual letters).

9. Select the N; then select Group from the Edit




menu. Now there’s a group that has just the N in it.
Now let's add the “two" to the new group:

10. In the Score window select the “two’’ and drag it
(by its gray bar) into the group. The purple cursor
should be directly below the N's drag bar. Your
Score should look something like this:

- @ e
b [AlS]_Jchar 0.5
Groupl:

b {lO]_Jchar N.&;
> FIS] Jtwol

| I. Now all you have to do is change the perf mode
of the group holding the N and the “two:" click and
hold on the group’s perf icon, and select Perfs
Difference in the popup menu.

Now you can render. Be forewarned though, perfo-
rations do increase rendering time, so just use the
Reasonable rendering setting for this session, unless
you can afford to use Excellent ‘n’ Slow.

- Don't forget, you're not restricted to using letters
for doing perforations. You can use any character at
all — characters in the PixarPerfs font (see below),
characters in a dingbats font (e.g. Zapf Dingbats), or
shapes in imported Adobe lllustrator files. (For more
on importing lllustrator files see the section on
“Importing lllustrator files” in the Getting Text In

chapter.) If one of the font creation packages are up
your alley, you can make shapes in them, too.

The PixarPerfs font

We used Fontographer to build a font with special
characters just for perforating objects (though you
might also use some of them to add interest to your
image). You really should try some of these, now
that you know how to do perforations — they're
much more fun than letters!

You should have installed this font in your system at
the time you installed Typestry. The character set
appears at the end of this manual. Alternatively, you
can use the Key Caps desk accessory to view all the
characters. These are just a small sample of the kinds
of shapes you might want to use to get away from

your basic “image with letters in it.”
Efi=—————— uUntitled IPICT.0 =———W
<+

twol T
<
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Image: Joy Folla

Fonts: Novarese Ultra, Gill Sans

Build Methods: Extrude; colored
angled bevel for T, custom (flat)
for Pixar...

Effects: Wall

Looks: Picture as Background with
Pixar 128 White Oak; ECGems
Dented Jewel, light blue, 5% scale;
Matte, light blue

Lights: #2 65% spotlight, #8 100%
spotlight with shadow,
Ambient 20%

“Pixar Typestry'" was typed on a line
in lllustrator and imported
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L,‘ght types Distant lights. This is the default — Typestry uses
distant lights unless you choose some other light
Use the Lights toolbox to adjust the lighting. Look from the Browser. Light from a distant light

source has a direction but no specific point of origin.
To add or adjust lights, select Show Lights from the

This is like light emitted from a distant body such as
Windows menu. This displays the Lights toolbox.

the sun, where all the light rays are parallel through-

out the scene (see the illustration at bottom).

’»Q’ lig
@ Front O Back
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. -
For the numbered lights you can change the look of ‘
the light to three things. These are called Looks: . ‘/Q -

light types

adding lights




Spotlights. Light from a spotlight Look casts a
cone of light from a specific location in a specific
direction. Only surfaces that fall within the cone are
illuminated. Some spotlights are “built” with stuff
across their faces: slats (creating effects like window
panes or blinds), hunks of gauze, and so on.

o A

Slide projectors. These are like spotlights, but
they cast an image (provided by you) onto objects.
Apart from casting an image, these differ from spot-
lights in the shape of the lit area, which must be rec-
tangular, since your image is rectangular. (Of course,
with real slide projectors it's the slide's rectangular
frame that shapes the lit area.) Since you can use
your own image in the Look, you can create inter-
esting variations of the Spotlights, for example. For
more on getting your image into a Look see the
section on “Getting a picture into an Instance” in
the Editing Looks chapter.




TV Screen. The TV Screen Look is special. This
allows you to use your own image to put on some-
thing like a TV screen at the light's location. This
shining “'screen” will be reflected by any objects in
the scene that are shiny enough to be reflective. Like
a real TV screen, it shines light, but only at a relative-
ly low intensity. Of course, images you use don't
have to be exactly the same shape as a TV screen,
they can be any rectangular shape. In fact, by having
an image repeat endlessly, you can create a screen
that's infinitely big, as in the picture below.

Using the Lights window

The illustration on the toolbox indicates the posi-
tions of the lights relative to the text.

@ Front O Back

This is representative of a bank of lights in front of
your monitor, pointing into the middle of the moni-
tor, illuminating the text:

Note: Turning on too many lights can really wash
out an image. One or two lights will often be suffi-
cient!

The “A"” (for Ambient) light near the bottom of the
Lights window is a “global” light. It's as if its light
comes from everywhere, as if there were an enor-
mous sphere around the scene casting light from
everywhere on its surface.

using the Lights window
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Note: Too much ambient light tends to “wash out”

an image.

The “E” (for Environment) slider at the bottom of
the window is used for reflections. These reflections
will appear on all objects in the scene that are shiny
enough to reflect. Clicking on the right-most box
allows you to select a Reflection Look. By selecting
the Use Your Picture Look in the Environments fold-
er you can supply your own image to be used as a
reflection. For more on using reflection pictures, see
the section on “Reflection issues” in the Editing
Looks chaper.

*  Note: When you use the E slider, unless you
turn off a Look's simulated reflection you'll get two
reflections: the simulated one and the E one. These
can add together to form an interesting reflection.
However, if you'd like to turn off the Look’s simulat-
ed reflections see the section on this at the end of
this chapter.

Use the sliders to control the lights’ intensity: all the
way to the left effectively turns the light off (zero
intensity), all the way to the right is “full’”” intensity.
For the E light, the slider controls the intensity of the
reflection.

intensity
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The boxes allow you to set a light's color, Look, and
shadow-casting ability (see below).

Note: Some Looks ignore all light settings (e.g. Sky
or Constant). Also, some Looks respond differently
to light intensity: settings that work for one Look
may be too bright for another. This means there's
no magic formula for lighting that will work for every
picture — you'll have to play with the lights to get
things the way you want them. However, the default
settings will produce a reasonable image.

Select front or back lights using the buttons at the
top of the toolbox.

gg lights
@ Front O Back

@ lights
(O Front @ Back
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To set a light's color, click in the first box to the right
of the light. This brings up the color picker. Click on
the color you want, then on OK.

Click on the middle box to set the look of the light.
This brings up the Browser, allowing you to select a
Light Look. The default installation puts light Looks

in the Lights folder in Pixar Applications:Look Instanc-
es:Starter. Clicking and holding on the box displays a

popup menu:
? ml[____ll
8 T -
Edit Look...
2 -:{Q Detach Look

New Look. Selecting this brings up the Browser,

allowing you to select a light Look.

Edit Look. Selecting this brings up the Looks
Editor, allowing you to edit the Look's parameters.
See the chapter on Editing Looks for more on this.

Detach Look. Selecting this removes the light's
Look. The light will revert back to the default distant
light.

Click on the third box to enable the light to cast
shadows behind the objects. (Shadows increase ren-
dering time.) Shadows cast by any light that's not a
distant light will tend to spread out somewhat.

Note: In Typestry, shadow casting is a characteristic
of a light, rather than of an object.

using the Lights window

adding lights




When using shadows, there are times when the
shadows may need to be recomputed. When you
render you will be prompted to allow this “preren-
dering.” Shadows need recomputing when

* you have just checked Cast Shadows for one or
more lights; or

« if you move, rotate, resize, or extrude a shadow-
casting object (the shape or location of the shadow
may change).

To force shadows to be recomputed, just move an
object and Undo the move. When you render, you'll
be prompted to Compute Shadows.

See the chapter on Making a picture for more infor-
mation on rendering with shadows.

Special lighting features

Clicking on the diagram of the lights in the lights
toolbox changes the diagram and allows you to
adjust a light's position, orientation, and spread:
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To move a light, just click and drag it. The light will
remain pointed at the center of the image.

* To reset all lights to their default positions and
settings, select Reset Lights from the Edit menu. This
deletes any settings in the Light Info dialog, as well as
lights' positions in poses where they are set!




Holding down the Option key while clicking on a

light brings up this dialog:

View from Light

F{ light info

Light # 7

Selection: string. 1
Tracking:

Point at Center
Point at Selection
Track Selection

(e )

If the light uses a spotlight Look, you'll see this dia-

log:

@ light info

Diew from Light

Spot Cone Angle
- ¢ +

Light # ?

Selection: string. 1
Tracking:

Point at Center
Point at Selection

Track Selection

f

i

Use the Spot Cone Angle slider to narrow or widen

a spotlight's cone of light:

View from Light

Spot Cone Angle
- L4 +

special lighting features
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Uiew from Light
L 1) N\

Spot Cone Angle
-9 +

[ Point at Center |

By default, a light points at the center of an image. If
you have changed this, click on the top button to
have the light point at the center again.

[ Point at Selection |

Use the middle button to make the light point at the
center of the selected object. You may need to
group objects to get the light to point at the center
of the group. You can also use this feature to train a
light on an invisible object; this way you can point
the light in an (almost) arbitrary direction. To do
this, just turn the object’s opacity all the way down;
this makes the object invisible (and it won't cast a
shadow either).

[ Track Selection |

Use the bottom button to make the light track (fol-
low) the selected object during an animation. You
can also use this feature to have a light track an
invisible object, so it looks like the light is moving
independent of the objects in the scene. To do this,
just turn the object’s opacity all the way down.




Turning off simulated reflections

If you're using the E light to create reflections, you
may want to turn off any simulated reflections. This
is not a light operation, but rather a Look operation.
To do this:

|. Select the object that has the Look you want to
change.

2. In the Looks window, click on the Edit Look but-
ton. Or, in the Score window, click and hold on the
object’s Look icon and select Edit Look. This brings
up the Edit Look dialog.

3. Look for the Reflection Type parameter and set
it to None. This will turn off the simulated reflection,
allowing the Look to use anything provided by the E
light.

4. Save the Look.

Don't forget, if you used Save As to save your Look
you'll have to apply the new Look you just created
to any other objects that used the Look you
changed. If you need to know how to apply a Look,
see the chapter on Applying Looks.

turning off simulated reflections
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Image created with Pixar Typestry. Pixar Showplace is available
for the Macintosh in disk or CD version.

Pixar Showplace is Pixar's powerful 3D
scene composition software. With it you
can create realistic 3D scenes on your
Macintosh without modeling. With Pixar
Showplace you simply select and import
objects from a library of over |30 pre-
designed ClipObjects, or you can import
your DXF, Adobe lllustrator or RIB files.
Pixar Showplace also features some amaz-
ing Plug-ins for creating editable models.
Once you've select and placed your
objects, cover them with any number of
striking Looks. Then, set your Lights and
view your image from any angle. Pixar
Showplace includes: Photorealistic Mac-

RenderMan, Glimpse, and NetRenderMan.

PIXAR SHOWPLACE

CREATE GREAT 3D SCENES WITHOUT MODELING




Applying a Look

What's a Look, and why would you want to apply
one? Well, in the real world we refer to the look of
a material, or the look of the light, meaning the char-
acteristics peculiar to the material, or light. Pixar
Looks mimic these characteristics. VWhen you want
an object to be metallic, or rough, or red, you apply
the appropriate Look.

To apply a Look to some text, or a wall or floor:

I. If you're applying a Look to some text, select the
text object by clicking on it in the project window.

2. Select Show Looks from the Windows menu or
click on the Looks window if it's already showing.

3. Select the radio button for the appropriate item:
your text, the text's sides, the wall, or the floor.

4. Click on the New Look button. This brings up
the Browser.

5. Use the dialog to find a Look; click on the Look
to highlight it. An example of the Look will appear in
the box in the upper left.

@® group1
Q Sides
O wall
O Floor

6. Click on the Select button. You'll see the select-
ed Look appear in the Looks window.

7. If you don't need to adjust the Look, you're
done: the Look will appear on the selection the next
time you render.

You can also apply a Look to text (not the wall or
floor) from within the Score window. With the
Score window showing:

applying a look
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I. Click on the gray button just to the left of the
name of the object you want to change, or click and
hold, and select New Look from the popup menu
that appears. (If a Look is already applied, this button
will have a miniature icon of the Look on it.) This
brings up the Browser.

b =] Jspinnaker
“%lBE%Nem Look...

Edit Look...
Object Info...
Detach Look

Then follow steps 5—7 above.

To adjust a Look, see the section on this below.

Copying a Look

To copy a Look from one object to another, you
should be in the Score window. Here, you can just
drag the little Look icon from one's Look field to the
other’s.
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Using the Browser (‘“‘select a look’’ dialog)

Using the Browser, you can build up a palette of
Looks to use in your projects. This palette will be
available each time you open Typestry.

Click on a Look in the file name list to display it in
the Look Example window.

@ select a look

= DocMacll
O Constant ¥ ™
D Glass i
0 Matte
O Metal Polished S
D Metal Rough
O Plastic Polished

|

Click on the Add button to add a Look displayed in
the Look Example window to the Look palette at
the bottom. (Or just click and drag from the win-
dow to the palette.)

Click on the Remove button to remove a Look
from the palette.

Clicking on a Look in the Palette displays it in the
Look Example window.




The Look displayed in the Look Example window
will be applied to the selected object (text, wall, or
floor) when you click on the Select button.

Be sure to use the palette to save time. You
can click and drag any example image into the
palette. The next time you open the Browser, click-
ing on the image in the palette automatically takes
you to the folder that contains the item and makes
it available for selecting. If you have some favorite
Looks that you use a lot, drag them into the palette.
This way you won't have to search around your
folders to get to the right one.

Another thing you can do is to put into the palette
Looks from many different folders. To get to a par-
ticular folder, just click on the palette image of the
Look that's in that folder. (Of course, you'll have to
remember what Look is in which folder, but hey, we
can't do everything for you!)

Use the Get Info button to get the lowdown
on a Look. You can get interesting and important
tidbits from these descriptions. Check them out.

Adjusting a Look

You can adjust a Look on a selection in two ways.

« Clicking on the Edit Look button brings up the
Look Editor. See the chapter on Editing Looks for
details on using this. The Look Editor allows you to
change almost everything about a Look that you
might want to.

« The other way to adjust the Look is to use the
Object Info dialog (the effect of the adjustments will
only appear when rendered). This contains the most
commonly-used controls.

To use the Object Info controls:

|. With an object selected, bring up the Object
Info dialog by clicking on the Object Info button in
the Looks window, or by selecting the Object Info
menu item available by clicking on the object’'s Look
icon in the Score window.

2. If the Look allows you to set a color (you'll know
because the Color Override box won't be grayed
out), click on the Color box to pick a color from the
color picker.

«  Warning: The Color Override control overrides
whatever is the first color parameter in the Look
Editor. So for Black Marble, for example, it would
override the Veins color, not the Base Rock color.

adjusting a look
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3. Type a scale factor in the Scale box. 200% dou-
bles the size of a Look’s features; 50% makes them
half as big.

@ object info

Object Bobject
Look White and Blue
Color Override [ |

Projection

[ Planarz |

forzontarrig) | [ J P4

Opacity Override

Look Scale %

[J Scale Look with Object

Vertical Flip




4. Set the opacity with the Opacity Override slider.
The effect of this control will vary depending on the
Look (e.g., a transparent glass Look will never be
completely opaque).

Opacity determines how much a surface “exists.”
Don't get this confused with Transparency! An invisi-

ble object may as well not exist — it has no effect

on light, and light has no effect on it. A transparent
object can still color the light passing through it, and
can still reflect, to a greater or lesser degree.

Note: The effects of the Opacity setting are best
seen against a background other than black. A tex-
tured background (a wall with something other than
a plain Look on it) works best.

adjusting a look
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5. Set the orientation of the Look using the 90°
Rotate, Flip Vertically, and Flip Horizontally buttons.
If these controls are not supported by the Look,
they'll be grayed out.

6. Click on Scale Look with object to have the
Look change size in proportion to the object. The
effect of this control will vary depending on the
Look.

7. Set the Projection. A description of these fol-
lows. If Projections are not supported by the Look,
this will be grayed out.

8. Click on OK to confirm the settings.

*  Note: In the Object Info dialog, changing the
Color Override or Opacity Override controls does-
n't change any settings in the Look. This is so you
don’t have to save a new Instance of a Look every
time you want to see it with a new color or opacity.
We made them available in the Object Info dialog
because they may be among the controls you use
the most. If you want to save these settings with the
Look you must make the same changes to the
Look’s Color and Opacity parameters.




Projections

Some Looks are really only the raw material for giv-
ing a surface a certain appearance. VWhat actually
gets such a Look onto a surface is a projection. You
could think of a projection as a “sheet’” through
which light shines onto the object, as a slide projec-
tor shines light through a slide and onto a screen.
Many Looks are designed to start out as one of
these sheets. A sheet can be flat, or it can be
wrapped around into a cylinder or sphere that
encloses part or all of an object.

There are nine types of projections supported by
Typestry in the Object Info dialog:

Projection

v AutoPlanar
Planar 2
Box
Box Spherical
Spherical Shrinkwrap
Spherical Wallpaper
Cylindrical Shrinkwrap
Cylindrical Wallpaper
Natural (st)

Generally speaking, you should see how the default
setting (Planar Z) works on your object. Then, if
you'd like to try an alternative, use:

e For Extrusions, try Box

» For Tubes, try Natural.

« For Rubber Sheets, use the chart below.

E Planar 2
F——

Planar 2

. Spherical Shrinkwrap

Cylindrical Shrinkwrap

L Planar 2

Ultimately, which of the projections you should
select depends on the shape of the surface and the
effect you are trying to create.

You should be able to get good results using the
rules of thumb outlined above. But if you're interest-
ed in more detailed, more technical descriptions of
the projections, read on.

Five of the projections use ‘‘sheets” that start out as
spheres or cylinders. One unavoidable aspect of
using any kind of cylindrical or spherical projection is
seams. Obviously, when you wrap a sheet into a

adjusting a look
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cylinder you'll get one seam; and as you might imag-
ine, wrapping a sheet into a sphere is trickier. A pro-
jection's behavior at seams is especially important if
you want an image you're using in a Look to tile
seamlessly. However, as in so many other things,
there's a tradeoff involved. For spherical and cylindri-
cal objects, there's always going to be some distor-
tion somewhere, and you have to choose where.

Take a sphere, for example. While things can match
perfectly at a seam running north—south, they would
have to be distorted toward the sphere's poles. For
things to look better at the poles, there will be dis-
tortion at the seam. So you should experiment with
the various cylindrical and spherical projections to
find the one that matches your needs most closely.
When you do this, start with Box Spherical — this
produces a pretty good compromise between the
two extremes.

In the accompanying illustrations below, the follow-
ing image is used for all the projections:

AutoPlanar

The Autoplanar projection treats the Look as a flat
sheet that gets “pressed onto” every face of a sur-
face. Suppose you want to apply a Look to a pyra-
mid. Using this projection the Look would be
applied individually to each of the pyramid's faces,
based on the face's orientation.

However, in exchange for the generality of this pro-
jection, you sacrifice control over individual faces.
Autoplanar projections can produce unexpected
(but entertaining) effects when used on curved sur-
faces like bevels.




Planar Z Box

The Planar Z projection treats the Look as a flat This applies a Look from six directions, as if there
sheet: a “slide” if you will, to be projected onto a were a large box around the object with a projector
surface's front. Another way of visualizing the effect pointing inward attached to each side. The differ-

on the object is this: if you imagine that the Look is a ence between this and Autoplanar is that Autoplan-
sheet of paint, using this projection is like pushing ar applies a projection from as many directions as
the object through the sheet. The top, bottom, and there are faces, instead of just six directions.

sides get “smeared,” and the back face has the
image reversed. Using the planar projection on an
object whose shape is decidedly not flat (a sphere,
for example) can produce unexpected (but enter-
taining) effects.

° adjusting a look
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Box Spherical

Imagine a sphere with six copies of a texture on it,
each texture occupying a sixth of the sphere. This
then gets projected onto the surface. The size of the
sphere is based on the largest dimension of the sur-
face's bounding box. This dimension becomes the
diameter of the sphere.

There are |2 seams, where the six copies of the
texture abut each other. On spheroidal objects
there will be some distortion at the seams, but in
general this is noticable mostly when there are
straight lines in the Look. This projection allows
seamlessly tiling textures to match at the seams, and
for spheroidal objects you should try using this first.

Spherical Shrinkwrap

This projection applies a Look as if it were a spheri-

cal sheet that got “shrink-wrapped” onto the object.

It covers objects equally from all directions. The size
of the sphere is based on the largest dimension of
the surface's bounding box. This dimension
becomes the diameter of the sphere.

There is one seam, at the back of the sphere. While
there is no distortion at the seam, there is distortion
toward the “poles.” Using this projection on an
object whose shape isn't really spherical can create
unusual results.

This projection allows seamlessly tiling textures to
match at the seams.




Spherical Wallpaper

This applies a texture as if it were a sheet of paper
you were trying to wrap spherically around the
object. Let's say there were small bricks on this
paper. The bricks would be the same size all over
the object, but you couldn't count on things match-
ing up at the seam, and you'd have to cut some of
the paper off to make it fit. This points up the differ-
ence between this projection and the Spherical
Shrinkwrap projection. With that, the bricks' size
would vary across the surface, but they would match
at the seam, and the whole texture would be pre-
sent. However, with Spherical Wallpaper the poles
should look OK if the view is more or less toward
the equator.

The projection sphere is oriented so that you see
the object's front through the front of the sphere.
The size of the sphere is based on the largest
dimension of the surface’s bounding box. This
dimension becomes the diameter of the sphere.

There is one seam, at the back of the sphere. The

farther you go from the seam, the less the distortion.

Cylindrical Shrinkwrap

This shrink-wraps a Look in the shape of a cylinder
onto an object. As you would expect, the sides get
covered equally, but the top and bottom get the
very top of the Look smeared across them.

The cylinder is oriented so that you see the object's
front through the front of the cylinder. The larger of
the width and depth dimensions of the surface's
bounding box determines the size of the cylinder on
which the Look is wrapped.

There is one seam, at the back of the cylinder.
While there is no distortion at the seam, there can

adjusting a look
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be distortion elsewhere on anything but a perfect
cylinder.

This projection allows seamlessly tiling textures to
match at the seams.

Cylindrical Wallpaper

This is like the Spherical Wallpaper projection, but
the top of the texture is left “open” when wrapped
around the object, creating a cylindrical shape. And
here again, areas of the texture are kept constant at
the expense of things matching up at the seam. Use
this on objects that are taller than they are wide.

The cylinder is oriented so that you see the object's
front through the front of the cylinder. The larger of
the width and depth dimensions of the surface's
bounding box determines the size of the cylinder on
which the Look is wrapped.

There is one seam, at the back of the cylinder. The
farther you go from the seam, the less the distortion.




Natural (st)

The shape of this projection is tailor-made to work
as well as possible for the object. For example, with
the natural projection of an ‘s, a Look would be
applied almost as if the projector itself were in the
shape of an “'s.” The Look would be “custom fit" to
the object.

When you use the natural projection to apply a
Look with a texture map made in the Look Editor,
the map gets scaled automatically so that its width
matches that of the surface to which it is being
applied.

Since a texture map gets scaled so that it has the
same width as the surface it goes on, its height may
not match that of the surface (the choice here is
between losing part of the image and distorting it to
fit, and we chose the former). The aspect ratio of
the map is always preserved. If you were to apply
the example image to a patch that had a shape dif-
ferent from that of the texture map, you would still
see the full horizontal extent of the map, though

perhaps not the vertical extent. If the patch's aspect
ratio were greater than the map's, the top and bot-
tom of the map would be cut off. If the patch's
aspect ratio were smaller than the map's there
would be extra space above and below the map.
The illustration below shows the situation.

Transporting Looks

There may be times when you need to take Looks
to another machine for rendering an image, much as
you would take fonts to a service bureau for printing

transporting looks
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a document. When you do this, you'll need to be
aware of a few things.

If you're using only the standard Looks that
come with Typestry and you haven't used the Look
Editor on any of them, you'll be fine — just take your
project file.

If you're using other Looks, or Instances you've
made with the Look Editor you'll need to take some
extra stuff. Read on...

There are actually two parts to a Look: the Master
and the Instance. You should already know the loca-
tion of the Instances you used in a project file
because that's what you found when you selected
your Looks with the Browser.

But how do you know what Masters you're using?
Here's how. For each Look you use, do the follow-

ing:

I. Bring up the Browser and select the Look.

2. In the Browser, click on Get Info. This brings up
an info window with a pull-down menu at the top
with the Look name showing.

3. Click on the menu. The name below the Look
name is the master. Write this down and put the
Browser away.

When you have your list of Masters you'll have to
go find them. The default installation put them in
your System Folder in Pixar Stuff:Look Masters. Look
for them in the logical subfolders there.

If you put the Masters somewhere else, you proba-
bly already know where they are. If you've forgotten,
you can always use the Find command in the Finder.

Now you should have all your Instances and all your
Masters. VWhen you get to the other machine,
where do you put them? If you put them just any-
where, Typestry might not be able to find them. But
there are a few rules you can follow to guarantee
that they'll be found.

You can put Instances in three places:

the folder containing the project file;

a Look Instances folder structure identical to the
one on your machine; but in this case, the Look
Instances folder must be in the same folder that con-
tains Typestry;

the place specified in the Pixar Preferences file
(in the System Folder.Preferences folder) on the line
beginning “/General/LooklnstancePath.” You can
open this file with any text editor. Instructions on
what to do there are already in the file itself.




The Masters must go in a specific place. This loca-
tion is specified in the Pixar Preferences file men-
tioned above. Look for a line beginning *'/Gener-
al/LooksMasterPath.” The rest of that line tells you
where Typestry looks for the Masters.

applying looks




Image: Joy Folla

Font: Gill Sans Ultra Bold

Build Method: Rubber Sheet, sphere
Style, solid letters and
background Textiling

Looks: Matte, yellow; Matte, blue;
Checkerboard Instance with
yellow and blue

Effects: Motion Blur

Lights: #5 50%, #7 100%,
Ambient 20%

Ball scaled and moved in 3 frames.
Rendered all 3 frames; composited in
Photoshop.
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Ever wish you could change things like the swirl in
the grain of your Oak Look, or the brightness of
your Sky, or the color of your Marble's veins? That's
why we provided a Look editor. This allows you to
save customized variations of your favorite Looks,

called Instances. Let's make one now.

Make a new Look variation now!

|. In Typestry, get some text in the project window Q‘ edit look

and apply the Black Marble Look to it. Black Marble Black Marble

is in the folder sequence Pixar Applications:Look In- /i, [ v<ins %
stances:Starter:Materials:Stone:Marble. [ ]saserock -

- 1 +, VYein Density

2. Click on the Edit Look button in the Looks win- - +] Potish

dow. The Look Editor dialog will appear. - +, Metalness ‘
1= +, Transparency
3. Click on the black Veins color swatch. This i= +, Glow
brings up the Color Picker. Reflection Type [
Description...

4. Select a color to replace the black marble veins
and click on OK. (Very very dark green could be
nice...)

[B1ack Marble - Hot much interesting to say - just [/
shiny black marble. %

15

el
&

(Ccancel | [ save || savess... ]| ‘

5. Drag the Vein Density slider about halfway to

make a new look variation now!
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the left end. As you might suspect, this will produce
wispier, less dramatic veining when you render.

6. Click on the Save As button. When the Save As
dialog comes up, open the User Instances folder (in
the Look Instances folder).

7. Type in a name for the new variation you just
created and click on Save. Now, in Looks window
the Look image has a big red X" through it, indicat-
ing that it's been edited.

8. Now render using Excellent ‘n’ Slow, and watch
the difference!

Now. If you want to cut to the chase and get to
more serious Look editing, turn directly to “Basic
surface controls” later in this chapter. However, the
more circumspect among us will simply continue on,
thank you.

What the heck is this thing for,
anyway?

Well, as you just found out, the Look Editor is for
making variations of a Look, called Instances. It does-
n't make new Looks, just new Instances. One way to
think about an Instance is to make an analogy
between a Look and a font. Take the Times font for
example. There's Times Roman, Times Bold, Times
[talic, and so on. There's no plain Times: a font only

exists as one of its typefaces. And the typefaces are
just closely-related variants. Similarly, a Look only
exists as one or more variants — the Instances.
These are variants of a Look “master.” If fonts used
this terminology, Times Bold would be an Instance
of the Times master.

Each master provides you with controls over certain
aspects of a Look, called parameters. The Look
Editor allows you to change the parameter settings
and save the result as a new Instance. When your
application uses a Look, the thing that actually makes
the picture appear is the renderer. For a given
object, the renderer needs to know generally what
sort of surface the object should have, and it also
needs to know the specific details about the surface.
A Look master supplies the general surface informa-
tion, and the Look Instance provides the specifics.

Look Masters are referenced by Look Instances, and
are never seen directly by the Look Editor. When
you open a Look, you are actually opening an
Instance, which contains a preset variation of its
Master, and likewise when you save a Look, you are
saving an Instance.




There are four kinds of Look masters:

Materials. A Material controls everything about a
surface except its bumpiness. So it provides color
and shininess, determines how it reacts to light, and
so on.

Reliefs. A Relief can create pits or cracks, waves,
protrusions, bumps — it controls the shape of dif-
ferent areas of a surface. Obviously, a surface as a
whole must have some shape to exist in the first
place; a relief simply alters the basic underlying
shape.

what the heck is this thing for, anyway?
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Lights. A Light, of course, controls how light from a Environments. An environment determines what
light source behaves: whether its rays spread out or gets reflected by an object — what the environment
stay parallel, whether it can be used as a slide pro- around the object is.

jector, whether it casts shadows, etc.

Many Looks have parameters that allow for the
most extreme variations. Believe it or not, a bumpy
glass Look can be made to look something like gran-
ite, or like wavy water. But while you may be able to
bend a Look to your will and make it look like
something totally different, the Look Editor is most
profitably used to “tweak’” a Look: to change one of ‘
its colors, to make it reflect what you want it to, or
to vary its smoothness, for example. However, the
power and flexibility of the Look Editor cut both
ways. As easily as you can transform a surface at
your whim, you can transform it into one that could




never exist in the real world. This is, after all, com-
puter graphics.

If you have a particular surface in mind that you'd
like to create, you'll need to find a Look that shares
some key characteristics that you can vary to
approximate the new surface. However there is a
virtual infinitude of surfaces, and you may find that
none of the Looks you have will transform into
exactly what you have in mind — that you simply
“can’t get there from here.” If you find yourself in
this situation, take heart. You can scan in a picture of
a surface, get the Pixar One Twenty Eight collection
of seamlessly-tiling real-world textures, or create
one with a paint program, and have the Look Editor
apply it to an object, effectively giving the object a
new appearance.

Be forewarned though — until you've gained some
experience with the Look Editor, some controls may
have unexpected results if you just play with them.
But that's OK, go ahead and play — you might dis-
cover a new way to make an asphalt Look or some-
thing!

If you'd like a little more nerdy discussion of
RenderMan issues like shaders and shading models,
turn to the "RenderMan Expert Parameter
Information for the Adventurous’ at the end of this
chapter.

How to make a new Instance

The process is pretty simple, really. First, create
something with a Look on it. Then:

I. Select the object.

2. Make sure the Looks window is showing (select
Show Looks from the Windows menu), and click on
the Edit Look button. This brings up the the Look
Editor dialog. This dialog will have the parameters
for the Look. You can also get this dialog from the
Score window by clicking and holding on the space
between the object's name and its Perfs icon. This
displays a popup from which you can select Edit
Look.

=

E,,Neuu Look...
Edit Look...
Object Info...
Detach Look

3. In the Edit Look dialog you'll see a description of
any parameter you select. Clicking on the Look
name displays a description of the Look itself.

4. Adjust the parameters to change the Look. You
won't see the results until you rerender.

5. When you're done, click on Save or Save As and
render.

how to make a new instance
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Danger, Will Robinson! If you're using a Look
with a Relief, the Relief will affect the faces and sides
of characters differently. You can minimize the differ-
ences by keeping the height of any bumps low.

More Danger, Will Robinson! Some parame-
ters may have an override icon next to them (a yel-
low triangle with an exclamation mark in it). The
Object Info dialog allows you to override some of a
Look’s parameters (Opacity, Color, and Scale, for
example). Any parameter changes you make in the
Object Info dialog overrides any settings you make
within the Look Editor.

* Note: In the Object Info dialog, changing the
Color Override or Opacity Override controls does-
n't change any settings in the Look. This is so you
don't have to save a new Instance of a Look every
time you want to see it with a new color or opacity.
We made them available in the Object Info dialog
because they may be among the controls you use
the most. If you want to save these settings with the
Look you must make the same changes to the
Look's Color and Opacity parameters.

*  Warning: The Color Override control overrides
whatever is the first color parameter in the Look
Editor. So for Black Marble, for example, it would
override the Veins color, not the Base Rock color.

Basic surface controls

Believe it or not, with no more than three parame-
ters, you can create reflective properties that mimic
surfaces as diverse as matte, plastic, shiny metal, and
glass.

Shininess

The shinier a surface gets, the more it will take on
the color of the light shining on it, both from light
sources, and from any reflected objects as well. It
takes on this color at the expense of the color of
the object itself, which will eventually dwindle away
to almost nothing. In fact, if the slider were all the
way to the right, you would see areas that are most-
ly whitish (from the reflections of fake objects) and
blackish (from the black space between the objects).

Increasing Shininess:

* Increases the degree to which the surface takes
on the color of the light and any reflected objects —
you'll see less of the Color parameter color.

* Increases the visibility of reflections.




* Decreases the size of highlights.

Metalness

When you look at a metal, you're actually seeing a
rich combination of the color of the surface and the
color of the light striking the surface. The Metalness
parameter mixes surface color back into the mix of
surface and light colors set by Shininess.

Increasing Metalness:

« Increases the amount of surface color (often set
by a Color parameter) that appears in the surface.

If you have no Shininess, Metalness will have no
effect. Remember that Shininess trades surface color
for light color. If no light color is present, you'll just
see all the surface color, so adding more with
Metalness won't do anything.

Transparency

With transparency, the important thing is to remem-
ber that something that's completely transparent can

still change the color of things you see through it. So
don't be surprised when you make something com-
pletely transparent (the slider would be all the way
to the right) and you still see some color.

Glass, however, is not completely transparent. By
definition, something that's completely transparent
allows all the light through. And that doesn't leave
any light left over to reflect off a surface. Weird,
hunh? Only in computer graphics can you get a sur-

face that's 100% transparent...

Increasing Transparency:

«  Allows more background to show through, col-
ored by the surface color.

« Decreases the visibility of reflections and high-
lights.

Don't get this confused with Opacity! Transparency
controls how much light can get through an object.
Opacity controls how “ghostly’ an object is, how
much it “exists.”” An object with no opacity may as
well not exist — it has no effect on light, and light
has no effect on it.

how to make a new instance
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Using your own images in a Look:
the Picture/Background Instance

Got an image you'd like to use in a Look? You can
use your own image in any Instance that uses a
“Color Picture” parameter.

* The Picture/Background Instance in the Place My
Pictures folder (in the Simple folder) is designed
specifically as a starting point for making Instances
that contain your own images.

If you have a drawing program or paint program that
saves files in PICT or TIFF format, you can create
your own library of Instances that use your images.

What can you do with your own pictures?

Parameters generally affect a whole surface equally.
If you change a plastic Look's Color parameter, the
surface will be all that color. Change Transparency
and the whole surface'’s transparency changes. But if
you'd like the plastic to have colored dodecagons on
it, or to have some partially-transparent areas, you'd
need a way to control these parameters at different
places on the surface. Well, you can use a picture to
do this. You can use this as a way to control area by
area a parameter that would otherwise apply to a
whole surface equally.

You can supply two kinds of pictures: color or gray

scale. Color pictures can do the job of any parame-
ter that is a color. In practice, you'll probably be
using color pictures just to “paint” an image on a
surface using the Color Picture parameter, or to use
as a slide or reflection in a Light Look. Gray scale
pictures can be used to control all sorts of things:
bumps, metalness, transparency ... just about any-
thing you might have a slider for. See “Gray scale
pictures’ later in this chapter for more on this.

Picture considerations

Image type. You can use as a picture any file you
create with a draw or paint program, or even an
image you've rendered to a file. When your file is
ready, you must save it in PICT or TIFF format. Look
parameters will work only with these formats.

Size. When you create a picture to be used in a
Look, you'll get the best results if you follow a sim-
ple rule:

* Make the picture at least as big (in pixels) as it
will appear in your final rendered image.

Let's say you have some 3D letters in an image, and
you want to put your own TIFF image on one char-
acter. If the character will take up a portion of the
final image that's only about 100x 100 pixels, that's
how big your TIFF image should be. If you made it
much smaller the renderer would have to blow up




your image to make it fit. And you know what hap-
pens when you scale up a bitmap image — that
pesky blurriness starts creepin’ in! If you made it
much bigger, it would still look the same, but might
take slightly longer to render.

» Using any picture in an Instance will increase the
size of the Instance, sometimes dramatically. Prac-
tically speaking, using a color picture whose largest
dimension is 128 pixels or less can add around 90K
to the Instance. If that dimension is 129-256, add
about 300K If it's 257-512, add about 1000K. Gray
scale pictures take up less space: 40K for a picture
128 pixels on a side, 100K for one that's 256-square,
and 450K for one that's 512-square.

Shape (aspect ratio). You may want to create a
picture whose shape approximates that of the
bounding box of the surface on which you'll be using
it. For example, if you want to use your image as if it
were a picture in a frame you'll need to match the
shape of your image to that of the frame — tall and
skinny, square, short and wide, etc.

«  When rendered, any picture used inside a Look
is one “‘unit” high, (about the default size of a letter)
until you change the scale, either in the Object Info
dialog or in the Look Editor! The smaller dimension
will depend on the shape of the picture.

Getting a picture into an Instance
(making labels)

This process actually applies to pictures of any sort
— color or gray scale pictures, or reflection or slide
projector pictures. If you're wondering how to make
something like a decal, with invisible areas, turn to
the section on “Single-color decals” or “Multi-color
decals” later in this chapter.

Once you have a PICT or TIFF image, apply the
Look in which you want to use the picture. For
color pictures a good place to start is the
Picture/Background Instance in the Simple folder (in
Look Instances:Place My Pictures). Then:

I. Click on the Edit Look button. This brings up the
Look Editor dialog.

2. Click on the parameter that uses the picture
(usually Color Picture). Select Other from the para-
meter's popup menu. This brings up the Browser.

3. Click on the name of the image (in PICT or TIFF
format) you'd like to use.

4. Set Periodic Wrapping if you'd like the image to
repeat vertically and horizontally across the surface.

5. Click on Select. The image will be copied into
the Instance, and converted into a format directly
usable by Typestry. The larger the image, the longer

using your own images in a look
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this will take. When you render, you will see the pic-
ture repeat across the surface of the object, both
horizontally and vertically, like rows of tiles.

Gray scale pictures

You already know about applying your own color

pictures. However, gray scale pictures have their
uses as well.

Using pictures instead of sliders

Theoretically, a gray scale picture could do the job
of any parameter that is controlled by a slider. While
a slider sets a value for all of the surface, a picture
can effectively set different values at different places
on the surface — it controls a parameter in two
dimensions. Practically speaking, you would rarely
want such a thing for most sliders. So there are a
few “all-purpose” Looks that allow you to use a pic-
ture for the most important parameters. You'll find
out about these later...

The two ends of a slider represent two extremes. In
a gray scale picture these extremes are represented
by black and white:

» For gray scale pictures, black is the left end of the
slider, and white is the right end.

Take the Transparency parameter, for example.
When the slider is all the way up, an object is com-
pletely transparent. But by using a Transparency pic-
ture you could control the transparency anywhere
on the surface. You could make some areas com-
pletely transparent, some partially transparent, and
others completely solid. All you would need is a
black image with gray circles blending into white in
the center. Or you could punch holes in an object
by simply painting white circles on a black back-
ground and using this to control Opacity.

*  While it's best to design a gray scale picture to
be used in Typestry in gray scale, you can use any
color image. It will automatically get converted to
gray scale in the conversion process.

Let's say you're using a gray scale picture like the
one below on a plain plastic-like surface:

Here are a some examples showing what might

happen using the image to control various parame-
ters:




Shininess Metalness

Transparency

Opacity

When you use a gray scale picture, its associated
slider works slightly differently: it exaggerates or
diminishes the effect created by the picture. The
slider affects the whole picture, effectively making it
brighter or darker.

If you need the utmost flexibility in using pictures to
control things, use the "“Pictures as Anything”
Instance in the Place My Pictures:Expert folder. In
addition to using pictures for many of the most
common parameters, this Look uses a picture for
Opacity, which is ordinarily set within the Object
Info dialog.

Using Opacity

Opacity determines how much a surface “exists.”
Don't get this confused with Transparency! An invisi-
ble object may as well not exist — it has no effect
on light, and light has no effect on it. A transparent
object can still color the light passing through it, and
can still reflect, to a greater or lesser degree.

Decreasing Opacity:

« Increases the visibility of the background; turning
Opacity all the way off makes a surface completely
invisible.

«  Decreases the “existence” of a surface, making it
more ‘“‘ghostly.”

Using two or more pictures together

If you're using two or more pictures in conjunction
with each other in the same Look, you'll need to
bear a few points in mind.

« It's best to make all the pictures exactly the same
size. This way they'll all match up at every point, and

gray scale pictures
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you won't be confused about what might be over-
lapping what.

* There's only one Size control, and it scales all the
pictures together! If you want to change the scale of
one picture independently of the rest, you'll have to
do it in a paint package. But remember — reducing
the size of the picture itself is different from reducing
the size of the individual elements of the picture. In
the latter case there will be more “‘empty space.”

Consider the shapes in this image:

There are three ways of reducing their size:

In the first image, the whole original image has sim-
ply been scaled down 75%. However, remember
that it will still cover the same area as the original
image, since within Typestry all images are one unit

wide. This effectively provides fewer pixels to try to
achieve the same effect as the original. As a result, it
will be blurry where edges line up.

In the middle image the overall size is the same, but
the shapes have shrunk 75% as a group and moved
toward the center, relative to their original positions.
So they're out of alignment with their counterparts
in the original image.

In the right image the overall size is the same, and
the shapes haven't moved, they're just 75% smaller.
Their centers will match those of the original image,
but they'll just be smaller.

So be sure to consider what effect you're trying to
achieve when you resize one of a group of gray
scale pictures.

Relief pictures

Sometimes, instead of using a Relief calculated by an
Instance you might want to customize the bumping
of a surface. If the Combination Look you're using
doesn't supply enough control in this regard, use the
Pictures As Anything Look in the Place My Pic-
tures:Expert folder. This allows you to use a gray
scale picture in the Relief Picture parameter.

* For a Relief picture, white means “bump out,”
black means “bump in,” and 50% gray means ‘“‘no



bump” will appear on the surface.

* The Relief Height slider sets the distance (in
“units’’) to bump the surface.

Danger, Will Robinson! When you use a Relief
on an object, the joint between the faces and sides
may have cracks or holes. If you see this, try either
lowering the Relief Height or using a bevel that
doesn't make a sharp corner at the face.

Multi-color decals

One thing you can do with an Opacity picture is
make a decal. This is an image with areas that are
invisible. You can get interesting effects by applying a
decal to a wall, or, scaled down, to letters.

You need two pictures: one for the colored areas,
and one to create the invisible areas where there is
no color. But the good news is that the second pic-
ture is a simple variation of the first. Ordinarily, you
would create your color image first. Then you'd
need to alter it in a program like Photoshop to cre-
ate the Opacity picture. All you need to do is make
any colored areas white, and the rest of the image
black.

Here are a few considerations to bear in mind as
you convert your image to an Opacity picture:

* If the colored areas are antialiased, be sure to try

to preserve this when you convert the image to gray
scale.

* Do not resize the image at all — the color and
gray scale versions must match each other precisely,
except for color.

* If you want the colored areas to be only partially
visible, be sure to use a shade of gray instead of
black. The darker the gray, the less visible things will
be.

To make a multi-colored decal:

I. In Typestry, apply the Decal - Multicolored
Instance in the Simple folder (in the Place My Pictures
folder) to the selected object(s).

2. Make sure the Looks window is showing (Show
Looks from the Windows menu). Click on the Edit
Look button. This brings up the Look Editor.

3. Pull down the “Color picture” parameter and
select Other Picture. This brings up the Browser.

4. Click on the name of the image (in PICT or TIFF
format) you'd like to use.

5. Set Periodic Wrapping if you'd like the image to
repeat vertically and horizontally across the surface.

6. Click on Select. This converts the image into a
format the Look can use, which may take a few sec-
onds.

gray scale pictures
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Now you need to get the Opacity picture so the
right parts of the image will go away.

7. Pull down the “Opacity Mask Picture - gray
scale” parameter and select Other Picture. This
brings up the Browser.

8. Select a grayscale TIFF or PICT file to be used as
the Opacity Picture.

9. Set Periodic Wrapping if you set it for the Color
Picture, and click on Select. This converts the image
into a format the Look can use.

If you use colors other than black, white, and gray in
the image to used for the Opacity Picture, they will
automatically get converted to their gray scale equiv-
alents.

Notice that you still have control over the material
parameters, so you can make your decal shiny, or
metallic, for example.

Single-color decals
Here’'s how you make a single-color decal:

I. In the Look Editor, open the Decal - Single
Color Instance in the Simple folder (in Place My
Pictures).

2. Pull down the “Opacity mask picture - gray

scale” parameter and select Other Picture. This
brings up the Browser.

4. Click on the name of the image (in PICT or TIFF
format) you'd like to use to control the visibility.

5. Set Periodic Wrapping if you'd like the image to
repeat vertically and horizontally across the surface.

3. Click on Select. This will convert the picture to a
format Typestry can use, which may take a few sec-
onds.

4. Use the general material parameters to control
the type of surface used for the decal.

5. Be sure to set the color in the Object Info dialog,
available by clicking on the Object Info button in the
Looks window.

6. Save the Instance.

Reflection issues

In many Looks, you'll notice some Reflection para-
meters:

Reflection Type. This determines whether the
surface has any reflections, and if so, what type.
Simulated creates light blobby areas on the surface.
These are fake reflections, computed by the
Instance. They are meant to give the impression of




there being some surrounding environment other
than blank featureless space. Reflection Picture uses
the picture selected by the Reflection Picture para-
meter as the reflection. (See the Reflection Picture
parameter description below.)

Simulated Reflection Complexity. This con-
trols the size and number of “blobs’ in the fake
reflection. It works only when Reflection Type is
Simulated; otherwise it has no effect. Increasing this:

* Increases the number of blobs.

* Decreases the average size of the blobs.

Reflection Picture. This allows you to select a
color picture to get wrapped into a sphere and
“shrink-wrapped" onto the surface to serve as the
reflections. This is an image constructed something
like a world map (which uses a Mercator projec-
tion), with distortions created so that when it gets
wrapped into a sphere things look “normal.”

Danger, Will Robinson! When you use a
Reflection picture you won't see anything until you
set Reflection Type to “Reflection Picture.”” Also, if

you use an Environment light to create a reflection,
you'll see that reflection as well as a reflection pic-
ture or simulated reflection.

*  We've provided a few reflection pictures for you
to use in your Instances. These will provide you with
different sorts of scenes to reflect in your objects.
You can find them all in the Look Reflection Pictures
folder.

If you're feeling adventurous, you can try your hand
at making a reflection picture. This is an image that
gets wrapped into a sphere in the same way as a
Mercator projection of the world would. The main
thing to remember is that the farther toward the
top and bottom of your image you go, the more
things will get scrunched. The very top line of an
image's pixels will be squeezed into a single pixel. It's
difficult to create an image and get really predictable
results, but if you just need some custom blobs or
shapes you'll do just fine. Also, small shapes near the
“equator” should look pretty reasonable, since they'll
suffer less from scrunching. Below you can see what
happens at the top and bottom of a picture when it
gets wrapped into a sphere — the view from the
equator is what you'd expect, but notice what hap-
pens to Antarctica:

reflection issues
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e The process for making any picture is described
in “Getting a picture into an Instance (making
labels)” in this chapter.

Environments and other reflections

Remember, you can also get reflections by using a
TV Screen or Environment Look in the Lights win-
dow. These Looks create reflections that will appear
on every object in the scene that's shiny enough to

reflect. Simulated reflections and reflection pictures,
on the other hand, appear only on the objects that

use them.

Approximating a new surface

If you need to create an altogether new surface, you
have two choices, each of which has its pros and

cons:

I) Use an Instance with a picture (scan in a photo,
create an image in a paint program).

Pros

Great realism from
scanned images

If you can paint, you can
get just what you want

Cons

Limited to what you can
paint or scan

Can look bad if scaled
up
Always have to worry

about correct wrapping

Lighting is already pre-
sent in the image

Have to edit image to
change the contents

Can use lots of disk
space




2. Find an Instance that already shares some key
characteristics that you can vary to approximate the
new surface.

Pros Cons

Control over a Look’s
characteristics (including
colors!)

May not be exactly what
you had in mind

May not have the “right”
Responds to lights in parameters

scene
May have to worry

Scales correctly about correct wrapping

May animate

If you use a picture in an Instance, the process is rel-
atively straightforward (see the section on “‘Getting a
picture into an Instance (making labels)" in this chap-
ter).

If you start with an existing Look, you can't escape
the limitations of the parameters of the Looks you
have on hand. The idea is to know your Looks and
their parameters well enough to know which one
shares the key characteristics of the surface you
want to create. When you're experimenting with
Looks, play with the parameters, explore the
extremes: what's the effect of turning a wood's swirl
all the way up, of increasing a glass's Metalness, of
making a tiny checkerboard of white and off-white,
etc.?

Get the idea? You may have to do some creative
parameter tweaking to get close to what you have
in mind. But remember, it just may be the case that
“you can't get there from here.”

RenderMan Expert parameter
information for the adventurous

Ok, here’s the deal. If you're reading this, we're
assuming you're a bona fide hard-core computer
graphics type. You've been warned...

Looks and “‘shaders”

A Look is actually a collection of text, bitmaps, other
stuff, and a thing called a shader. The shader is the
essence of a Look, the sine qua non for any image.

A shader is a small program that creates a synthetic
surface. More accurately, it is in some ways a mathe-
matical simulation of how a particular group of sur-
face characteristics affects light. In the real world we
usually see only light reflected from objects’ surfaces.
Naturally, this light is affected by the angle of the
surface, the position of the light, and the position of
the viewer. But what really makes a surface look the
way it does are properties unique to the surface, for
example its patterns of color and large- and small-
scale bumps. It is aspects like these that are repre-
sented and manipulated in a shader by parameters.

RenderMan expert parameter information
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Adjusting the whole set of available parameters
allows literally millions of surface appearances.

The RenderMan Expert parameters

In RenderMan, the light you see coming from an
object has six components:

*  Ambient

« Diffuse

« Highlight Strength
« Highlight Spread

« Reflection Strength
+ Reflection Spread

These are mixed together so as to mimic the reflec-
tion characteristics of a particular surface, each com-
ponent contributing some percentage of the whole.

(They often, but not always, add up to 100%.) These
percentages are set initially in one of two ways:

* by the shader, internally;

* by higher-level controls — (Shininess and
Transparency, for example)

When you move a slider for one of the six compo-
nents, what you're really doing is changing the per-
centage of that component’s contribution. In fact,

the preset percentage is multiplied by the number
you see in the parameter’s info window. It is most
useful to think of these controls as fine-tuning values
that are set elsewhere.

Ambient light in a scene gets used for one thing
only: to control a surface'’s brightness uniformly in all
the light and dark areas. The Ambient parameter
multiplies the amount of ambient light (only!) that
gets used to lighten the surface. Increasing ambient
when there are 100 lights in your scene, but no
ambient light, will have no effect!

Any other light can get used for two things:

* to get spread out (diffused) over the parts of a
surface on which the light falls. The light gets used in
proportion to the angle at which the light is striking
it. Areas of the surface on which light is falling direct-
ly will be brighter than areas where the light is strik-
ing obliquely or not at all.

* to get concentrated in areas of a surface that are
at a particular angle to the viewer, creating highlights.

The Diffuse parameter controls how much of the
light gets spread around. The Highlight Strength
parameter controls how much of the light gets used
to form highlights. It often makes sense to vary these
two parameters oppositely from each other, increas-
ing one while decreasing the other. This way, when
you make a surface'duller” the hightlights diminish as
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well. However, since this is computer graphics and
not the real world you can effectively make a surface
duller and shinier at the same timel!

The values multiplied by the sliders basically specify a
percentage. This is the contribution made by that
component to the total light. The sum of all the per-
centages can be more than |00, which simply inten-
sifies the effects of the light. If the sum is 0, you can
have a thousand lights in your scene, but the surface
won't respond to them, and may look like a black
hole.

Ambient

This multiplies the contribution of the component
that controls the overall brightness of a surface.

Ambient light is light that is “‘everywhere’ in a scene,
light that doesn’t come from a single direction. It is
all the light reflected and rereflected around the
scene by all the various objects. You already know
about this kind of light: it's the reason you don't
need to turn on any lights in your house on a sunny
day, even though the sun may not be shining directly
into your room. There's enough ambient light to
light the whole room adequately.

The Ambient parameter controls how much of this
light the surface responds to. If you think of this as a
percentage, O would mean the surface ‘‘sees” none

of the ambient light, 50 would mean the surface
sees half of it, and so on.

If there is ambient light in a scene, increasing this
number:

* makes the surface uniformly brighter;

* tends to wash the surface out somewhat —
makes the colors “flatter’” with less contrast.

If there is no ambient light in a scene, this parameter
will have no effect!

Diffuse

This multiplies the contribution of the of the com-
ponent that controls the dull, unpolished part of the
surface reflection.

Diffusely-reflecting surfaces are ones like chalk, rac-
quetballs, or flat paint. The light that hits a spot on a
diffusely-reflecting surface gets scattered in many
directions, instead of bouncing off in a single, pre-
dictable direction, the way a billiard ball bounces
(like light reflecting off a mirror or a shiny polished
surface). This has the effect of ““spreading the light
around” the surface.

This parameter determines how much of the avail-
able light gets used for spreading around on a sur-
face. If the Diffuse and Specular parameters are both

RenderMan expert parameter information
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present in a Look, usually as the value of Diffuse
increases, Specular should decrease proportionally
— things aren't usually shiny and dull at the same
time.

Increasing this number:
e makes the surface brighter;

e ‘“spreads the light around” more.

Highlight Strength

This multiplies the contribution of the component
that controls the brightness of the highlights you see
on shiny surfaces caused by light sources (not by
simulated reflections or pictures).

Shiny surfaces look the way they do because the
light hitting them gets bounced off at a very consis-
tent angle.

This parameter determines how much of the avail-
able light gets used for creating highlights on a sur-
face. If the Diffuse and Specular parameters are both
present in a Look, usually as the value of Highlight
Strength increases, Diffuse decreases proportionally
— things aren't usually shiny and dull at the same
time. Use the Highlight Spread parameter to control
the size of the highlights.

Increasing this number:

* increases the brightness of highlights only.

Highlight Spread

This multiplies the contribution of the component
that controls the size of the specular highlight.
Naturally, if Highlight Strength is O, this parameter
will have no effect.

Increasing this number:

* increases the size of highlights, spreading them
out across a surface,

* makes highlights’ edges less sharp, more diffuse.

Reflection Strength

This multiplies the contribution of the component
that controls the brightness of the reflections. This is
a parameter that you'll just have to play with until
the reflection looks the way you want.

Increasing this number:

* increases the visibility of reflections.

Reflection Spread

This multiplies the contribution of the component
that controls the sharpness of the reflections.



Naturally, if Reflection Strength is O, this parameter
will have no effect.

Increasing this number:

¢ makes reflections’ edges less sharp, more diffuse.

Displacement

When you use a Relief to bump a surface, you have
two choices. You can actually change the shape of
the surface (Displacement On), or you can use a
trick of shading to make the surface just seem like it
changes (Displacement Off). In the latter case, the
surface remains flat, but areas are rendered darker
or lighter to simulate changes in height. This can be
very useful for prevent cracking problems at the
edges of letters caused by too much displacement.
Calculating new positions for points on the surface
slows down rendering more than the simple shading
calculations, so you might choose which method to
use based on how obvious the bumping will be in
your image.

For example, if you're bumping stucco on a back
wall, your image might look perfectly fine if the stuc-
co doesn't actually stick out from the wall that mil-
limeter, but just looks like it does. On the other
hand, if you have some bumps that need to cast
shadows, be sure to turn Displacement on!

Turning this on:

* allows surfaces to change shape according to the
Relief used.

Antialias

This makes surface patterns blurrier, reducing any
jaggy, stair-step (aliasing) effects, if any.

Under some circumstances, some parts of a surface
pattern may exhibit “aliasing.” When this happens,
any lines or patterns that aren't perfectly horizontal
or vertical may have jaggy stair-steps at the edges.
This parameter blurs the surface slightly (or lots) to
make the aliasing less noticeable.

Note: Before you use this, you should try rendering
with Smooth Shading turned on (in the dialog avail-
able by selecting Custom Setup from the Render
menu).

Increasing this number:

* blurs the surface more.

RenderMan expert parameter information

editing looks




Image: Joy Folla

Font: Gill Sans Bold Condensed

Build Method: Extrude, custom (flat)
bevel

Effects: Wall and Floor
Looks: ECShiny Sunhills; Matte, brown

Lights: #4 25%, #6 20%, #16 100%
spotlight with shadow, moved
down and out

Floor made into a gradient in
Photoshop
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A number of interesting effects are possible with
Pixar Typestry.

Backgrounds

You can include a wall, a floor, or both (shown
below) in your images by selecting these from the
Backgrounds menu under Effects.

You can also adjust the orientation of the wall and ‘
floor. The process is the same for both. Below are |

backgrounds

adding effects




the steps to take to adjust the wall; to adjust the
floor use the Floor Setup instead of Wall Setup:

I. Once you have a wall, select Wall Setup from
the submenu in Backgrounds under the Effects
menu. This brings up the Wall Setup dialog.

2. Click on Manual. A dot will appear at each end
of the wall.

3. Click and drag the dots to adjust the angle of the
wall.

In the Setup dialogs the text is represented by a sim-
ple wireframe. You see the wall from above, and the
floor from the side. The camera represents the point
of view when looking at the project window. Below
are the wall and floor setups showing manual adjust-
ment of their positions, and the resulting image.

@ wall setup

Top View

O Automatic
(@ Manual

o

e

@ floor setup
Side View
(O Automatic
‘ @ Manual
. i
Cancel ' 0K I

Caution: It's possible to get the wall or floor in front
of the text, or to sink objects into the floor. Be sure
to use the Wall/Floor Setup dialog to check the
position of the wall/floor. Also, if your object is near
the top of the window, your view may be from




under the floor, so you won't see the object. You
may be able to fix this by adding an object lower
down whose Opacity is O.

Camera

Normal. This creates a view of the object that has
a “natural” amount of perspective — a 90° field of
view.

(A=A Render Motion Windows
Backgrounds »

Camera Lens » ~Normal
Camera Views »| Fish Eye
Motion Blur »| Telephoto

Particle System p| Custom...

Perforations...

Fish Eye. This creates a view of the object that
exaggerates the perspective. This may not appear

obvious unless the object is turned or extruded

somewhat. The field of view is | 60°,

A =46 Render Motion Windows

Backgrounds »

Camera Lens ) (NI

Camera liews 14 ~Fish Eye

Motion Blur »| Telephoto
Custom...

Particle System )
Perforations...

camera
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Telephoto. This creates a view of the object that Custom. This brings up a dialog allowing you to set

eliminates perspective. This may not appear obvious your own angle for the Field of View. Higher angles
unless the object is turned or extruded somewhat. widen the view, allowing you to see more of the
This setting is great for aligning objects. The field of world at once; smaller angles narrow your view.

view is 10°.

31148 Render Motion Windows

Backgrounds »

Camera Lens |d Normal
Camera Views »| Fish Eye
Motion Blur |d ~Telephoto
Particle System b| Custom... |
Perforations...

31{-A 8 Render Motion Windows
Backgrounds »

Camera Lens |ld Normal
Camera liews »| Fish Eye
Motion Blur p| Telephoto

Particle System p CANTEICT; T
Perforations...

*  Warning: Some Looks, especially those with a Use the Camera Views to get a different view of the
reflection or environment picture, may not work scene. View to Fit moves the current “camera”
correctly with this setting. (Front, Left, or Top) in such a way as to fit every-
thing in the scene. So if you find you've moved some

text off-screen, or made it too large to see the




whole thing, just use View to Fit to see everything. If
you've used View to Fit and need to get the original
view back, select Reset View under the Edit menu.

The views are also useful when you want to move
text in front of or behind other text. Using the Top
or Side view lets you see exactly where things are.

Motion Blur

Normal Blur creates a streak based on the shape,
direction, and speed of objects.

Blur and Strobe creates the same streak, and
includes the objects at the end of the streak.

To blur a still image you must create a 2-frame ani-
mation:

I. Select a blur option from the Effects menu.

2. Move the object to the place where the blur
should start.

3. If the Score window isn't showing, select Show
Score in the Windows menu.

4. In the Score window, move the Time Marker to
the second tick mark (frame 2). The Time Marker is
the pinkish ball with a triangle on it under the
notched timeline:

motion blur
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timeline, marked in frames

Time Thingy — click and drag

08
@ score

i =

Jibe ho! *

5. In the project window, move the object to the
place where the blur should end.

6. Render.

e Warning: Unless you render at Excellent ‘n’ Slow,
you won't see the full effect of motion blur.

Particle System

You can make objects look like they're spraying
things out from their edges using this feature. This
allows you to get effects like sparks flying off letters,
or spray, or fireworks, or explosions, or a splash, or
oh, ever so many interesting things. This works on
any object you can select: a letter, a group of letters,
or all objects in the scene, but not a wall or floor.
This is an effect for animations, but of course you
can use it in a single frame. The basic process is easy:

I. With some object selected, select Add
Generator from the Effects menu.

2. Adjust the settings for the generator. These are
described in the rest of this section.

2. Make a simple 2-frame animation. To do this, see
the section on “Creating a 2-frame animation’ near
the end of the Animation chapter. Use Update
Simulations on the second frame, and render that
frame.

Warning: It's very easy to generate an enormous
number of particles in a single frame. If you're doing
hundreds of frames things can get out of control.
The more particles in a frame, the longer it will take
both to send the frame to the renderer, and to render
the frame. The default limit to the number of parti-
cles in a single frame is 2000, but you can adjust this
in the Particle Physics dialog (see below).

Note: Particles don't come from an object's faces,
only its sides (including the bevels). For Rubber
Sheets the particles come from the character edges.
For Tubes they come from everywhere on the tube.

To turn this on, select Add Generator from the
Particle System menu. This brings up the Particle
Generator dialog described below.

To change the way a generator works, select Edit
Generator. This brings up the Particle Generator
dialog, divided into two sections:




‘g particle generator

r Average Particle ———————— F Particle Emi
Life Span frames Startat frame [:,
Mass =2 + Stopat  frame

Elasticity - 9.+ [ Pulse
Birth Color  [_]

Death Color . Particle Density =, ¢ *
Randomness ¢ + Ejection Speed -2 +

The Average Particle controls affect individual parti-
cles coming from the selected object(s):

Life Span. This controls how many frames individ-
ual particles last. If you're simulating sparks, you'd
want a relatively short life span. Sawdust, of course,
should last until the termites arrive.

Mass. This determines how heavy the particles are.
For a given Viscosity (see below), heavier particles
won't go as high or as far as lighter ones.

Elasticity. If particles hit a surface they will bounce
if they're elastic enough. The higher you set this, the
bouncier they'll be. Note: For this to work, Collision
Behavior (in the Particle Physics dialog described
below) must be set to Bounce.

particle system
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Birth/Death Color. Using these you can make
the particles change color as they age. To control
exactly how they go from one color to the other,
use the Color "Tweening control in the Particle
Physics dialog, described below.

Randomness. With this turned off (all the way to
the left), every particle for the selected object(s) will
have exactly the same Life Span, Mass, Elasticity, and
Colors. The higher this setting is, the more variation
you'll see in these characteristics. You'll see some
particles with short Life Spans, some with long ones,
some heavy ones, some light ones, etc. The settings
will become average settings. So this slider controls
the amount by which particles vary from the average
represented by the setting.

The Particle Emission controls affect how the parti-
cles get thrown off:

Start at/Stop at. These determine the frames at
which the effect starts and stops. Stop at is set to
9001 frames by default. So if your animation is
longer than 9001 frames, you'll have to enter a new
number. This is useful when you want an effect to
start at some point into an animation, or to stop
before the animation ends.

Pulse. Checking this allows you to have the parti-
cles come out in spurts. You'll see an On and an Off
box. These control the frames for which the effect is

on and off. Using values of 30 and |5 turns the
effect on for 30 frames, then off for |5 frames, then
on for 30 frames, and so on. Pulsing only occurs
between the Start at and Stop at frames.

Particle Density. This controls the number of
particles emitted in a given time — a lot or a few.

Ejection Speed. This sets the speed the particles
have when they leave the object. Use this in con-
junction with Gravity (in Particle Physics dialog
described below). Low Ejection Speeds can make
particles seem to just fall off an object.




There are some controls that apply to all particles in
a scene. You can think of these as properties of the
scene, into which the particles emerge. Select
Particle Physics from the Particle System menu item
to get at these. This brings up the Particle Physics
dialog:

@ particle physics

Gravity = .0 .5 Color Tweening O RGB
Viscosity B Ieeeeeee.. | i

Particle Size =% . . . . .+
Collision Behavior

Particle Look

Particle Limit
@ Bounce
) Disappear [ cast Shadows

Gravity. As you might imagine, this controls the
downward force felt by particles. Turning Gravity off
(setting the slider all the way to the left) will have
the effect of making particles fly off in straight lines.

Viscosity. This puts the brakes on particles' speed,
constantly slowing them down. The less a particle's
Mass, the faster this will slow it down.

Particle Size. We'll leave this one to your imagi-
nation... But beware of setting this too low. You may
not see anything when you render.

Collision Behavior. When particles meet a floor
or wall (but not a text character!) they will bounce
with Bounce selected. Their “bounciness’ is con-
trolled by the Elasticity you set in the Particle
Generator dialog (described above). Disappear
makes particles, uh, go away when they touch a sur-
face. Try using an invisible wall or floor (with
Opacity turned all the way down) to make some
particles disappear in unusual ways! Using Ignore,
particles will simply pass through the wall or floor
unaffected.

Color 'Tweening. VWhen you have the Birth and
Death Colors set to different colors (in the Particle
Generator dialog) you can have the colors change in
two ways. Take a look at the Mac's Color Picker.
Imagine two points on opposite sides of the circle,
the Birth and Death Colors in the Particle Generator
dialog. Checking RGB (which stands for Red-Green-
Blue, which is one color model) will make the parti-
cles go from the first color to the second in a
straight line, so they will pass through white halfway
through. Checking HSV (which stands for Hue-
Saturation-Value, which is another color model) will
make them go from the first to the second around
the edge of the circle, and will never be white. Of
course, if you were to move one point over to the
other side of the center, so the two points are on
the same side, and still in line with the center, the
two behaviors will be identical.

particle system
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Particle Look. Use this to apply a Look to all the
particles in the scene. (A couple of useful Looks are
Constant, for creating things like sparks, that are unaf-
fected by light, and Matte, for things like confetti.)

Particle Limit. This sets the maximum number of
particles that can be generated in a single frame. For
frames with particles in them, this number can have
an effect on how long it takes to write out frames
prior to rendering them, and on how long the ren-
dering itself takes — the more particles, the more
time it takes to create and render them.

Cast Shadows. This makes the particles cast shad-
ows. Of course, you might leave this off for effects
like sparks, which are more like light sources than
objects, or for particles with a very low Particle Size,
whose shadows you might not even see.

Note: The control you have over particle systems
with these dialogs is rather extensive. As you experi-
ment with them, you might make small wireframe
movies to see the results, rather than take the time
to try to render all the frames. Or, if you need to see
the colors, just render a few small frames from differ-
ent points in the animation.

Atmosphere

You can add a foggy or hazy atmosphere to your
scene using the Atmosphere dialog. If you're animat-
ing, you can make the fog swirl.

To use this:

|. Select Atmosphere from the Effects menu. This
brings up the Atmosphere dialog:

(y atmosphere
—————————
@ 0ff C0n
Color D
Density = B
Lumpi -9 +
Lump Scale LT [PTE
Global Motion =._. .99 . . %
Local Motion =.. .. % . . . %

2. Click on On to turmn on the atmosphere effect.

3. Set the controls to your liking (see below) and
click on OK. When you render you'll see the results.

Off/On. This disables/enables the effect. Be sure to
tumn it off if you don't need it!



Color. This sets the color of the atmosphere.
(White or light gray usually works best to simulate

fog.)
Density. This controls how thick the fog is.

Lumpiness. This controls how uniformly thick the
fog is. Tuming this up makes the fog “lumpier.”

Lump Scale. This controls the size of the “lumps”
in the fog.

Global Motion. This controls the motion of the
“fog bank.” The farther the slider is from the O in the
middle, the faster the fog bank will move — to the
left, or to the right.

Local Motion. This controls how much the
“lumps” move around and interact with each other.

atmosphere
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Using Gllmpse you can tailor the Looks of the objects in your scene to create new
Instances of the Look. Manipulating one or many parameters of a Look can result
in subtle to dramatic changes in appearance. With Glimpse you can change the
color; shininess, metalness, add a soft glow, add reflections, and so on. You can
even combine your Materials Look with a Relief Look to add pits, cracks, waves,

protrusions, etc. Glimpse also allows you to make texture map Materials and
Relief Looks from your own PICT or TIFF files.

GLIMPSE

THE Looks EDITOR
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As you found out in the chapter on Manipulating
Text, grouping can be a useful tool for making perfo-
rations, and for making your life easier as well. The
more you feel comfortable with grouping, the more
you'll discover things you can do with it. This chap-
ter will help you get on more intimate terms with
the concept.

The short (terse, actually)
explanation

All Typestry objects created using the Extruded
Build Method are structured “hierarchically’” — they
have different levels. Each level represents a group-
ing of objects. Text you type in already has three
levels of grouping by default: |) text object, contain-
ing all the letters you typed in the Text dialog; 2) the
individual components of the text object (the let-
ters), containing faces and sides; 3) faces and sides,
always the bottom level. The exception to this rule
is when you type in more than one line of text in
the Text dialog. This adds a fourth level just under

the text object level. Think of a level as a group.
These groups appear in the Score window.

You can create a new level (group), by using the
Group command, available under the Edit menu.
This takes the selected object and puts it in a new
group. For example, grouping letters creates a level
between the text object level and the letter level.

You can use any of the Transform tools on any level
but the bottommost — the faces and side.s. (If you
could move those separately you'd no longer have
3D characters, and we wouldn't like that, would
we?) This means you could move one letter of one
word (if you had made a “word level"), resize just
that word, and rotate the text object containing the
word. Faces and sides are locked together. You can
also apply a different Look to any level. So you could
make the text object plastic, change one word to
marble, make one of the word’s letters metal, and
make that letter’s sides checkerboard. ‘Gad!

Double-clicking on an object allows you to move
down the levels: each successive double-click moves
you down a level.

the short explanation
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Using the “tree”

The left side of the Score window is the area in
which you control grouping. It contains a hierarchical
“tree’”” of all the objects in the scene and their ele-
ments. If you need more room to see the full
names of items, you can click and drag the bar sepa-
rating the tree from the rest of the window.

Using this tree is a little like using System 7's Finder
in View by Name mode. Just as you can open a fold-
er by clicking on its triangle, you can open a group
by clicking on its triangle. To change an object’s
name, just select the current name and start typing.

Kt I
-+

Click and drag

to move bar
Click and type to edit name

Click and drag to
move in/out of groups,
up/down in list

Click to show/hide contents

But there is one thing you can do that you can't do
in the Finder. By dragging an item up or down you
can change its position in the list of items. (Recall the
importance of order when you're perforating
objects, as you learned in the Manipulating Text
chapter.) A purple cursor appears, indicating where
the item will end up when you release the mouse
button. Let's look at a few examples. Let’s say our
tree starts out looking out like the one above.

To move the "'y" to first place within its group:




To move it up one level, and above its current
group:

The long explanation

Now let's flesh things out a little. When you click on
Build Object to get letters into Typestry, the pro-
gram automatically groups objects into different lev-
els, which you can see in the Score window. Faces
and sides are grouped into letters, or "letter
objects,” and letters are grouped into a “text
object.” So there are always three levels to start out

with. If you have more than one line of text, each
line will be a group as well.

No doubt you're used to having folders within fold-
ers within folders on your machine. You can think of
a grouping as a folder. A text object would be a
folder with other folders (letters) in it. And like
opening and closing folders (under System 7's View
by Name function) you can open and close groups
by clicking on the triangle to the left of the item.

Each of the letter folders has two “files” in it (faces,
and sides). The files are where the information lives:
they are what actually describe the letters’ surfaces.
The folders are just a way of organizing the files. You
can select both folders and files, but selecting a fold-
er selects everything in the folder as well, just like on
your computer.

Once a text object is created, you can then ungroup
letters or text objects, or you can add your own
groupings. Try this. Create a Typestry file with a text
object that says “Can do:"

. With the Text tool selected, click in the middle
of the window to bring up the text dialog.

2. Select a font and type Can do.

3. Click on Build Object, select any bevel, and click
on OK.

the long explanation
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You should have a tree that looks like this:

i =l

Now let's group the five letters into two words:

|. If the Score window isn't showing, select Show
Score from the Windows menu.

2. In the Score window, click on the “Can do”
object’s triangle. You should see all the letters in the
text object.

3. Select the Move tool from the tool palette, and
in the project window, click on the text object to
select it.

4. Now double-click on the letter C, or click on the
letter in the Score window. This will select just that
letter and put us at the “letter level.” Now we can
group letters.

5. Select Group from the Edit menu. This creates a
new group that appears at the letter level in the

Score window. Right now the group includes only
the C.

6. Type "“Can’” in the Group Name box.

7. Add the "a" to the group by dragging its gray
handle into the Can folder. Drag it so the purple
cursor is directly below the “C.”

8. Add the “n" to the group similarly.
9. Now select the “d."

10. Select Group and name the group ‘“‘do.” This will
put the “d" into the group.

'l Add the “o" to the “do" group.

Now your tree should look like this:




Where the text object had two levels below it
before (letters, and faces and sides), it now has
three levels below (the faces and sides aren’t show-
ing): two groups, each of which has groups of its
own (letters). We've added a new level to the struc-
ture. Using the folder analogy, we put the contents
of the Can do folder into two new folders, Can and
do.

The power of this organizational scheme is that it
allows you to do different things at different levels.

I. With the Scale tool selected, click on the text
object: you've selected the highest level. Click and
drag to make the whole object bigger — the top
level and everything in it.

2. Double-click on "“Can*: you've selected a word,
which is at the next lower level. Get the Move tool
and drag the word somewhere else.

3. Double-click on the “a‘: you've selected the let-
ter. Get the Rotate tool and rotate the letter.

4. Double-click on the “a" again: you've selected
the letter's faces, which is the lowest level. These are
“locked," and can’t be manipulated (but they can
have a separate Look).

5. Double-click on the “a" once more: you've
popped back up to the highest level.

6. Get the Rotate tool and rotate the whole group.

Just think of the implications of this for animation!
(And just read about it in the chapter on Anima-
tion).

Remember, anything that you do to an item in the
tree is is done to all of the items inside it. This
includes applying Looks. If you apply a Look to the
word “Can" then it automatically applies to the let-
ters “C,"" "a" and “n" both to their faces and their
sides.

*  Unless an item has its own Look, it will have the
Look of the group that contains it.

Next, if you change the Look of the letter “C,"* then
it will get the new Look but the letter “a" and ‘'n*
will be unaffected. They will still have the Look given
to “Can."

Thus you can override any Look that was applied
higher up the tree. If you want to get rid of the Look
that you just gave “C," then click on the Detach
Look button and it will “inherit” its Look from the
next higher box in the tree.

Let’s look at the “Can do'* example to make this
clearer.

the long explanation
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Making the “Can do" text object yellow will make all
the letters yellow because no group or letters below
it have an assigned Look.

Changing the “C" Look to red will make the “Can
do’ have a red “C" while the rest of the letters will
remain yellow.

Changing the "'do" group to blue would change that
whole word to blue.

The cumulative effect would be something like this:

In this particular example the advantage is obviously
small, since there are so few letters, but you can see
that the longer the words, the more time you might
save applying Looks.

So, when you think you might want your text object
organized by whole words (and/or by smaller

groups of letters) be sure to use Group to organize
the letters!




Copying Looks from one object to another

If you'd like to avoid having to use the Browser to
apply the same Look to a number of objects, there's
a solution. To do this, in the Score window find the
object whose Look you want to copy. Just click and
drag the little Look image next to the object name
to the same place on another object in the Score
window. This copies the Look to the object.

“Inheriting” a Look

If you've used different Looks at different levels, you
can use the Detach Look button in the Looks win-
dow to “unassign” the Look of the selected level.
This means that any files in the selected folder will
get their Look from the next higher folder that has a
Look applied — it will “inherit"” the Look of the level
above it. In the example above, selecting the red
“C" and clicking on Detach Look would change the
"C" to yellow, since that's the color assigned to the
next higher folder that has a Look.

Applications

This hierarchical scheme allows you to create some

interesting effects. Since you can select a text object
as a single object or select components of it as sepa-
rate objects, you can use this to good advantage.

* Applying a Look to a word as a single entity
makes the word look like it was made from a single
piece of the material. Applying it to each letter indi-
vidually makes each letter look like it was made out
of its own piece.

the long explanation
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Similarly, in animations you can have an object
move "through" a Look. If a group has a wood Look
applied to it and an object within the group moves,
the object will seem to move through the wood.

When you use the Difference perforation you
can create objects with holes whose sides have a
Look that's different from that of the rest of the
object. Just make the characters that are being cut
out have their own Look.
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A short animation

Let's make a short animation. Here are the names of
the things you'll be using this time around — you
can find a complete chart at the end of this chapter.

Score window

Time Marker
object timeline
pose nib
\animation bracket

g score

¢
%

Play button

I. Get a word into Pixar Typestry and position it at
the left side of the project window.

2. If the Score window's not showing, select Show
Score from the Windows menu. Make the Score

window wide enough to see the rightmost anima-
tion bracket.

3. Drag the animation bracket to the *'I:1" tick
mark.

4. In the Score window, drag the pose nib (little
black diamond box to the right of the double line)
over to the tick mark just before the "“I:1" tick mark.

You've just set the length of the animation to 30
frames, or one second.

5. Double-click on the pose nib you created. This
moves the Time Marker to where the nib is, letting
you set what's happening at the time represented by
the position of the nib.

6. Move the text to the right side of the project
window. Now the text will start out at the left and
end up at the right.

Remember this: move the Time Marker first, then
move the text. Whenever you do something in the
project window, you do it only at the time repre-
sented by the Time Marker.

a short animation
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7. Move the Time Marker about halfway in
between the two nibs.

8. In the project window, move the word to the
bottom of the screen. You'll see a new nib appear
on the word's timeline.

+  Wherever you see a nib on an object's timeline
it means ‘‘the object has an appointment at this time
to be somewhere.”

9. Using the Rotate tool, rotate the word a bunch.

If the word gets in a weird position, just use Undo,
or Reset Orientation from the Edit menu.

1 0. Click on the Play button at the bottom of the
Score window. You should see a box moving
around the screen where the word would be,
twirling as it moves down and across the screen
from one side to the other, over and over. Click
anywhere to stop the animation.

That's it. It would be a simple step to render all the
frames and make a QuickTime movie, but we just
wanted to show you how easy it is to set up a sim-
ple animation.

Now if you're the type who's ready to plunge ahead
expecting to be the next Walt Disney without fur-
ther ado, hang on just a little while longer.

So, class, what have we learned in our introductory
lesson?

¢ Use the Time Marker to show you where you
are in time.

* Using one of the tools on an object freezes it in
space (in the project window), and in time (as a nib
in the Score window).

How to play a rough version of an animation
(with the Play button).

What you did was to pick a few points in time, and
then determine where an object should be at those
times. Typestry then calculated where the object
should be in between those times. This is called
“tweening” (or “interpolation” if that makes you feel
better).

As you can see, you can create simple animations of
your text with the controls in the Score window. A
finished animation consists of a series of rendered
frames, which can be used either as the raw material
for a QuickTime movie, video, or for some other
animation software.
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The Pose * In the Score window, each pose nib on a time-

line represents a pose.
Each pose nib (little black box) in an object's time-

. , . , i j [ fined by i
line implies four things about the object, corre- The path an animated object takes is defined by its

. osition in some number of poses. Let's say you
sponding to the four tools that allow you to change P P v

. have five poses, equally spaced in time, that look like
an object: v P quaily sp

the ones above.

*  positi
position The object will follow a path that 131

e orientation passes though all five of the object's
poses. The shape of this path is

v Smooth

- e determined in a popup menu. To e
. . No Ease
« slant (skew) get this menu, click and hold on a Ease In
pose nib. Ease Out

Ease In&0ut

These four characteristics define an object's pose.
The way poses change over time defines an anima-
tion.
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Linear. This moves
the object in a straight
line from pose to pose,
creating sharp corners
where it changes direc-
tion.

Smooth. This moves
the object in a tight
curve as it changes
direction. The shape of
the curve is affected
both by where the
object is coming from,
and by where it's

going.

Selection text (=]

Selection text El

The four bottom items on the menu control not the
shape of the path, but an object’s speed near a pose.

No Ease. This moves the object at a constant
speed as it passes through the pose.

Ease In. This decelerates the object as it arrives at
the pose. At the moment of the pose it speeds up
to its previous speed (before the deceleration). As it
leaves the pose, the object moves at a constant
speed. This is often useful when an object arrives
somewhere (so you never see the speed jump as it
leaves).

Ease Out. This moves the object at a constant
speed approaching the pose. At the moment of the
pose the object slows down, and is accelerated back
to its previous speed as it leaves the pose. This is
often useful when an object is leaving somewhere
(so you never see the speed jump as it arrives).

Ease In&Out. This decelerates the object as it
arrives at the pose, and accelerates it leaving the
pose.

Each pose type has its own nib shape. Below, the
nibs shown are, from left to right: No Ease, Ease
Out, Ease In&Out, Ease In and No Ease.

Smooth =i - i

Linear =1 {} ~{—i




When would you want to ease in or out? Well, eas-
ing is often perceived as a more “natural” motion
for many things. It's impossible, for example, for
things to reach some speed without accelerating to
get there. But, as usual, in computer graphics the
impossible is not only possible, it's all too easy.
Similarly, unless you're trying for a crash effect,
decelerating to a stop is often desirable. However,
there is a place for everything — if you're simulating
the billiard ball effect, you'll want no easing and lin-
ear motion. For this situation, those settings will
make for a more “natural” motion. Be sure to play
around with different types of motion when you
create your animations. They can add subtle effects
that heighten the sense of motion.

While it's quite easy to make an object move in
Typestry just by changing its position in some poses,
you can also change the other characteristics of the
object's pose. Resizing it in another pose will make it
grow or shrink, and rotating it will make it twirl. In
any pose you can change any or all of the object's
characteristics.

Don't forget that since you can move a light's posi-
tion in the Lights window, you can animate lights,
too. You can make them track objects, or make the
sun seem to rise.

* Note: Typestry provides a good way to get start-
ed doing simple animations. If you'd like to do fanci-

er animations, you may need to look at packages
designed specifically for animation. Also, if you

would like to get an animation into video, you'll have
to think about a number of issues Typestry was not
intended to address, for example NTSC vs. PAL for-
mats, NTSC “forbidden’” colors, and so on.

Before we move on, there's something you must
remember as you start to make animations, or you
will surely curse yourself. You must first move the
Time Marker to where you want it, and then set the
object's pose (move the object). So now repeat this
mantra:

* "“First move the Time Marker, then set the pose.
First move the Time Marker, then set the pose.”

A common mistake to make when doing animation
in Typestry is to move something, then move it
somewhere else, then somewhere else, all the while
leaving the Time Marker in one place. Nothing will
animate unless an object changes position over time.
The way to go to a new time is to move the Time
Marker, or to select Jump Forward from the Motion
menu.

Jump Forward skips ahead by the number of frames
set in the Animation Settings dialog, available by
selecting Animation Settings from the Motion menu.
Naturally, you can go back the same number of
frames by using Jump Backward, also under the
Motion menu.

the pose
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Poses and groups I. Get the word "test” into Typestry, near the mid-

. , o dle of a squarish project window.
As we said before, an object's four characteristics

Untitled 3

define its pose. Well, the fundamental thing to
understand about a pose is that it defines a relation-
ship.

Let's look at the characteristic of position. Perhaps ﬁ@ gjt
the most obvious way of describing a word’s posi-
tion is by saying something like, “It's in the middle of
the window.”" But if we're talking about a letter in a

Selection :test Front Yiew frame

word, you might say something like, “It's at the end

of the word.” In the first case the description was @ score
relative to the window; in the second it was relative

to the word. This is exactly analogous to the way =N
Typestry keeps track of things.

G]

Now let's do a little experiment. This will prove that:

«  Objects that are members of a group move rela-
tive to the group.

» Objects that are not members of a group move
relative to the window. (For example, a word that's
the only group in the scene isn't a member of
another group, so it moves relative to the window.)



2. With the Score window showing, move the
Time Marker about 3/4 of the way to the “1:]"
mark, then move the word down to the bottom of

the project window.
mq‘———#ia

EE=—— Untitled 3

test

Front View frame 230

Selection :test

{g score
[ [T=_Ttest]
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3. Run the animation by clicking on the Play button
at the bottom of the Score window. (Make sure the
animation brackets are placed appropriately.) You
should see the word move from its initial position
down to the bottom of the window.

4. Now open the word group by clicking on its tri-
angle in the Score window.

Notice that although you created a new pose for
the group, there are no new poses for the individual
letters. You don't see new poses for the letters
because their position, orientation, etc. relative to the
group haven't changed — they're all still in their
proper place within the word.

5. Move the Time Marker most of the way back to
the first frame.

s" by double-
clicking on it, and move it up to the top of the win-
dow.

6. In the project window, select the

Untitled 3 ==———=[

g

Selection s Front Yiew frame 6 |[
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7. Run the animation again. As the word moves
down you should see the box representing the *'s”
shoot upwards, then drift down as the rest of the
word does.

Rather than thinking you moved the letter higher in
the window, since it's a member of a group you
should think that you made that part of the group
higher than the rest of the group. You changed the
letter’s position relative to the group, not relative to
the window. That's why when the letter finished its
own motion, the word's motion affected it.

If the word were twirling in place instead of falling,
the “s’" would be twirling too, of course — it's part
of the word. It would just be higher than the rest of
the word.

Leave this project window as it is — you'll need it in
a minute.

So, to review:

e The characteristics (pose) of an object that is not
a member of a group are relative to the 3-dimen-
sional "'space” inside your project window.

e The characteristics of an object that is a member
of a group (e.g, a letter in a word) are relative to
those of its group.

Grouping and ungrouping

Now that you know about the motion of groups
and their elements, the next step is to realize that
you can:

* separate an element from its group to allow the
element to move independently;

« control two objects at once by combining them
into a group.

In addition to the above, in this section you'll learn a
handy trick:

* how to delay movements

So, what if we wanted the ''s" to stay at the top of
the window? Well, we could just move it there in
the very last pose, but how could we be sure it was-
n't just a little too high or too low in that pose?
Instead, let's just remove it from the word and treat
it as a separate object:

|. Take it out of the word group by dragging it (by
its gray drag bar) up above the “test” group in the
Score window. Now there are two objects at the
highest level: the ''s’” and the *‘tet.”

[
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2. Run the animation.

The "s” moves up and stays there. Its movement is
no longer relative to the rest of the word. But if we
ever want the "'s” to be part of the word again
we're hosed — there's no connection between the
two. So let's say we want to twirl the whole word
when the “te t"’ reaches the bottom. What do we
do?

Here's where the tricky part comes in. We can't just
stick the “'s” in the word again, because it will fall
along with the word, after it reaches the top. We
already know that. The trick is to have everything, all
the letters, really be parts of one object again —
one group. All we need to do is create a new group
that contains both the "'s” and the “tet” group, and

twirl that:

3. In the Score window, select the *'s,”” then select
Group from the Edit menu. This creates a group
with just the “'s" in it.

4. Move the "tet” group into the new group by
slowly dragging it to the right, and slightly upward
until the purple cursor is under the drag bar of the
“s." (If you'd like to review how to reorganize
groups, and the behavior of the cursor, see the sec-
tion on “Using the tree” in the Group Therapy chap-

ter.)
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5. Move the Time Marker all the way to the “‘I:|
mark.

6. In the project window click on some empty
space to ensure that you have nothing selected, then
click on any of the letters to select the new group
and twirl it some using one of the Rotate tools.

7. Run the animation again.

Uh-oh! We wanted the group to twirl after the
“te t'’ reached the bottom, not while it was on its
way there. We need to keep the group stationary
until the right time. How do we delay it's rotation
until later?

Remember, the group isn't moving relative to any-
thing but the space in the window. And at time O

the pose
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the group was just the way we want it to be when
the rest of the word reaches the bottom of the win-
dow. All we need to do is copy that first pose over
to the time when the rest of the word reaches the
bottom of the window. That will prevent the group
from twirling until that point:

8. In the Score window, hold the Option key down
and drag the group’s initial pose even with the last
pose of the “tet”” group. This makes a copy of that
pose.

(g score
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9. Run the animation again.

So don't forget, when you need to change relation-
ships for a while, ungroup an element, and then cre-
ate a group that contains both the element and old

group.

Save or close your project now.

And now for the “really big shew...”

Ok, now that you're warmed up, let's try making a
more complete animation using a combination of
tools and poses. Then you'll really be the next Walt
Disney. First, get a new project window and make it
wider than it is tall. Then:

I. Get the Text tool, click once in the project win-
dow to bring up the Text dialog, and type in the
word “Fly.” Use the Extrude build method with the
default Bevel Style and Depth.

2. Use the Scale tool to make the word about half
an inch high on your screen.

Let's have the large-scale movement be from upper
left to middle bottom to upper right. And let's have
the word get bigger as it nears the bottom. After all,
you can have more than one kind of motion at
once:

3. Using the Move tool, move the word into the
upper left quarter of the window.

4. In the Score window, move the Time Marker
halfway to the “I:1" tick mark.

5. In the project window, scale the word so it's
about twice as big, and move it to the bottom in the
middle of the window.



6. Now move the Time Marker all the way to the
“1:1" mark, and move the word into the upper right
quarter of the window.

7. Run the animation by selecting Run Animation
from the Motion menu. You should see the word
move down as it grows, and then move up to the
upper right.

You with me so far? Good. Now let's take advan-
tage of the ability to move things at different levels
and overlay some movement by individual letters.
We'll have the "y"” get lost and catch up with the
word, while the “F” twirls on its way down. Let's do
the "F" first:

I In the Score window, open up the word by click-
ing on its triangle. Now you can see the timelines for
the individual letters.

2. Slide the Time Marker halfway between the
word's first and second poses.

3. In the project window get the Rotate tool and
double-click on the “F.” This selects the letter.

4. Holding down the Option key, click once on the
“F.” This brings up the Rotate dialog. Type 180" in
the dialog and click on the left-most axis, then on
OK. This rotates the letter forward so it's upside
down.

To get the “F" to twirl the rest of the way we could
rotate it 180° again when it reaches the bottom
(where the word’s middle pose is). But there's a
more elegant way. Did you notice that what we
want is for the letter to have the same relationship it
had with the rest of the group at the beginning —
same position, size, and orientation? | knew you did.
Same relationship = same pose:

5. In the Score window select the “F's” first pose.
Holding down the Option key, drag the pose direct-
ly undermeath the word’s middle pose. This copies
the pose, restoring the letter’s original (right-side up)
relationship with the word.

Run the animation (Command-L) to check this out.
Now for that poor “y.” Like the “F,” let's have the
“y"" be back to normal by the time it reaches the
bottom:

6. Dragthe "y's" initial pose out to, oh, just before
the word's middle pose. This way it will rejoin the
word just before it reaches bottom.

7. Set the Time Marker about where the “F's’ mid-
dle pose is.

8. In the project window use the Move tool to
move the "y" near to the upper left corner of the
window.

and now for the reallybig shew...
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9. Move the Time Marker so it's halfway between

the "'y's” last two poses, and move the “y" so it's just
above and to the right of the "I.”

Run the animation again to view the fruits of your
labor. And now for the finishing touch. After the
word arrives at the upper right, let's have the *'y" fall
on the floor. We'll build in a pause before the fall for
dramatic effect:

G

I. The final position of the "y"" will be on the floor.
This is the end of the animation. Since it's some time
after the arrival of the word in the upper right, set
the Time Marker about halfway between the “1:1"
and "“2:1" tick marks.

2. Move the y" straight down (using the Shift key
to constrain its movement) to the bottom of the
window.

3. Using the Rotate tool and the Option key, rotate
the “y" forward 90° (use the left-most axis in the
Rotate dialog again).

4. Now take a look at the scene from the Left
View — pull down the Effects menu, then select
Camera, then Left (or Command-2).

(Don't let those camera views go begging to be
used. Use them with abandon!)

5. The letter is undemeath the word. This is
because an object rotates around its center, not its
base.

6. Using the Move tool move the letter to the right
so it's just barely out from under the rest of the
word. You'll have to sort of eyeball this. (But you
might be able to use the Top View to check it —
Command-3.) When you're done go back to the
Front View (Command-1).

Run the animation again.

Surprise! We forgot to make sure that the "y"
doesn't start to fall until after the word arrives on
the right. Instead, it starts when it rejoins the word
halfway through. What to do, oh what to do?

Well, remember, we want its relationship to the word
to continue unchanged until sometime after the
“1:1" mark. So we'll copy the pose where it's joined
up with the word (currently the word’'s next-to-last
pose) over to around 40:

7. Select the "'y's"” fourth pose; holding down the
Option key, drag it to around 40, just a couple of
frames before the very last pose.

Now. Run the animation, sit back with a cold one
and survey your work. Ahhh, a job well done!
What?! The pause before the "y's” fall is too long?



Piece of cake — moving a pose along the timeline
adjusts the timing of the move:

I. Select the "y's” last two poses (using the Shift
key to add the second one), and drag them to the
left some.

Why not render it to a wireframe movie? It's only
about 45 frames. Be sure to try the Play All Frames
option under Playback in the Pixar MovieTool appli-
cation. If you have a fast machine you may need to
play it back at half speed. Or...

You could change the length of the animation! It's
easy — you can use the pose scaling tool to resize
the length of all the lines at once:

2. In the Score window, drag a selection box
around all the poses except for the initial ones.

3. Set the Time Marker to the very first frame.

4. Select the Score window's pose scaling tool (to
the left of the zoom tool).

5. Click and drag the last pose to the left or right.
Dragging right lengthens the animation, left shortens
it.

For extra credit you could:

* Add eases (in and out) where appropriate — at
the beginnings and ends of movements. Click and

hold on a pose nib to bring up the ease popup
menu.

* Adjust the path of the "y" as it catches up to the
word by adding poses. You could make it travel in a
circle by positioning the letter at a few key points
evenly spaced in time. Don't forget — move the
Time Marker, then move the letter.

* Adjust the timing of the various segments. Select
the group of poses associated with a segment by
dragging a selection box around them, or by holding
down the Shift key while clicking on individual pose
nibs. Then drag them left or right, earlier or later in
time.

* Delay the scaling of the word until it reaches the
bottom. Hint: use Reset Scale from the Edit menu
on the pose at which the word reaches the bottom.

Organizing poses

Most of the time you're dealing with poses you'll
need to have the Score window's Pick tool selected.
If you have the Zoom tool selected, the more you
click trying to select a pose, the more you'll zoom in!
To zoom back out, hold down the Option key while
zooming.

Whenever you need to alter poses, you'll have to
click and drag on a pose, not near it.

organizing poses
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Creating a new pose — “freezing’ an object

There are two ways to create a new pose for an
object:

* In the Score window, set the Time Marker to a
time in the timeline, then select the object and
adjust it in the project window.

» In the Score window, select the object, then hold
the Option key down and click on a time in the
timeline for the object.

A new pose nib will appear in the Score window,
indicating a pose for that object at that time. This
ensures that the object will remain as it is at that
time, no matter what happens in the previous or
subsequent frames. (Just delete the pose nib to
allow the object to resume the pose implied by the
frame before and after.)

*  Note: Using any of the tools in the Transform
toolbox on an object automatically “freezes” that
object into a pose.

If you want to allow an object to take on a pose
implied by poses before and after, all you need to
do is unfreeze the object. Just delete the pose from
the timeline. For example, deleting the third pose
above would result in a path something like the one
below right.

*  Warning: Remember, the Delete key deletes
whatever you have selected in either the project
window or the Score window. Hitting Delete when
the project window is active will delete any selected
objects! Likewise, in the Score window hitting it with

an object selected deletes the object. However, with

a pose nib selected, the pose will be deleted, not the
object.

Selecting poses

To select a pose, just click on a pose nib on the
object's timeline. You can select multiple poses to
work on by dragging a selection box around them.
Holding down the Shift key while clicking on a nib
adds or removes it from the selection.

*  Warning: When you select a pose you won't see
how the scene looks at that time. To do that you
must double-click on the pose (or hold down the



Shift key while sliding the Time Marker, so it snaps
to poses). This moves the Time Marker to the time
of the pose.

Moving a pose — adjusting timing

Moving a pose is one of the most useful animation
features of Typestry. It provides an easy way to
change an object's speed.

You can move one or more poses anywhere along a
timeline by clicking and dragging them. Beware
though: moving one pose beyond another one can
play havoc with the already-established movements.

Consider the case of two poses that make an object
move from left to right in 24 frames. Let's say you
create a new pose at frame 12, halfway through the
animation. Then you move the pose to frame 20.
The object is still going to be halfway across the
screen in this frame (you haven't moved the object);
it will just take longer to get there — 20 frames
instead of 12. And the rest of the distance will be
covered in just four frames. So the object will
appear to move slower for the first half of the dis-
tance, and faster for the second half,

Remember: Click and drag on a pose, not near it.

Scaling poses — adjusting duration

You might want to stretch or squeeze the action in
a part of an animation. There are a couple of ways
you can do this. One is by dragging the beginning
and ending poses of the section out some, until they
run into other poses. However, there are tools to
stretch and squeeze in more interesting ways. You
can effectively resize just a portion of an object’s
timeline. The Time Marker acts as a reference point,
controlling how the resizing behaves — whether
one end is stationary while the rest of the line sec-
tion moves, whether the middle stays where it is
while both ends move, and so on. The farther from
the Marker a nib is, the larger its motion is.

Here's how you do it. With two or more poses
selected:

I. Select the Pose Scale tool in the Score window
(to the left of the Zoom tool).

2. Drag the Time Marker to the point around
which you'd like the line to scale.

3. Click and drag the poses along the timeline. This
will resize only the selected section of the timeline
without regard for points on the rest of the line.
This may mean that the selected poses expand out
beyond other ones.

-Or-
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3. Hold down the Option key while clicking and
drag the poses left or right. This resizes the selected
portion, and pushes out (or pulls in) the right-hand
unselected portion of the line (without scaling it) as
needed. The left-hand unselected portion is
untouched. The whole timeline's length will change.
In other words, the selected poses expand out (or
in), moving some outer points out as well. This is
the “smart scale” mode.

Duplicating a pose

Duplicating a pose is especially useful when you
want an animation to end up exactly where it start-
ed. To duplicate poses:

I. Select all the poses you want to duplicate.

2. Hold down the Option key and drag one of the
poses to a new place on the timeline. This creates
copies of the selected poses and drags them all at
the same time.

Deleting a pose

To delete a pose, just select the pose, and hit the
Delete key.

Animation settings

You can customize the way the Score window
works with the controls in the Animation Settings
dialog. This is available by selecting Animation
Settings from the Motion menu.

@ animation settings

Frames/Second Time Display
@ Secs:Frames

() Frames

Jump by: frames

[ Align Poses to Frames

Frames/Second. This sets the number of frames
per second. You'll want to adjust this based on
whether you're going out to regular video, a
QuickTime movie, etc.

Jump by. This sets the number of frames by which
to jump when you use Jump Forward or Jump
Backward under the Motion menu.

Align Poses to Frames. With this on, pose nibs
and the Time Marker both snap to frame bound-
aries. Turing it off allows them to be between
frames.

Time Display. This determines the meaning of the
numbered tick marks in the Score window. The

©



default is Secs:Frames. This displays the current time
and frame number. For example, 3:17 means the
I7th frame after the 3rd second. Unnumbered tick
marks are frames.

Renderinglviewing an animation

Typestry provides four ways to create an animation.

*  You can see a simplified version of an animation
(one with boxes representing letters) within

Typestry.

* You can create a wireframe QuickTime version
of the animation.

* You can create a full image QuickTime movie.

* You can create all the frames in a file format for
use in other programs.

To view a simplified version of an animation within
Typestry:

I. Set the animation stoppers at the top of the
Score window to set the beginning and ending of
the animation.

2. Select Run Animation from the Motion menu.

3. Click in the window to stop the animation.

Typestry runs the animation in the Motion Drawing
Mode selected in the Preferences dialog. These
modes are:

Burn In. This draws each frame, one on top of the
other, beginning to end, creating a ““trail”’ so you can
see the objects’ paths.

Loop Forward. This simply runs the animation
from beginning to end, over and over, until you stop
it.

Loop To and Fro. This runs the animation for-

ward, and then backward, over and over, until you
stop it.

Note: When Typestry animates objects on-screen, it
always displays the required frames as fast as it can.
For complex objects, this may be slower than you
expect; for simple objects it may be faster than you
expect. To see a “draft” of the animation at the right
speed, make a wireframe movie (see below).

To create a QuickTime wireframe animation:

I. Select Make Movie from the Motion menu. This
brings up a Save dialog.

2. Select a folder and type a name in the Make
Movie box.

rendering/viewing an animation
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3. Click on Save. This brings up the Make Movie
dialog.

4. Select Wireframe QuickTime movie under the
Movie format; click on OK. This creates a
QuickTime movie file directly. To view this file use
the Pixar MovieTool (see the Movie Tool chapter,
following this one).

.;g make movie

Name: Untitled [J Compute Shadows

Image Quality: O Low O Medium @ High O Custom
Movie Format: @ Wireframe Quicktime movie
O PICT files
(O Use Image Format Dialog (TIFF)
280 &% 210 pinels

Frames: O Al 52 frames

orom [

O Keyframes (2)

To create a full image QuickTime movie:

|. Select Make Movie from the Motion menu. This
brings up a Save dialog.

2. Select a folder and type a name in the Make
Movie box.

3. Click on Save. This brings up the Make Movie
dialog.

4. Select PICT Files under the Movie format if you
want the dimensions of the movie frames to be the
same as your window. Otherwise select Use Image
Format Dialog to specify that you want the settings
found in the Image Format dialog to determine the
dimensions of each frame.

5. Select an image quality. You can use lower quali-
ty settings to make a quick “draft’” of an animation.
Higher quality animations will take longer to render.
If you've set any lights to cast shadows, check
Compute Shadows to have them appear in the ani-
mation.

6. Click on OK. This creates a series of PICT files.

7. Use the Pixar MovieTool to build and view the
movie (see the Movie Tool chapter, following this
one).

To create just frames for use elsewhere:

I. Select Image Format from the Render menu.
This brings up the Image Format dialog.

2. In the dialog, set the image dimensions, resolu-
tion, and File Type, and click on OK.

3. Select Make Movie from the Motion menu. This
brings up a Save dialog.




4. Select a folder and type a name in the Make
Movie box.

3. Click on Save. This brings up the Make Movie
dialog.

5. Under the Movie format, select Use Image

Format Dialog to specify that you want the settings
found in the Image Format dialog to determine the
dimensions, resolution, and file type of each frame.

6. Select an image quality. You can use lower quali-
ty settings to make a quick “‘draft” of an animation.
Higher quality animations will take longer to render.
If you've set any lights to cast shadows, check
Compute Shadows to have them appear in the ani-
mation.

7. Click on OK. This creates a series of PICT files.

The nature of Typestry animation

In Typestry, an animation is really a sort of a table,
like this:

Objects have a certain pose at each frame. If they're
not in the table, they're not in the animation. If they
are in the table, they're in the whole animation.
They can't be in the table in one frame, and not in
the table in another. This means that if you create
an object in a certain keyframe, you've created it for

the whole animation. Likewise, if you delete an
object in any keyframe, it's gone for the whole thing.

What to avoid

That having been said, here are a few things you
should avoid in an animation. They are all character-
istics that are permanently in place.

* Adding or deleting objects. An object exists (or
not) for the complete animation. Likewise, when
you group objects, they're grouped for the whole
thing. If you want to make objects seem to disap-
pear, you can use a trick: shrink the object almost to
nothing in the space of a single frame.

* Changing an object’s Look, or changing any of
the Object Info dialog settings (color, opacity, scale,
etc.).

* Changing anything in the Effects menu.

* Changing a light's Look, color, or shadow-casting
ability. (But there’s a trick you can use to give the
illusion of animating a light's Look and color. Read
on...)

What to remember

And speaking of lights, don't forget — there are a
couple of things that you can play with and animate

the nature of Typestry animation
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to good effect: any light's position and intensity, and
any spotlight's coneangle as well. The Lights window
shows you the state of the lights at the time indicat-
ed by the Time Marker. Since you can animate inten-
sity, you can get the illusion of animating a light's
color or Look using a trick. Use two lights in the
same position, each with a different color or Look.
Turn one's intensity down and the other’s up. It will
look like one light, since they're both in the same
place.

Tradeoffs

When you set some poses for an object, Typestry
moves the object through those poses using certain
tweening (interpolation) schemes. Think of this as
drawing curves through a series of points (poses).
Different animation packages use different kinds of
curves. Each has its advantages and disadvantages.

The tradeoff with Typestry's curves is that although
the curve goes through all the points so you can see
exactly where the object will be at a given pose, the
shape of the curve may not be exactly what you
want. Everything depends on the positions of the
various poses. Some situations may cause an object
to go through a point, and then beyond it, before
starting to curve around, rather than curving exactly
as it reaches the point. For rotations, sometimes you
may see a ‘preparation’” for the rotation. Here the

object may rotate slightly the wrong way just before
it starts the real rotation.

If you notice any of these subtle idiosyncracies you
can fix the situation pretty easily. The general idea is
to identify the pose where things seem “‘off,” make a
copy of that pose, and move it right next to the
original. The closer the better — one frame away
isn't too close.

An animation checklist

If you think you need to establish a new relationship
between elements, you'll probably need to group or
regroup things. Think about what needs to move
relative to what. Remember, when we say move, we
mean move, rotate, scale, skew, or any combination
thereof.

If you need to move something independently of
other things, try moving it out of the group it's in.

If you need to move something in conjunction with
something else, try creating a new group that
includes both things.

If you need to delay an object's movement, find the
pose where the delay should begin. Copy that pose
(using Option-drag) to the time at which the delay

should end. The object won't change between the

two poses.




If things are moving too quickly or too slowly, select
the affected poses and use “smart”" pose scaling.

If you need to change the length of a whole anima-
tion, just select all the poses and use the Pose Scale
tool in the Score window to move them all at once,
lengthening or shortening the whole animation.

If things start too early or too late, just move the
pose(s) down the timeline.

If you need to reset an object’s orientation, scale, or
skew in the middle of things, just use one of the
Reset... functions under the Edit menu.

If you need to tweak the movement of a group, you
may benefit from creating a new group that includes
the one you want to tweak. Tweaking the new
group leaves the old one to act as it has been, so

you don't have to go back and change other parts of

the animation.

Rendering a loop

If you're doing an animated loop you may have to
make a small adjustment to your animation. First of
all, you should have the first pose duplicated at the
end of the animation, so things end up where they
start. Now, when you go to render the frames, ren-
der all but the first frame, since it's already duplicat-

ed at the end. This is especially important if you're
using particles, wind, or motion blur.

* And remember: It's not every piece of software
that allows you to do motion blur. If you can afford
the extra rendering time, be sure to turn this on: it
adds a powerful bit of realism. You'll probably want
to use the Normal Blur setting (for the Motion Blur
item under the Effects menu) for an animation,
unless you're shooting for an unusual effect.

Creating a 2-frame animation

To use particles or wind (Physical Simulation) in a
still image you must create a an animation, since
these both depend on motion. However, you may
need only two frames to achieve the desired effect.
In any case, you should never need more than two
poses.

When you use particles or wind, Typestry has to
calculate the position of the particles or the sheet in
every frame of the animation. For this reason, the
fewer frames you have, the smaller the number of
calculations that will have to be made, speeding
things up.

* This means that you should use the Animation
Settings dialog (available from the Motion menu) to
set a low number of Frames/Second. Two may be

creating a 2-frame animation
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sufficient — this will allow you to see things at inter-
vals of half a second.

l. With the Score window showing, drag the
object’s initial pose nib out. The farther you drag it,
the later in time the rendered frame will be.

2. Double-click on the pose nib you just dragged
out. This sets the Time Marker to that time.

3. Select Update Simulations from the Motion
menu. Typestry will then calculate things for that
frame. The more intermediate frames there are, the
longer this will take.

4. If you need to, move the pose nib to a different
time, double-click on it again to see the pose at that
time, and select Update Simulations again. Repeat
this until you reach a time that gives you the results
you like.

Danger, Will Robinson! To see the effect of the parti-
cles or wind in a given frame, you must select
Update Simulations from the Motion menu.
Otherwise, the calculations for the object’s shape
won't get done.

5. Now you can render.




Summary of Score window
operations

* “First move the Time Marker, then move the
object. Move the Time Marker, then move the
object.”

Click and hold to show

Click and hold to show Looks menu: click and

Perfs menu drag to copy Look to

another object

v F}'g
/ o

Click to open/close
b

I
1.2

i3

SHCHS
~

Drag bar: click and Click and type to edit name

drag to move in/out of
groups, up/down in list

summary of score window operations

animation




Animation brackets

Second:frame t

..................'I'.................

Time Marker: shows

the time and frame

Pose nib: click and A 1 2 of the current view
L]
hold to show Pose
type menu; Option- + v Smooth
click to create new >
pose nib; Option- No Ease - Pose/ease type menu
drag to copy nib e B
Qe Ease In
Ease Out
Ease Inf&0ut
Pick tool Play animation
Zoom in;

Pose Scale; +Option key = zoom out

+Option key = smart scale
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Pixar MovieTool is a simple utility for playing and
building QuickTime movies. If you've used Pixar
Typestry to create a wireframe QuickTime movie
you will use this tool to playback the movie. Once
you've rendered a sequence of PICT files from
Typestry, use Pixar MovieTool to convert them into
a single QuickTime movie file and to play it back.

Playback

To playback a QuickTime movie, simply open the
movie (using Open in the File menu). This will bring
up your movie within the QuickTime standard
movie controller.

= motion.mool) =

This interface consists of 5 simple controls which are
modeled after a typical consumer VCR.

The play/pause button allows you to start your
movie running or pause it if it's already running.
While paused on any single frame you can copy it to
the clipboard using Copy Frame in the Edit menu.

[]

The scrollbar indicates your progress through the
movie and allows you to shuttle forward and back-
ward.

The frame forward and frame backward buttons
allow you to step through your movie frame by

frame.

playback

movie tool




The resize button allows you to resize the playback

Pixar MovieTool provides additional control over

window.

playback through the Playback menu.

Playback

Loop L
Loop To and Fro 3P

Half Speed

v Full Speed
Double Speed
Play Rll Frames

Half Size #®0
Normal Size #®1
Double Size 82

Looping

* Loop causes your movie to be replayed continu-
ously.

* If Loop To and Fro is set AND Loop is on, your
movie will play forward until the end, then play
backward until the beginning (and so on).

Playback Speed

Pixar MovieTool provides several controls over the
speed at which a movie is played. When a

QuickTime movie is constructed, it is assigned a pre-
ferred, or “natural,” playback rate. When playing
your movie, QuickTime does its best to preserve
this natural playback rate. In doing so it may need to
skip individual frames in order to assure that things
happen at their “natural” time. This is great for live
video, but when developing an animation you are
probably more interested in experimenting with the
playback timing or in seeing every frame that you've
rendered. If you want to change the playback rate,
use the controls to set Half Speed, Full Speed or
Double Speed playback. If you want to see every
frame of your animation choose Play All Frames.

Playback Size

The dimensions of your movie have a significant
impact on QuickTime's ability to play it back. The
larger the images, the more likely QuickTime wiill
need to skip frames and cause jerky motion. There
are some internal optimizations in QuickTime for
playback into windows which are Half Size, Normal
Size and Double Size. Pixar MovieTool will automat-
ically set your movie window to the size you
choose. Use the resize control on the window itself
for other dimensions.




Build Movie

Use Build Movie to construct a QuickTime movie
file. Build Movie asks you to specify the first and last
frames in a sequence of frames that were rendered
with Typestry.

Here are the rules for building a movie:
« the frames must be in PICT file format.

« the file names must follow a naming convention
where the movie name is followed by a period
which is followed by the frame number (movie.|
movie.2, movie.3, ... ).

« all frames must be located in the same folder.

QuickTime movie files can be quite large. In order
to reduce the size of your movies and to increase
their playback rate, Pixar MovieTool uses the com-
pression scheme specified in the Compression
Setup dialog.

The Compression Setup dialog is a standard com-
pression dialog which is uniform across QuickTime
applications (just like the standard file selection dia-
log). It allows you to choose which compression
scheme to use when building your movie. The con-
tents of this compressor popup menu will depend
on which compression components you have
installed on your system.

-~ COMPressor

'—’—_—"__________‘_-’__—__——:T‘

Compression Settings

[ Animation v

[ Millions of Colors+ ¥

- Quality-

1
Ledst Low Normal High Mast

B ] | T

Frames per second: EIE]
X Key frame every frames

[ Limit data rate to ‘:] K/Second

Cancel u 0K '

build movie

movie tool




Compressor

Apple supplies a few standard compressors with
QuickTime and these are:

Animation. Your best choice for a compressor.
This compressor has the best characteristic for syn-
thetic imagery. It shouldn't cause your image to
deteriorate and it should reduce the file size. For
highest quality, use Millions of Colors.

Graphics. This compressor doesn't provide you
with much control over the quality of the image so
it's generally unsuitable for our purposes.

None. This doesn't do any compression. It will
playback slower than the Animation compressor.

Video. This compressor is intended for live video
movies. It compresses files quite well, has a good
playback rate, but introduces many artifacts into
your images.

Photo-)JPEG. This compressor offers the highest
compression rates for the highest quality.
Unfortunately it takes the longest to compress or
decompress yielding slow playback rates.

Quality

This slider gives you some control over the quality

vs. size trade off for compressors. This slider has no

¢

or minimal effect for certain compressors.

Motion

You can control the “natural” playback rate of your
movie by setting its Frames per Second before
building it.

When building a highly compressed movie you may
wish to insert an uncompressed reference frame
every so often. Use the Key Frame every... field to
specify how often you'd like these frames to appear.
This field will be dimmed for certain compressors
which don't actually compress your image.
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Working with a Typestry window

You might want to make your project window the
same size as your final rendered image so you'll see
things at the correct scale. To make a Pixar Typestry
window a particular size:

|. Select Image Format from the Render menu.
This brings up the Image Format dialog.

.@ image format

Window Size Qutput File []Constrain Aspect Ratio

581 |pinels  Width 400.00 | IPEENRG

419 | pizels Height 300.00

22 pinels/in Resolution |72 pinels/in |
_ File Type [ _PICT |
Set Default g
File Size  468.8K [ ok ]

2. Under Window Size, type in the dimensions
you'd like to use.

3. Click on OK.

working with a Typestry window
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Warning: If you render to a file rather than to the
screen, the dimensions used are those under
Output File instead of Window Size. If you want

these to be the same, just click on the “>>"" button.

This loads the Window Size dimensions into the
Output File dimensions.

Basic Preferences

Some items in the Preferences dialog are useful at
any time. This is available by selecting Preferences
from the File menu. These are described here.
Descriptions of the other items appear later in this
manual.

Q preferences

Wireframe Complexity Motion Drawing Mode

, LIPS IEIPL. @ Loop Forward
Line Color ] Q Loop To and Fro
Empty Space Qs

@ Colored O 6rid

Q Transparent by
Nudging Distance Renderer

E- %, S @ Internal RenderMan
Look Editing Level (O MacRenderMan

@ Standard

QO RenderMan Expert

Wi ireframe Complexity. This controls the accu-
racy with which letters are displayed. Setting the
accuracy higher slows down screen redraw.

Line Color. This controls the color of the wire-
frame lines in your window. Just click on the box
and pick a color from the color picker. Be sure to
make this contrast with the Empty Space color (see
below), otherwise you won't see the lines against
the background.

Empty Space. In the project window, the Colored
button controls the color of the background on
which the wireframe lines are drawn. In a rendering,
it controls any “empty” areas in the image: those not
covered by a wall, floor, or letters. Just click on the
box and pick a color from the color picker.
Choosing Transparent will have the effect of making
these areas look black, but in fact, they'll be com-
pletely transparent when used by programs that
support an alpha channel.

Nudging Distance. \When you use the Move,
Rotate, Scale, and Skew tools you can use the arrow
keys on your keyboard to affect the selected object
in small increments. This control sets the size of an
increment.

Look Editing Level. Some Looks have many con-
trols. These are what you see in the Edit Look dia-
log. By clicking on RenderMan Expert you can see
some parameters that are normally hidden from




view. These low-level parameters, at the heart of
the RenderMan shading model, act somewhat differ-
ently from the other parameters. You can get along
perfectly well without ever touching them. If you're
still interested, they are described in “RenderMan
Expert Parameter Information for the Adventurous”
in the Editing Looks chapter.

Grid. This sets the number of grid lines you see in
the grid displayed in the project window by the
Toggle Grid command under the Edit menu.

Renderer. If you have Pixar's NetRenderMan, you
can bypass Typestry's internal renderer and render
across your network. Just set this to MacRenderMan
and select a renderer in the Chooser.

Printing

To print an image, just select Print or Print One
Copy from the File menu. If the image was rendered
to the screen, it gets printed at the size and resolu-
tion you see on your screen. This means the resolu-
tion will usually be 72 pixels, or dots, per inch.

If you need a higher resolution, you'll need to render
the image to a file and print it from some other
application, like Photoshop, that deals with resolu-
tion in conjunction with printing.

0 printing
simple things




Pixar's NetRenderMan brings dramatic
speed improvements to the 3D computer
picture making process by allowing you to
utilize remote CPUs for rendering.
NetRenderMan allows Pixar Typestry users
easy access to networked rendering using
Pixar's PhotoRealistic RenderMan software.
Once installed, rendering a high-quality
Pixar Typestry color image from a net-
worked UNIX workstation, or a network
of Macintosh CPUs is as straightforward as
printing a document. This is ideal for any-
one rendering large print-quality images.

With NetRenderMan you can render your

finished high-resolution image overnight
This image was created with Pixar Showplace using

Pixar One Twenty Eight Textures. and have it ready for you in the morning!

NETRENDERMAN

A Macintosh with the power of a UNIX workstation or multiple Macintosh CPUs
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Can | use Fontographer and lllustrator out- and the strings were saved in three files (top, middle,

put both in the same Typestry file? bottom). Each Adobe lllustrator string was imported
' ' into Pixar Typestry 2, sized and positioned through

Ahhh. We were hoping you would ask that. See this ;

) the appropriate set of
picture? It uses

both. Here's the

story.

stars.

The Christmas ornament

) ) ) was created using three of
First, a nice fat lttle the snowflakes in the Zapf
Dingbats font and the
Rubber Sheets option. The

top of the ornament is

star was created in
Fontographer.

Three separate star
“words'' consisting simply an extruded Gill
of 4, I'l, and 5 star
characters (top,
middle, and bottom,

respectively) were

Sans capital “O" with no
bevel. The hook eye is the
upper case "U" from the
Charlemagne font.
brought into Pixar
Typestry 2. The
stars were sized and

Grouping was extremely
handy for this project. All

o the stars and strings were grouped as were the
positioned. The wall background was added and the

file rendered. This rendered Black and White EPS
file was imported into Adobe lllustrator and the Looks: The stars are EC Gems Dented Jewel with
strings were drawn in. The star image was deleted the highlight strength and spread turned up and the

ornament parts.

tasks




Pits relief added. The string is a new Relief, Threads,
combined with a shiny red Instance of the Metal
Look. The snowflakes on the ormnament were creat-
ed with EC Gems-Corrosion, again with the highlight
spread and strength turned up. To this point all the
Looks were customized in Glimpse.

The blue ornament background is the Starter: Shiny
Chrome with the highlight strength and spread
turned up and the color set in Typestry 2. The orna-
ment top is Starter: Combinations:Engraved metal
and the hook eye is Starter: Shiny Metal set to gold.

Last but not least, the back wall is Pixar |28 Belizan
Mahogany.

Lights: #8 at 100% with a spot and shadows. #5 at
|00% with a spot, focused tightly on the ornament
only.

Rendering time on a Mac llci with a YARC accelera-
tor board was 2 hours and 22 minutes. Final ren-
dered size was 7x5 inches at 300 dpi, because it was
intended to be used as a Christmas card.

How do | change a word’s bevel?

You must use the Edit menu’s Replace Selection
command for this. But the command is available only
for whole objects that remain as they were generat-
ed in the text dialog. This means that you can't type

in a word, and change the bevel of one of its letters.
You must change the whole object. If you need to
change the bevel of a letter, you should type in the
letter separately and group it with the rest of the
word.

But to change an object’s bevel:

I. Select the object.

2. Select Replace Selection from the Edit menu.
3. Click on Build Object.

4. Set the Bevel Style or Depth.

5. Click on OK.

How do | kern letters in Typestry 2?

There are no facilities specifically designed to do
kerning per se, but you do have two options. First,
you can use lllustrator to adjust almost anything
you'd like about your text, and import that file.
Second, within Typestry you can always move indi-
vidual letters to adjust their spacing. This is best
done with the Camera (in the Effects menu) set to
Telephoto:

I. Select Telephoto from the Camera menu (
under Effects).




2. Select a letter (double-clicking to select the letter
as a subelement of a text object, if necessary).

3. Select the Move tool.

4. Hold down the Shift key to constrain the direc-
tion of motion while starting to drag the letter hori-
zontally.

5. Don't forget to set the Camera view back to
Normal, if that's what you were using.

How do | use my own texture on a word (or
wall or floor)?

I. With the object selected in the Looks window,
click on the New Look button.

2. Use the Browser to find the Picture/Background
Look in the Look Instances:Place My Pictures:Simple
folder; then click on Select.

3. Click on the Edit Look button in the Looks win-
dow.

4. Find the Color Picture parameter in the Look
Editor dialog and select Other Picture from the

popup.
5. Use the Browser to find your image, and click on

Select. Your image must be in RGB TIFF or PICT
format.

6. In the Look Editor, click on Save As and save the
Look.

7. Render! You may need to adjust the scale in the
Object Info dialog, available by clicking on the
Object Info button in the Looks window.

How do | avoid having letters run together?

If you use a large bevel size this may be unavoidable.
Using a smaller bevel size will help, but otherwise:

- Move the letters one at a time using the Shift key
to constrain motion to the horizontal (see the kern-
ing task above); or

- Type a space between each letter as you type in
the text dialog.

Can | use any font at all?
Typestry can only use a font if:

- itisa Type | outline font located in the System
folder's Extensions folder, or in a folder containing
an open Suitcase file, which can be anywhere in your
system.

« itis a TrueType font in the System file itself.

Warning: Some TrueType and Type | fonts (typical-
ly shareware or freeware) are poorly or illegally con-

tasks




structed. If this is the case, Typestry may not be able
to properly convert characters into 3D.

How do | adjust Looks (change color, size,
orientation, etc.)?

|. Select the text with the Look on it.

2. Click on the Object Info button in the Looks
toolbox.

3. Use the Object Info dialog to change the Look’s
size, color, orientation, opacity, and projection.

If you'd like to make more extensive changes you
should click on the Edit Look button in the Looks
window and use the Look Editor.

See the chapter on Applying Looks for more informa-
tion on both of these procedures.

How can | use NetRenderMan with Pixar
Typestry?

If you have NetRenderMan and would like to use a
renderer on the network:

I. Select Preferences... from the File menu.

2. Click on the MacRenderMan button.

Make sure you have a network renderer selected in
the Chooser (not Local!).

How can | speed up rendering?

* Use lower quality settings when appropriate (to
check on position, orientation, preliminary lighting,
etc.).

e Make your window smaller: larger images take
longer to render than smaller ones — you may not
always need to see things at full screen size.

*  Use the crop window liberally. If you apply a
Look to some text, you may not need to see all of it
— a single letter might suffice.

* Use effects judiciously. Motion blur, perforations,
and shadows can all slow down rendering, and the
more perforations and shadows there are, the slow-
er the speed. Using your own pictures in Looks will
tend to slow things down somewhat, too.

¢ The more shadow-casting lights you have turned
on, the slower the rendering. Your image may need
a lot of lights, but you may not need all of them
every time you render.

If you've done all this, and you're willing to spend
money to buy more speed you should consider
either accelerator boards, a faster machine, or ren-
dering across a network either to a UNIEX machine




or to other Macs on the network using NetRen-
derMan.

Some accelerator boards are designed specifically
for speeding up RenderMan renderers. Most generic
accelerator boards will also speed things up.

How do | guarantee enough memory to
render?

You can't guarantee it, but you can try increasing the
application’s memory.

To increase the application’'s memory, first quit
Typestry. Then:

|. Select the Pixar Typestry icon.

7. Select Get Info from the File menu. This brings
up the Get Info window.

3. Type in a higher number in the “Current size”
box in the lower right corner of the window. Be
sure not to exceed the available memory in your
system.

4. Close the window.

How do | improve the quality of my shad-
ows?

@

Shadows are computed for an image of a particular
size. If you have computed shadows for a small
screen image, and then render to a file (or window)
of larger dimensions without recomputing shadows,
you may get poor results.

When rendering to a file, always use “"Compute
Shadows” instead of “Render with old Shadows,”
unless you know the old shadows are both correct
and an appropriate size.

How can | correct typos?
|. Select the object to be changed.
2. Select Replace Selection from the Edit menu.

3. Type the correct text in the text dialog (using
the same font and bevel settings!).

4. Click on Build Object.

How can | get one word behind another?

|. For this you'll probably want to make sure the
words are in separate groups. Use the Tree window
to do this.

9. Then select Left or Top from the Camera
popup, available under the Effects menu. These

tasks




allow you to see the words from a more convenient
perspective.

3. Use the Move tool to move the words into the
right positions.

4. Get the Front view back from the Camera
popup under Effects.

How can | get reflections?

In a nutshell, to reflect on a floor, make a duplicate
of the object, reverse it, put it under the floor, and
make the floor semi-transparent. The process is
rather inexact, and is kind of cheating, but hey, what-
ever it takes... Here are the steps:

I. Create two identical versions of the text object.

2. Superimpose one on top of the other as accu-
rately as possible (see the next task).

3. Bring up the Scale dialog by holding down the
Option key while clicking on the object with the
Scale tool.

4. Click on Nonuniform and type —100 (that's neg-
ative 100!) in the Height box.

5. Drag the reversed object down (using the Shift
key to constrain movement) so its top meets the
bottom of the regular object. This will be the reflec-

tion. (If you want the object to look like it's floating
in air, the reflection won't meet it, so move the bot-
tom one farther away.)

6. Group the two objects. This way you can adjust
them (move, rotate, etc.) together.

7. Select Floor from the Backgrounds menu item
under the Effects menu.

8. Now select Floor Setup from the same menu.

9. Click on the Manual setting and try to line the
floor up so it falls exactly halfway between the two
objects; click on OK.

I0. After you've applied a Look to the floor, get the
Object Info dialog by clicking on the More Info but-
ton in the Looks toolbox.

['I. Turn down the Opacity a little so it's around 80
or 90%, and click on OK. (You'll have to experiment
with this setting to get just the reflective effect you
want.)

| 2. Render.

This trick has its limits. Since the “reflection” is really
just another object, its surface won't look upside
down with respect to its counterpart (though you
may be able to adjust this by flipping the Look in the
Surface Info dialog, depending on the Look). But you
may not see enough of it to really notice.




Also, if the object is tilted forward or back, its reflec-
tion will have to be tilted in the opposite direction.
You should do this before you group the words.

To reflect on a wall, you'll have to put a copy of the
object (not reversed, as for the floor) behind the
wall. See the “How can | get one word behind
another’ task for this procedure. Check the Wall
Setup dialog (from Backgrounds under the Effects
menu) for placement of the wall and the objects in
relation to it.

What’s the best way to align things?

|. Select Telephoto from the Camera menu item
under the Effects menu.

2. Select Preferences from the Edit menu and
increase Wireframe Complexity to the maximum.
Also, set the grid dimensions to some number that
will give you enough grid marks to help line things
up: 25x25, 40x40, whatever works for you.

3. Make your window as big as possible.
4. Select Toggle Grid from the Edit menu.
5. Line your objects up.

5. When you're done, set the Camera back to
what it was!

How can | get a light to track by itself?

A light can only track an object, but you can create
an invisible object (maybe just a single character) for
the light to track, so it looks like it's tracking by itself.
To make an object invisible, just turn its Opacity set-
ting all the way down in the Object Info dialog, avail-
able by clicking on the Object Info button in the
Looks toolbox. (You must first apply a Look to it.)

I rendered a word and brought it into my
page layout program, and | got the word on
a black background. How do | get rid of the
background?

The short answer is you can't, unless like Adobe
Photoshop, your page layout program (or whatever)
uses an alpha, or matte, channel. If an alpha channel
is supported, then:

|. In Typestry, select Preferences from the File
menu.

2. Make sure the “Transparent” Colored button is
selected.

3. Click on OK.

But if you just need a white background in your
image so it blends in with a white page, the solution
is simple. Use the steps above, but make sure the
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“Empty Space” Colored button is selected, and that
the color is pure white.

When you rerender, you'll have a white background.
Of course, the Empty Space color can be anything,
and so can match any solid background you may
have.

But what if you want the word to lie on top of an
image you already have on a page? Well, the fact of
the matter is, you're stuck with importing a rectan-
gular area. But despair not, for Typestry is capable of
making empty areas of an image disappear using
“coverage.”

The theory is, modify the idea of a pixel so that in
addition to color information, it includes an amount
of coverage. Now, when you bring in an image over
a background, for each pixel in your image you can
ask the question, ““Should this pixel cover what's
under it?”" If the answer is yes, you see the regular
dot of color in the image. If the answer is no, you
see the background. Voilal A rectangular image cov-
ering a non-rectangular area!

Using the alpha channel, not only can we turn cov-
erage on and off, we can also tumn it on a little, a lot,
or anywhere in between. Turning it on completely
for a part of an image makes that part completely
opaque. Tuming it off makes it completely transpar-

ent. Anywhere in between makes it semi-transpar-
ent.

In those programs that know what to do with alpha
information (“'support” an alpha channel), each pixel
of an image is described by four values, three for
color (RGB) and one for coverage (alpha). In those
programs that don’t support alpha, an image’s pixels
have only RGB values, and all the pixels are just
there, covering everything.

Currently, there's a problem. We're in one of those
transition times where some software supports an
alpha channel, and some doesn’t. Unfortunately,
most page layout and paint programs don't yet sup-
port alpha. So where's this leave us?

Well, it depends on what you need to do. If you
want to include a Typestry word in an image you've
made, buy a program that supports a matte, or mask
channel and just copy the “covered” part of the
Typestry image into your image. No unsightly rec-
tangle, no extra pixels, just the word.

If you want to put a Typestry word over your text,
you'll either have to plan on having a rectangle
around the word or lobby for your application to
support an alpha channel!




How do | know what size and resolution and
stuff like that to use if I’m printing to a
LaserWriter (or Lino, etc.)?

OK. We'll assume you've made your project win-
dow the shape you want your image to be.
Additionally, you must know what linescreen you'll
be using when you go to print. If you don't know
about this, read on. If you're printing on a
LaserWriter, figure on 60. Then:

|. In the Image Format dialog (under the Render
menu), click on the "*>>" button to load these val-
ues into the Output File boxes.

2. Check the Constrain Aspect Ratio box.
3. Change the popup from pixels to inches.

4. Enter the Width and Height of the image as it
should appear on the printed page.

5. Multiply your linescreen number by | .5 and type
this in the Resolution box.

6. Render to file.

And now a little explanation. No matter what print-
er you're going to use, you need only decide on a
linescreen value to know what numbers to use in
Typestry. The linescreen number is typically some-
thing like 60 for a 300 dpi LaserWriter, and more
like 120—150 when going to Lino or high-resolution

imagesetters. The linescreen basically determines
how coarse the image looks.

Bear in mind that the higher the linescreen number,
the less color subtlety you'll see in any but the high-
est-resolution imagesetters (2400 dpi or more).

For the Resolution you can actually use a number
that's between | and 2 times the linescreen number,
and you may want to try a test or two to see what
you like best. But 1.5 should work pretty well.

How can | get my animations out to video?

If you want to see your animation in real time,
you're probably going to have to get fancy and
spend money. QuickTime is useful for many purpos-
es, but to get real speed and large frame capabilities,
you may want to look at video systems. These can
consist of a board to plug in your machine and soft-
ware that allows you to record a series of images
onto frames of videotape. You can then edit frames,
add special effects, and so on. And of course, you'll
be able to play them back at video rates, just like
you see on your television. Some packages
(Diaquest, for example) can record either individual
frames, or whole QuickTime movies to video disk
or tape.
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Are there any rules of thumb for getting
good results in Typestry?

While there are a lot of ways to make a good pic-
ture using Pixar Typestry, there are also a lot of
ways to make a bad one. To help you avoid some of

the pitfalls in the process we've come up with some
tips and caveats.

* Lighting from above (lights |, 4, and 7) tends to
look most “natural.”

* A reasonable light setup could have all lights off,
except for light 7, which should be all the way on.

(An unreasonable setup would have all the lights
on.)

When using perforations, usually a small bevel
size will help readability.

Avoid using transparency when bevel size is large
unless you want to see the internal structure of a
letter’'s beveling.

When using motion blur, the longer the streak,
the more dissipated it will look.

* To get highlights on objects where you want
them, think of the surface as a mirror; tilt the object

(or move the light) so you could see the light in the
mirror.



TroubleshooTing
M

Letters aren’t beveled as much as |
expected.

This can happen for two reasons:

«  The letters appear too small for you to notice
much beveling. Depending on the bevel style and
size, the effect can be subtle enough to be apparent
only when the letters are relatively large.

«  The letters’ depth has been scaled, stretching out
the bevel so it's not as apparent. You can use
Replace Selection from the Edit menu to redo the
Depth of the bevel so it's closer to what you want.
Then once it's in the project window you can tweak
its depth with the Scale tool.

I edited a bevel but it looks all crazy in the
rendered version.

If you've edited a bevel so the line curves around
and intersects itself, or does something exceedingly
weird, Typestry may get confused. Try making the
bevel a little simpler.

| turned on a shadow, but I don’t see it any-
where.

Could be one of the following:

«  There's nothing for the shadow to fall on (a
floor, wall, other characters, etc.).

«  The light is shining at a low angle, and casts a
shadow above the floor.

e The light is a back light, and casts a shadow in a
direction opposite the wall.

< The wall is right up against the back of thin let-
ters, so it's difficult to see.

« There are other lights on, drowning out any
shadows.

Shadow looks funny on floor/wall

This can happen if the wall or floor is in an orienta-
tion that makes shadows fall in an unexpected way.
Check the Wall Setup or Floor Setup in the Effects
Backgrounds menu.

troubleshooting




I have a lot of lights turned on, but the floor
is still pretty dark. Why?

Since Typestry lights shine in a particular direction, if
a surface is facing away from the light it will be rela-
tively dark. If your image uses lights 3, 6, or 9, which
shine up from below, the floor’s surface (and tops of
letters as well) will not be lit by these lights —
they're shining on the floor's underside. Either
increase the ambient light, or use any of the other
lights, which shine from higher up.

How do | avoid having ‘“washed out” areas
in my image?

This is usually the result of too much light.

* Before you try turming lights down, first try reori-
enting the affected elements so the light falls more
obliquely, if you can.

* If you can identify a particular light that's having
the most effect on the area, try reducing that one
first.

e Try a different combination of lights.

* Reduce all the lights gradually until the area looks
more normal.

e If the ambient light intensity is more than about a
quarter of the way up, your whole image may seem

“flat.”” Just reduce the ambient intensity to improve
this.

I only see a wall in my picture, but | know
there’s text there. What happened?

You probably got the wall in front of the text by
manually adjusting it using the Wall Setup dialog in
the Effects menu. Use the dialog to reset the wall.

I just can't seem to get things as shiny as |
want them. What's the deal?

The desire for shiny things is an ancient one. There's
just one small trick you should know to help you
make things shiny. If you're using any Look that has a
simulated reflection (and you can check this in the
Look Editor dialog) you need to turn on some back
lights.

This is because the simulated reflection comes from
a simulated object that faces the front of your text.
Back lights, shining on the back of your text, shine
on the front of the simulated object, making it
brighter. This will have the effect of making the
reflection brighter and more pronounced. Try
adding 3 or 4 back lights at medium intensity and
see if things don't improve.



You can also turn up a Look's Shininess parameter
in the Look Editor dialog (available when you click
on the Edit Look button in the Looks window). Save
this Instance and use it instead. One caveat here. It's
easy to think that something doesn't look shiny
enough because it looks very dark. You might also
try turning down Shininess and seeing if that has the
effect you're looking for. This will, in fact, make the
dark areas lighter, and may make it seem like it's
reflecting more.

Another thing to try is turning on an environment
with the E light in the Lights window, or using an
environment picture in the object’s Look.

| perforated an object, but the perforations
don’t go all the way through the object (or |
don’t see some or all of the perforations).

If the perforator is thinner than the perforatee, as it
were, all the perforation will occur inside the perfo-
ratee, and you won't see any perforations. If the per-
forator doesn't go all the way through the perfora-
tee you'll get a carved out effect. Just make the per-
forator thicker so it sticks out both sides of the per-
foratee.

| applied a Look, but | don’t see its effects.

«  The Look’s scale is too low or too high. Try 50%
and 250% in the Object Info dialog’s Scale box.

«  There's not enough light. Try adding more.

- It got applied to the object’s sides instead of to
the whole thing.

« Rendering quality is too low to see the detail.
Try using Excellent 'n’ Slow.

I turned the floor on, but | don’t see it.

It's right in the middle of the picture, so it's edge on.
Check the Floor Setup dialog and check its position
and orientation or, camera is set to Telephoto and
you're seeing the floor “edge on.”

Why can't | choose Object Info after typing
in some text?

When letters are created as part of a group, they
take on the Look of the group. You can only get
Object Info for something that actually has a Look
on it. The letters don't — they “inherit” their Look
from the group. To adjust the Look on a letter you
have to actually apply a Look to the letter. Then you
can use the Object Info dialog to adjust its Look.
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What if | move my text out of the picture?

If you've lost sight of something, just use a different
Camera view, available under the Effects menu, and
move it so it's visible in the view you want to use.

I just keep getting things mixed up when |
try to do an animation. Help!

Remember the animation mantra: “First move the
Time Marker, then move the object.”” Since an ani-
mation consists of things moving in time, you must
be sure you're at the right time before you move any-
thing. Otherwise things can get awfully confusing. So
check where the Time Marker is before you do
things, and use it to show you what's happening in
successive frames. And don't be afraid to delete
some pose nibs and redo things if necessary.

My text is obscured by something and | just
can’t select it.
I. Select the object in the Score window.

2. Hold down the Control key as you manipulate
the object in the project window.
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Below are the shapes in the PixarPerfs font. The
column on the left contains the characters you
would type on your keyboard. The middle column is
what you'll get in the PixarPerfs font.

Char. Shape

12345 Zo~>=]—

Description

Use combinations of these
shapes to make lots of
interesting patterns.

67890 = =|==0 Use combinations of these
shapes to make lots of

interesting patterns.

qwer b Circles. Use the smaller

ones if you need more.

tyui 2 SIS 4

LI TR

Five-pointed stars.

asdf Bars. To cover large areas,
make a single line with as
many bars as you need,

then stretch them out.

ghijk =
ZXCV b
bnm 4

OWER ® 3
TYU!I

A'S

Squares.
Diamonds.

A hexagonal pattern of
circles.

Hearts.
Wave shapes.

Concentric circles, suitable
for a bullseye. To make a
solid shape, fit the second
shape inside the first.

Same as above, only with
more circles.

A square checkerboard
pattern.

A diamond checkerboard
pattern.

Burst shapes.

the pixar perfs font
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For taking bites out of your _+
words.

A bullet hole. '@ #
A four-pointed star. $

A plaid pattern.

The two halves of a yin- &
yang symbol. Put them %~ *
together, and put a

different Look on each one

for the full effect. O

Yet another way to make
movies with Typestry. The
second character is the
same shape as the film
frame.

A halftone kind of dissolve.
More dissolve shapes.

Another dissolve shape,
this time with two
variations.

Another wave shape.

Solid pieces that can be
added to the above shapes

for more solid area.

L K &

o

Irregular edges for
achieving the tormn look.

Sort of sine waves.

A round-cornered
rectangle.

Don't do this.

Pentagon, hexagon,
octagon.

Hexagons on a hexagonal
grid, inverted and not.

Square and rectangular
frames.
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3D scene composition, 54
accelerator boards, 148—149
Adobe lllustrator files, 10
importing, 32
kerning and, 146
output, 145—-146
aligning, 151
alpha channels, 152
ambient light, 47-48, 88, 89
Ambient parameter
(RenderMan), 88, 89
animation, | 13—136
2—frame, |33—134
brackets, 113, 119, 136
changing length of, 125
checklist, 132—133
creating, | 13—114
2—frame, 133—134
methods of, 129
with poses/tools, 122—125
curved path, 116
curves, |32

delaying movements and, 120,

[21—-122
do’s and don'ts of, 131—132

duration adjustment of,

[27—128
Effects menu and, 131

frames, adjusting, 128

going to new time and, | 17

lights, 117, 131-132

linear, 116

looping, 129

rendering and, 133

moving through a Look, 112

object speed, |16

rendering, 129—131

running, 119, 123

settings, 128—129

stoppers See animation
brackets

stopping, 129

stretching/squeezing, |27—128

timing adjustment of, 125, 127

troubleshooting, 158

video and, 117, 153

viewing, 129—131

working with, |3 1-132

See also frames; poses; Score
window

Animation Settings dialog, 117,

128—129, 133134

Align Poses to Frames option,

128
Frames/Second option, |28,
133—134

Jump by option, 128
Time Display option, 128129
See also animation
Antialias parameter (RenderfMan),
91
Atmosphere dialog, 102—103
Color option, 103
Density option, 103
Global Motion option, 103
illustrated, 102
Local Motion option, 103
Lumpiness option, 103
Lump Scale option, 103
On/Off buttons, 102
AutoPlanar projection, 62
Box vs., 63

B

backgrounds, 93-95
deleting, 151—152
pixels and, 152
white, 151—152
See also floors; walls
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Backgrounds menu, 93

Floor Setup command, 94,

150
Wall Setup command, 94
Bevel Editor, 19-22
adjustments, |9
function of, 19
loading into, 19
bevels
changing, | |, 146
custom, | |
defined, 19
designing, 2|
editing session for, 21-22
handles, 19-22

illustrated, | |-14
interesting shapes for, 2|
Look and, 10

names for, 22
perforations and, |54
points, 19-20
resetting, 20
rounded, 2 |
saving, 22
selecting, 19
size, large, 147
transparency and, |54
troubleshooting, 155
See also Bevel Editor
binary dicing, 30
blurring
still images, 97-98
surfaces, 9|

See also motion blur
Box projection, 61, 63
Autoplanar and, 63
Box Spherical projection, 62, 64
Browser, 5
Add button, 56
bringing up, 5, 6, 55
Get Info button, 57, 68
Look Example window,
56-57
Looks and, 5657
Periodic Wrapping option, 79,
83, 84
pull-down menu, 68
Remove button, 56
Select button, 55, 79, 83
Build Methods, 9, 10—19
Extrude, 10—14
Rubber Sheet, 1518
Tubes, 18-19
Build Movie, 139—140
compression method,
139—140

C

Camera, 95-97

Camera menu
Custom command, 96-97
Fish Eye command, 95
Front command, |50
Left command, 124, 149
Normal commmand, 95
Telephoto command, 31, 42,

96, 146, |51

Top command, 149
ClipObjects, 54
Color Picker, 6, 49
colors, |
atmosphere, 103
of lights, 49
of wireframe lines, 142
Command-3, 124
Command-—|, 124
Command-L, 123
Command—2Z, 124
Compression Setup dialog,
39—140
Compression options, |40
Motion option, 140
Quality option, 140
cropping, 3637
Crop tool, 29, 36-37
uses, 36
crop window, 29, 3637
functioning of, 37
project window and, 37
using, 148
Crop Window dialog, 36-37
Crop option, 37
functions, 37
Zoom option, 37
Custom Bevel pop—up menu, 22
Custom quality, 26
Custom Quiality dialog, 29-30
Binary Quality option, 30
Gamma option, 30
Hider Quality option, 30



Load Values From option, 30
Memory Usage option, 30
Pixel Samples option, 30
Shading option, 30
Shading Rate option, 30
Custom Setup dialog, 26
Cylindrical Shrinkwrap projection,
61, 65-66
seamlessly tiling textures and,
66
Cylindrical Wallpaper projection,
66

D

decals
multi—color, 83—-84
single—color, 84

Delete key, 126

dialogs
Animation Settings, |17,

128—129, 133—134
Atmosphere, 102—-103
Compression Setup, 139—140
Crop Window, 36-37
Custom Quality, 29-30
Custom Setup, 26
Edit Look, 53, 75
Extrude, 3, 1011
Floor Setup, 94, 150, 157
Image Format, 27-28, |30,
141, 153

Import, 10
Light Info, 50-52

Look Editor, 71-72, 75
Make Movie, |30—131

Object Info, 5-6, 57-60, 150,

[51, 157
Particle Generator, 98—100
Particle Physics, 99, 101-102
Preferences, 31, 129,
[42—143
Render to file, 29
Rotate, 33, 123
Rubber Sheet, 15—17, 18

Save, 29, 129
Save As, 72
Scale, 34, 150

Select a Look. See Browser
Text, 3, 9-19, 107

Tubes, 18-19

Wall Setup, 94, 151, 156

Diffuse parameter (RenderMan),

88-90
Specular parameter and,
8990
Displacement parameter
(RenderMan), 91
distant lights, 45

E

easing, | 17
adding, 125
no, |17

Edit Look dialog, 53, 75
Metalness parameter, 77
Shininess parameter, 7677

¢

Transparency parameter, 77
Edit menu
Group command, 39, 42—43,

105, 108, 121
Replace Selection command,
11, 17,22, 146, 149

Reset Lights command, 50
Reset Orientation command,
5 114
Reset Scale command, 34,
125
Reset View command, 97
Toggle Grid command, 31,
51
Ungroup command, 39
effects, |
adding, 93—103
motion blur, |
particle, |
wind, |
EFfects menu
animation and, 131
Atmosphere command, 102
Backgrounds command, 6, 93,
150, 156
Camera command, 42, 95-96,
124, 146, 151
Motion Blur command, 97,
133
Particle System command, 98
Environment masters, 74
EPS format, 28
Excellent ‘n' Slow quality, 4, 6, 26

index




Excellent ‘n’ Slow quality
(continued)
illustrated, 26
uses, 26
Extrude Build Method, |0—-14,
122
function, 10
projections and, 61
using, 4|
See also rotating; scaling
Extrude dialog, 3, 10— |
Bevel Styles option, 10
Custom Bevel option, | |
Depth option, ||

F
file formats, 28
File menu
Get Info command, 149
Open command, 137
Preferences command, 142,
51
Print command, 143
Print One Copy command,
143
files

formats of, 28

llustrator, 10

location, 29

organizing, 107

QuickTime, 139

rendering to, 25, 27-29, 142
saving, 29

floors, 93
adjusting, 94
applying Looks to, 150
checking position of, 94-95
dark, 156
missing, |57
reflecting on, 150
See also walls
Floor Setup dialog, 94, 157
Manual setting, 150
fog, atmospheric, 102
motion of, 103
thickness of, 103
uniformity of, 103
folders, 38
letter, 107
Lights, 49
Look Reflection Pictures, 85
Looks, 57
Simple, 83
See also groups
FontMonger, |
Fontographer, |, 43
output, 145—-146
fonts
choosing, 9
PixarPerfs, 43
shapes in, 159—160
PostScript, 3, 9, 19
programs for, |
TrueType, |, 9, 147
tubes and, 19
Type |, I, 9, 147

G

usable, 147—148

frames, |
aligning poses to, 128
creating, 130—131
in file format, 129
jumping, 128
on top of each other, 129
per second, 128
See also animation

G

gamma, controls, 30

Get Info window, 149

Glass, transparency and, 77

Glimpse, 104

Glow, 81

gray scale pictures, 78, 80—-84
black in, 80
instead of sliders, 80-81

multi—color decals and, 83—-84

multiple, 81-82
Opacity and, 81
Opacity Mask Picture
parameter, 84
parameter control, 8081
in Relief Picture parameter,
8283
single—color decals and, 84
white in, 80
grid, 31
lines, number of, 143
grouping, 37-39, 105—112
controlling, 106—107



default, 37-38, 105
example procedure for, 108
functioning at different levels

with, 109—110
multiple operation objects
and, 39
objects, 107

reasons for, 38

ungrouping and, 120-122

See also folders; groups

groups, 37-39

creating, 39, 105

location of, 105

Looks and, 38, 105, 109
copying, | I'l

motion of, | 19—120

movements of, |33

moving among, 105

perf icon, 39

poses and, | 18-120

rotating, 39

separating elements from,
[20—121

subtraction and, 42
tools and, 38-39
“tree,” 106—107
ungrouping, 39

See also grouping

H

handles, 19
adjusting, 20-22
Delete key and, 20

direction of, 19, 20
function of, 19
length of, 19, 20
restricting operation to, 20
undoing operations, 2|
See also points
Highlight Spread parameter
(RenderMan), 90
Highlight Strength parameter
(RenderMan), 88, 90

1-)
Image Format dialog, 27-28
>> button, 153
Constrain Aspect Ratio box,
28, 153
Constrain box, 27
Default button, 28
file formats, 28
Output File option, 142, 153
QuickTime movie settings

and, 130
Window Size option, 2728,
41

images
aspect ratio, 27
dimensions, on—screen, 2728
importing, |
printing, 143
quality customization, 29-30
rendering, 25-30
resolution, on—screen, 2728

(%

sample, iv, 23, 28, 44, 70, 92
washed—out areas in, 156
See also objects; pictures; text
Import dialog, 10
Instances, Look, 68
creating, 75—76
in creating new surface,
8697
Decal — Multicolored, 83
Decal — Single Color, 84
defined, 72
function of, 72
location of, 68
Picture/Background, 78, 79
pictures in, 79-80, 86, 97
reflection pictures and, 85-86
See also Masters, Look
interpolation, | 14, 132

K

kerning, |46—147
L

LaserWriter, 153
letters

bevel, troubleshooting, 155
kerning, 146147
running together, 147
See also text

Light Info dialog, 50-52
Point at Center option, 52
Point at Selection option, 52
Spot Cone Angle slider, 51

index




Light Info dialog (continued)
Track Selection option, 52
Light masters, 74
lights, |
adding, 45-53
ambient, 4748, 88, 89
animating, |17
animation and, |31—-132
back, 156
bank of, 47
best, 154
color of, 49
direction of, 51-52
distant, 45
front/back, 49
intensity of, 48
Looks and, 49
look of, 49
moving, 50
reflected, 48
resetting, 50
shadow—casting, 148
Shininess and, 76
slide projectors, 46
special, features, 50-52
spotlights, 46
adjusting, 51
too many, 47
tracking, 52
automatic, 151
TV screen, 47
types of, 45—47
See also shadows

Lights folder, 49
Lights toolbox, 6, 47
Back button, 49
diagram of lights in, 50
Front button, 49
Lights window, 26
A (Ambient) light option,
47-48
E (Environment) slider, 48,
157
pop—up menu, 49
Time Marker and, 132
using, 47-50

Look Editor
bringing up, 57
color parameter, first, 57
Color Picture parameter, 79,
83
function of, 57
parameter settings, 72, 75
override icon, 76
texture map, 67
transporting Looks and, 68
uses, 74
See also Instances, Look;
Masters, Look
Look Editor dialog, 71-72
Color Picture parameter, 147
illustrated, 71
Save As button, 7|
Shininess parameter, |57
Look Example window, 56-57

(%

Looks

adjusting, 57-69, 148
applying, 55—69
groups and, 109
from six directions, 63
to text, 55-56
bevels and, 10
Color parameter, 60, 76
Combination, 82
copying, 56
groups and, | ||
custom fit, 67
editing, 53, 71-91
Environment, 86
finding, 55
flat sheet, 63
groups and, 38, 105
icon, 56
information on, 57
inheriting, |1 |
Instance, 68
creating, 7576
in creating new surface,
86—-87
Decal — Multicolored, 83
Decal — Single Color, 84
defined, 72
function of, 72
Picture/Background, 78, 79
pictures in, 79-80
reflection pictures and,
85-86
light, 45, 49




detach, 49

edit, 49

new, 49
light settings and, 49
Master, 68—69

defined, 72

function of, 72

types of, 7374
Materials, 104
moving through, |12
opacity, 59
Opacity parameter, 60, 76
orientation, 60
overriding, 109
palette of, 56

using, 57
parameters, 72, 75

override icon, 76
for particles, 102
parts of, 68
Picture/Background, 147
Pictures As Anything, 82
Reflection, 48
Relief, 76, 104
Save As and, 53
scaling, 58

in proportion to objects,

60

surfaces and, 75
Telephoto view and, 96
transporting, 67—69
troubleshooting, 157
TV Screen, 47, 86

using own images in, 7879
Windowspot light, 6
wrapped, 66
See also Look Editor; Looks
window; projections
Looks menu, 135
Looks toolbox
More Info button, 150
Object Info button, 5, 148
Looks window, 53, 55

applying Look to Sides option,

10
Detach Look button, | I']
Edit Look button, 53, 57, 71,
75, 83
New Look button, 5, 55, 147
Object Info button, 57
X in, 72
See also Look Editor; Looks

M
Make Movie dialog, 130131
Compute shadows option,
131
Image Quality option, |31
PICT file option, 130
Use Image Format Dialog
(TIFF) option, 130, 131
Wireframe QuickTime movie

option, 130
Masters, Look, 68—69
defined, 72

Environments, 74

(Y

function of, 72
Light, 74
location of, 68—69
Material, 73
parameters, 72
reference to, 72
Reliefs, 73
searching for, 68
types of, 73-74
See also Instances, Look
Material masters, 73
memory
rendering and, 149
usage controls, 30
Metalness, 77
gray scale pictures and, 8|
increasing, 77
Shininess and, 77
motion blur, 1, 97-98
Blur and Strobe, 97
Normal Blur, 97, 133
rendering loops and, |33
using, 133, 154
See also blurring
Motion menu
Animation Settings command,

117,128
Jump Backward command,
117

Jump Forward command, 17

Make Movie command, |29

Run Animation command,
123, 129

index




Motion menu (continued)
Update Simulations
command, |34
Move tool, 32-33, 108, 109, 122,
123, 124, 146
Movie Tool, 130, 137—140
Build Movie, 139—140
playback, 137—139
Playback menu, 138—139
All Frames option, 125
playback size control,
138—139
playback speed control, |38
See also QuickTime standard
movie controller

N

Natural (st) projection, 67

NetRenderMan, 143, 144
with Typestry, 148

o
Object Info dialog, 5-6, 57—60
bringing up, 57
Color Override box, 6, 57,
60, 76
Flip Horizontally button, 60
Flip Vertically button, 60
illustrated, 58
Look Scale box, 58, 157
Opacity Override slider, 59,
60, 76, 151
overriding parameters and, 76
Projection option, 60, 61-67

Rotate button, 60
Scale Look with object box,

Opacity, 59
decreasing, 81

60 function of, 77
trouble choosing, 157 gray scale pictures and, 8|
using, 57-60 decals, 83—-84
objects Look, 59
aligning, 31 pictures, 83
animation using, 81
adding/deleting, |31 viewing effects of, 59
changing, 131 See also Transparency

bevels, changing, 146
combining, in group, 120, 121
freezing, | 14, 126

P
PageMaker, |

invisible, 151 Particle Generator dialog, 98—100
letter, 107 Birth/Death Color option, 100
movement of, | 18 Ejection Speed option, 100
paths of, | 15 Elasticity option, 99

illustrated, 99

Life Span option, 99

Mass option, 99

Particle Density option, 100
Pulse option, 100—101

perforating, 3943
poses, | 15—122

Reliefs as objects, 8283
restoring size of, 34
selecting, 31-32

extruding, 32 Randomness option, 100
speed of, |16 Start at/Stop at option, 100
spherical, 64 Particle Physics dialog, 99,
spraying, 98 101-102
squashed and stretched, 34 Cast Shadows option, 102
text, 107 Collision Behavior options, 99,
thickness of, | | 101
tilted, 151 Color ‘Tweening option, 101

Gravity option, 101
illustrated, 101
Particle Limit option, 102

transparent, 59
unfreezing, 126
views of, 95-97




Score window (continued)
for creating poses, 126
grouping control in, 106—107
Group Name box, 108
Look icon, 57
Looks menu, 135
object timeline, | 13
operations summary,

135—-136
perf modes, 39
Perfs menu, 135

Pick tool, 125
Play button, 113, 114, 119,
136

pop—up menu, | 15—116

Ease In&Out command,
16

Ease In command, | 16
Ease Out command, | 16
Linear command, | 16
No Ease command, | 16
Smooth command, | 16

Pose/ease type menu, |36

pose nib, 113, 114, 115, 125,

126, 134, 136
Pose Scaling tool, 125, 127,
133, 136

tick marks, 128—-129
Time Marker, 97-98, 113,
119,122, 136

lights and, 132
moving, | 13—114, 117
scaling and, 127

selecting poses and,

126—127
using, | 14, 119, 122, 123,
124, 126, 158

working in, 42—43

Zoom tool, 125

See also animation
Select a Look dialog. See Browser
shaders, 87—88

defined, 87

parameters, 87-88
shading

controls, 30

rate, 30

using, 9|
shadows, 26

computing, 27

improving quality of, 149

light and, 49
missing, 155
particle, 102

recomputing, 50
rendering with old, 27
rendering without, 27
troubleshooting, 155
Shininess, 7677
gray scale pictures and, 81
increasing, 7677
lack of, 156—157
light and, 76
Metalness and, 77
Showplace, 54
Skew tool, 35

uses, 35
slide projector lights, 46
sliders
pictures instead of, 80-81
See also specific sliders
Spherical Shrinkwrap projection,
61, 64
Spherical Wallpaper projection,
65
Spotlights, 46
adjusting, 51
surfaces, 75
blurry, 91
controls for, 7677
creating, 8687
using Instance with picture,
86
using similar Instance, 87
highlights on, 88—89, 90, 154
metalness of, 77
properties of, 87
scanning pictures of, 75
shininess of, 7677, 90
transparency of, 77

T
text, |
adding space around, |7/
applying Looks to, 55-56
bevel, changing, 146
cropping, 36—37
kerning, 146147
manipulating, 31-43




reflections, 48
brightness of, 90
creating, 150—151
environments and, 86
sharpness of, 90-9 |
simulated, 53, 86
complexity, 85
tilted object, 151
turning off, 53
types of, 84-85
Reflection Spread parameter
(RenderMan), 9091
Reflection Strength parameter
(RenderMan), 90
Relief masters, 73
Relief pictures, 82—83
black in, 82
Relief Height slider, 83
white in, 82
Reliefs, 76
for bumping surface, 91
using on objects, 8283
rendering, 25-30
animation, 129—131
area restriction, 29
canceling, 27
to file, 25, 27-29, 142
image quality and, 29—-30
loops, 133
memory and, 149
monitoring, 27, 29
perforations, 41, 43
to screen window, 25

shadows and, 27
speeding up, 148—149
RenderMan, 75
light components, 88
distribution percentages,
88
RenderMan Expert parameters,
8891, 142—-143
Ambient, 88, 89
Antialias, 91
Diffuse, 88—90
Displacement, 91
Highlight Spread, 90
Highlight Strength, 88, 90
Reflection Spread, 90-9 |
Reflection Strength, 90
Render menu
Custom Quality command, 29
Image Format command, 27,
130, 153
Render to file command, 28
Render to Screen command,
4, 6,25
Render Status window, 27
Render to file dialog, 29
resizing, 33—34
nonuniform, 34
object poses, | |7
uniform, 34
RIB format, 28
Rotate dialog, 33, 123
Rotate tool, 33, 109, | 14, 123
Option key and, |24

uses, 33

rotating, 33, 109
animation curves and, |32
See also scaling

Rubber Sheet Build Method,

15-18

particle direction, 98
projections and, 61

Rubber Sheet dialog, 1517, 18
examples, 15—16
No Wind option, |7
Padding option, 17
Sheet Style option, |5
Sheet Textiling option, |5
Wind Gustiness option, |7
Wind option, 17
Wind Speed option, |7

S

Save As dialog, 72

Save dialog, 29
Make Movie box, 129

Scale dialog, 34
Nonuniform option, 34, 150
Uniform option, 34

Scale tool, ||, 33-34, 109
pull—aside menu, 33—34
uses, 33

scaling, 33-34
looks, 58
See also rotating

Score window, 32, 38, 56
animation brackets, | 13, 119,

129, 136

index




missing, 156

moving, 5, 32—-33

objects, 107

replacing, 22

resizing, 5, 33-34

rotating, 5, 33

selecting, 31-32
hard—to—get, 32

slanting, 35

thickness, changing, 21, 34

unable to select, 158

See also letters

Text dialog, 3

Build Methods, 9, 1019
Extrude, 10—14
Rubber Sheet, 15-18
Tubes, 18—19

Build Object command, 3, 9,

18, 107
opening, 9
using, 9—10
Text tool, 9, 32, 107, 122
import, 10
uses, 32
texture map, 67
aspect ratio, 67
textures
custom, using, 147
photographic, 24

Pixar One Twenty Eight, 24,

75
seamlessly tiling, 64, 66
See also surfaces

TIFF
Materials/Relief Looks and,
104
programs saving, 78
rgba format, 28
rgba (packed) format, 28
rgb format, 28
rgb (packed) format, 28
saving files in, 78
Time Marker, 97-98, 113, 136
lights and, 132
moving, | 13—114, 117
scaling and, 127
selecting poses and, 126—127
using, |14, 119, 122, 123, 124,
126, 158
toolbox
Move tool, 5
Resize button, 5
Rotate button, 5
tools, 32—-37
Crop, 29, 36-37
groups and, 3839
Move, 3233, 108, 109, 122,

123, 124, 146

Pick, 125, 136

Pose Scale, 125, 127, 133,
136

pull-aside menus, 32

Rotate, 33, 109, |14, 123, 124
Scale, 11, 33-34, 109

Skew, 35

Text, 9, 10, 32, 107, 122

Transform, 105, 126
Zoom, 125, 136
Transform tools, 105, 126
Transparency, 77
changing, 78
gray scale pictures and, 81
increasing, 77
picture, 80
See also Opacity
Tree window, 149
troubleshooting, 155—158
animation, 158
dark floors, 156
edited bevels, 155
effects, missing, 157
floor, missing, 157
letter bevels, 155
Object Info command, 157
perforations, |57
shadows, 155
shininess, lack of, 156—157
text
missing, 156
unable to select, 158
washed—out areas, 156
TrueType font, |, 9
Tubes Build Method, 1819
fonts and, 19
particle direction, 98
projections and, 61
size of, 18
tube styles, 18
Tubes dialog, 18-19

index




TV screen light, 47
tweening, | 14, 132
Type | font, I, 9
Typestry
explained, |
good results from, 154
icon, 149
NetRenderMan with, 148
quick—start, 3—4
starting, 56
steps for using, |
troubleshooting, 155—158
typos, correcting, |49

U
UNIX, NetRenderMan and, 144

\"4
views
custom, 96-97
fish eye, 95
normal, 95
telephoto, 96
See also Camera menu

WwW-Y
walls, 93
adjusting, 94
checking position of, 94-95
See also floors
Wall Setup dialog, 94, 151, 156
wind, |
2-frame animation and, 133
controls, |7

changing, 17—18
gustiness, |7
rendering loops and, 133
speed, |7
windows
grids and, 31
sizing, 141
working with, [41—142
See also specific windows
Windows menu
Show Lights command, 6
Show Looks command, 5, 55,
75
Show Render Status
command, 27, 29
Show Score command, 32,
38, 41,97
wireframe movies, 125, 129
creating, 129—130

z
zooming, 125

crop window, 37
Zoom tool, 125, 136



Wow we d3id

M

To produce this manual, we had to do exactly what
you'd have to do if you wanted to get some
Typestry text into print. And it really was surprisingly
easy: it was almost as easy as pi. All the reference
illustrations were rendered with Typestry 2 at 150
pixels per inch against a black background as TIFF
RGBA files. This creates an alpha (matte) channel,
which includes everything that isn't background. We
used this channel to determine the selection in
Photoshop (using Load Selection), copied it, and
pasted it over a pre-painted border background.

These files had their mode changed to CMYK and
were then saved in TIFF format. We imported them
into QuarkXPress and had color separations printed
with a line screen of 150.

We made no color adjustments in Photoshop or
Quark, and had very few matchprints made. But we
did do some tests to make sure we were sane. We
failed most of those. On the other hand, some color
tests confirmed our guess that we could get away
with default settings in Photoshop and Quark. This
saved a LOT of time and money, since there were

absolutely no color corrections made.

The other big savings was in using Quark to sepa-
rate whole pages. This meant that we didn't have to
get separations for every image. We were able to
go from a whole page of images directly to separat-
ed film for the page, without any stripping in of indi-
vidual pictures.
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